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Preface

Purpose of the Manual

This manual serves as an instruction and reference document for the components of SICAM PAS/PQS:

• SICAM PAS/PQS UI – Configuration

• SICAM PAS/PQS UI – Operation, SICAM PAS/PQS UI – Operation Client

• Value Viewer

• User Administration

Target Audience
This manual is mainly intended for customers and their employees who are involved in the configuration and
parameterization of substation automation systems.

Scope
This manual is valid for SICAM PAS/PQS.

Standards
SICAM PAS/PQS has been developed in compliance with ISO 9001:2008 standard.

Additional Support
For questions about the system, contact your Siemens sales partner.

Customer Support Center
Our Customer Support Center provides a 24-hour service.
Siemens AG
Smart Infrastructure – Protection Automation Tel.: +49 911 2155 4466
Customer Support Center E-Mail: energy.automation@siemens.com

Training Courses
Inquiries regarding individual training courses should be addressed to our Training Center:
Siemens AG
Siemens Power Academy TD Phone: +49 911 9582 7100
Humboldtstraße 59 E-mail: poweracademy@siemens.com
90459 Nuremberg Internet: www.siemens.com/poweracademy
Germany

Notes on Safety
This document is not a complete index of all safety measures required for operation of the equipment (module
or device). However, it comprises important information that must be followed for personal safety, as well
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as to avoid material damage. Information is highlighted and illustrated as follows according to the degree of
danger:

! DANGER
DANGER means that death or severe injury will result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! WARNING
WARNING means that death or severe injury may result if the measures specified are not taken.

² Comply with all instructions, in order to avoid death or severe injuries.

! CAUTION
CAUTION means that medium-severe or slight injuries can occur if the specified measures are not taken.

² Comply with all instructions, in order to avoid moderate or minor injuries.

NOTICE
NOTICE means that property damage can result if the measures specified are not taken.

² Comply with all instructions, in order to avoid property damage.

ii NOTE
Important information about the product, product handling or a certain section of the documentation
which must be given attention.

Qualified Electrical Engineering Personnel
Only qualified electrical engineering personnel may commission and operate the equipment (module, device)
described in this document. Qualified electrical engineering personnel in the sense of this document are
people who can demonstrate technical qualifications as electrical technicians. These persons may commission,
isolate, ground and label devices, systems and circuits according to the standards of safety engineering.

Proper Use
The equipment (device, module) may be used only for such applications as set out in the catalogs and the
technical description, and only in combination with third-party equipment recommended and approved by
Siemens.
Problem-free and safe operation of the product depends on the following:

• Proper transport

• Proper storage, setup and installation

• Proper operation and maintenance

Preface
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When electrical equipment is operated, hazardous voltages are inevitably present in certain parts. If proper
action is not taken, death, severe injury or property damage can result:

• The equipment must be grounded at the grounding terminal before any connections are made.

• All circuit components connected to the power supply may be subject to dangerous voltage.

• Hazardous voltages may be present in equipment even after the supply voltage has been disconnected
(capacitors can still be charged).

• Operation of equipment with exposed current-transformer circuits is prohibited. Before disconnecting the
equipment, ensure that the current-transformer circuits are short-circuited.

• The limiting values stated in the document must not be exceeded. This must also be considered during
testing and commissioning.

OpenSSL
This product includes software developed by the OpenSSL Project for use in OpenSSL Toolkit (http://
www.openssl.org/).
This product includes software written by Tim Hudson (tjh@cryptsoft.com).
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
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Overview
What is SICAM PAS/PQS?

SICAM PAS/PQS has been designed as a modular system with open communication interfaces. It meets the
requirements of state-of-the-art substation control and protection systems and of the power management
systems required for industrial manufacturing plants. Functions for power quality evaluation complement its
versatile fields of application.

SICAM PAS/PQS UI – Configuration
The SICAM PAS/PQS UI – Configuration system component is used for:

• The configuration and parameterization of your station

• The exchange of configuration data
In the different views, you can specify the type and the transmission modes of your communication links.
Additionally, you can define which devices, substations, control centers or HMIs are connected.
For each of the connected system components, you can specify what information is evaluated in SICAM PAS/
PQS. Furthermore, you can define what information is available for communication with higher-level control
centers and for system management by using SICAM SCC.
You can individually structure your system data in a topological view to map your operating conditions and
also assign individual switching permissions.
In this view, you can also define parameters for fault location calculation, for example, the line data, double
line, maximum load current, or the starpoint position. In addition, you select the measuring channels whose
PQ measuring data must be used for the Fault Locator.
In order to be able to evaluate the quality of power quality measuring data (PQ measuring data), the individual
topological levels must be assigned to the Grid Codes.
Predefined device-specific and project-specific templates, templates for scheduled reports and Grid Codes,
along with import/export and copy functions, facilitate and accelerate the configuration and parameterization
of your system.
For the DNP3i, IEC 60870-5-104, and IEC 61850 protocols, the use of certificates ensures secure and
encrypted data transmission.
SNMP is available for the configuration of Ethernet network monitoring.
Redundant system components prevent data loss. When a communication link is interrupted, the redundant
component takes over the process connection.
Extensive functions have been implemented for checking the network quality. These functions allow the
archiving and evaluation of power quality measuring data according to various criteria. Import and export
functions support the data exchange with other evaluation components. Through e-mail and/or SMS, you can
obtain information for example, on limit value violations or network faults.
Fault records and fault location reports support your operating personnel in the analysis and location of faults
in electric power networks.
The project statistic provides you with an overview of the data defined with the help of parameters, for
example, the total number of devices or the total number of data points which have not been mapped.

SICAM PAS/PQS User Administration
By using the User Administration tool, you can assign passwords in order to define which persons can access
individual programs.
For the password-protected access to system functions, you define either SICAM PAS/PQS internal users or use
the same passwords as for Windows access.

User Administration
A user can log on with one of the following user roles:

• Administrator with full rights

• System engineer with full rights, no access to the User Administration

1.1
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• Data engineer with full rights for SICAM PAS/PQS UI – Configuration and Feature Enabler, read-only
rights for SICAM PAS/PQS UI – Operation and Value Viewer

• Switch operator with full rights for SICAM PAS/PQS UI – Operation and Value Viewer, read-only rights for
SICAM PAS/PQS UI – Configuration and Feature Enabler

• Guest with read-only rights for all SICAM PAS/PQS system components with exception of the User
Administration

• Security administrator with full rights for the User Administration, read-only rights for all SICAM
PAS/PQS system components

• RBAC manager creates users and assigns roles in the User Administration, with read-only rights for all
SICAM PAS/PQS system components

• Security auditor audits the security logs, with read-only rights for all SICAM PAS/PQS system components

[sc_User_Administration, 4, en_US]

Figure 1-1 User Administration, Example

If the control center is connected by using DNP3i, you can further modify the user rights (authentication).

Feature Enabler
SICAM PAS/PQS is designed as an open, modular system whose components can be selected in order to meet
project-specific requirements.
Use the Feature Enabler to install all functions required in your project or on the corresponding computer.
In this context, the different communication protocols, the automation (SoftPLC), the HMIs, the SNMP
Ethernet monitoring component, OPC connections and Power Quality functions are referred to as "functions".

SICAM PAS/PQS UI – Operation
SICAM PAS/PQS UI – Operation provides you with a brief overview of the operational status of your system
components. Update functions ensure that the display is always up to date.
Furthermore, you can enable or disable individual components, such as interfaces or devices, set bay and
telecontrol blocks or perform redundancy switchovers.
The diagnostic function supports you in the analysis of fault causes, for example, faulted communication
connections.

SICAM PAS/PQS UI – Operation Client
SICAM PAS/PQS UI – Operation Client provides the functions of SICAM PAS/PQS UI – Operation from a local
computer or a remote computer with improved performance by an Internet browser.

Value Viewer
If the communication links have been established properly, the Value Viewer displays information on the
selected device or substation.
During commissioning, for example, you can use this information view to test data links and to check whether
an interface or a device transmits correct values. Detailed time stamps provide information on the reliability of
values.

Product Overview
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For test purposes, you can initiate password-protected command outputs or manually update (substitute)
information.

SICAM PAS SoftPLC
In order to perform project-specific automation tasks in SICAM PAS/PQS, you can graphically link automation
blocks or even define the automation function as Structured Text (ST), with the help of the Statement List
(STL) or by using the Sequential Function Chart (SFC).
A comprehensive library of different automation blocks supports you in performing your tasks. These blocks
have been specifically designed to provide sophisticated solutions in the field of power automation.

SICAM PAS LSA Converter
Using the SICAM LSA Converter, you can convert the project data of a SINAUT LSA system configured by
means of LSATOOLS or PARAM.
The corresponding file is converted to XML. You can import the XML file into your SICAM PAS/PQS project for
parameterization. Additionally, a description for each device is saved in a TXT file. After the import, all bay
devices of the SINAUT LSA system are included in the SICAM PAS/PQS project.

Version Scan
The Version Scan system component determines the version and the storage location of the products
installed and their lower-level system components. Error sources through inconsistent versions of the indi-
vidual components can thus be determined quickly and efficiently.

Product Overview
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Configuration

This chapter explains how to use SICAM PAS/PQS UI – Configuration.
In the Configuration view, you can define a new station configuration or modify an existing configuration for
example, in order to add new devices.
2.1 Starting SICAM PAS/PQS UI – Configuration 16
2.2 Views 16
2.3 Working with Project Databases 21
2.4 Importing/Exporting 24
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Starting SICAM PAS/PQS UI – Configuration
Start SICAM PAS/PQS UI – Configuration from the Windows Start menu.

ii NOTE
If you open SICAM PAS/PQS after an update, the existing project database is converted and can no longer
be edited with previous versions of SICAM PAS/PQS.

² Click Start and scroll through the app list.

² Select UI - Configuration from the SICAM PAS/PQS folder.
SICAM PAS/PQS UI – Configuration opens with your current station configuration.
If you have enabled the User Administration, you are requested to enter your user name and password.

[sc_SICAM_PAS_PQS, 3, en_US]

Figure 2-1 SICAM PAS/PQS UI – Configuration

Views
SICAM PAS/PQS UI – Configuration is subdivided into different views. The individual views are used to
configure your station, in the following way:

2.1

2.2

Configuration
2.1 Starting SICAM PAS/PQS UI – Configuration
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• Configuration
The configuration tree shows all components of your station configuration in hierarchical order. In this
view,
– you insert the individual functions (applications) and
– define the parameters of the functions

The functions include all device connections, control center connections, the archive, or the Power
Quality functions (Fault Location, Scheduled Reports, and Grid Codes).

• Mapping
In this view, you select
– the device/substation information to be used
– the tests to be performed for information processing, for example, bay blocking or switching

authority
– the components to which this information is forwarded, for example, control centers, SICAM SCC
– the purposes for which the information can be used, for example, as a trigger for PDR recording

• Topology
In this view, you
– map your station's topology
– assign the individual structure levels with the appropriate information
– define the switching authority of the individual structure levels
– parameterize data for fault location calculation
– define the measuring channels through which measuring data is transmitted for fault location

calculation
– assign the individual structure levels to the Grid Codes for power quality evaluation

• Templates
Templates can be used for the configuration of the individual components of your project. In this view,
you
– manage and parameterize device descriptions, for example, the assignment of commands and

feedbacks, checks for blocks, the switching authority, or "M of N monitoring"
– define normalization procedures
– insert certificates which you require for secured data transmission based on IEC 60870-5-104 and

DNP3i.

• Reports
In this view, you
– insert templates for reports to be created at cyclical intervals.

The templates include selected measured values used as a basis for power quality evaluation. The
report templates are created as TXT files and imported into SICAM PAS/PQS

– select the time and interval of report generation for a report template
– assign the measuring channels through which PQ measuring data is transmitted

• Grid Codes
In this view, you
– insert the standards which describe limit values for the network. These Grid Codes provide the basis

for evaluating the quality of the PQ measuring data of the station.

Configuration
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Window Structure

The navigation tree which displays the structure of the corresponding project data is located in the left-hand
section. You can insert station components by using the tree structure of the navigation tree. The selected
view is displayed on the left-hand margin bar of the navigation tree.
In the Configuration, Templates, Topology, Reports, and Grid Codes views, you select an object from the
navigation tree. The parameters of this object are displayed in the input area in the right-hand section. The
parameters are grouped according to categories, for example, General parameters or Transmission parame-
ters.
In the Mapping view, the right-hand section is subdivided into the Information – Monitoring direction and
Information – Command direction sections. These sections are divided into tabs, Process and Status. From
these tabs, you select the information to be used and you map the information to other system components.
In addition, you can define the parameters for different functions, for example, bay blocking or switching
authority.
The display depends on the object selected from the navigation tree.
Depending on the object selected from the navigation tree, the right-hand section of the Templates view is
subdivided into different tabs, for example, Information points, General recording channels.
The display depends on the selected tab and can be further subdivided.
The Properties window, displays the general parameters of the selected template.
Clicking the  icon at the bottom of the window opens or closes an information field. Clicking  opens or
closes an error field, clicking  opens or closes a warning field.
The information field provides descriptions regarding the value or value range which is permissible for the
selected parameter of an object.
The error field provides information on the cause of an incorrect or incomplete parameter entry.
The warning field is only displayed in the Mapping and Templates views. It notifies you that the parameters
of certain items of information have not been completely defined. This warning is displayed for example,
when the item of information exists only in the monitoring direction and not in the control direction, while
mapping the items of information for an IEC 61850 control center connection.

2.2.1
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[sc_Configuration view, 2, en_US]

Figure 2-2 SICAM PAS/PQS UI – Configuration, Configuration View

[sc_Mapping view, 2, en_US]

Figure 2-3 SICAM PAS/PQS UI – Configuration, Mapping View
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Switching the Work Level

To switch between the work levels or views:
² Select the view to which you want to switch.

The view is switched over.
To switch views by using the context menu:
² In the configuration tree, select a device or a control center and select Go to... from the context menu.

In the window which opens, select the view to which you want to switch.
When switching the view, the focus remains on the previous object which has been selected in the
previous view.

To switch between the views:
² In the menu bar, click View and select the view you want to switch to from the context menu.

[sc_Switching Views, 3, en_US]

Figure 2-4 Switching Views Using Context Menu

Modifying the Representation

You can modify the size of the individual section of the windows in order to focus your view on the current
section you are using.
Proceed as follows:
² Move the splitter between the individual areas.

The section of the window is represented larger/smaller.

2.2.2

2.2.3
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² Click the arrow of a component in the configuration window or the arrow in the header of a parameter
category displayed in the properties. The lower-level components of the configuration structure or the
parameters of the parameter category are shown/hidden.

² To open the information field, click the  icon at the bottom of the window and select a parameter
field. Explanations and input aids for the selected parameter are now displayed.

² To open the error field, click the  icon at the bottom of the window and select a parameter field
highlighted in pink. Explanations on the parameters are now displayed, for example, the permissible
value range.

² Click the blue error designation (link). You are now guided to the parameter which has been filled in
incorrectly or incompletely.

² Click Previous and Next. You are now guided to the incorrect parameter field.

² To open the warning field, click the  icon at the bottom of the window.

² Double-click the blue designation (link) of a warning. The system takes you to the parameter which has
not been completely defined.

² Click Previous and Next. The system takes you to the corresponding parameter field.

Working with Project Databases
SICAM PAS/PQS saves your project's configuration data in a relational database in the %PAS_APPDATA%\Data-
base\pas.db installation directory.
This project database is loaded and displayed by default. Any change in the current station configuration is
automatically saved in this database.
Additionally, you can archive and load back your station's configuration. This creates the backup copies of your
station configuration, for example, before performing changes. If you configure a station offline on another
computer, you can transfer this configuration to your station and dearchive and customize it afterwards.
You can perform the following operations at the project level:

• 2.3.1 Archiving Project Data

• 2.3.2 Dearchiving Project Data

• 2.3.3 Creating a New Database

• 2.3.4 Creating a New Database from a Template

• 2.3.5 Compressing the Database and Reducing the Data Points

Archiving Project Data

ii NOTE
When archiving a database, all communication links are interrupted and restarted automatically afterwards.
SICAM PAS/PQS UI – Operation is exited.

ii NOTE
As some user-account features can block the archiving on network drives, always archive project data on
the computer on which SICAM PAS/PQS has been installed.

Proceed as follows to archive your database:
² Select the Configuration view.

² Click File > Archive... and select the directory in which you want to save the backup copy.

2.3

2.3.1
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² Click Save to confirm.
The data is compressed as a ZIP file and saved in the selected directory. The ZIP file includes the database and
log files and also the ARCHIVES subdirectory.

ii NOTE
Note down the information for project identification, for example, directory, file name, database version,
and also the information which you have entered under General parameters on the project level.

Dearchiving Project Data

ii NOTE
When copying an archived project database, all communication links are interrupted and restarted auto-
matically afterwards. SICAM PAS/PQS UI – Operation is exited.

ii NOTE
When loading an archived project database, the current project is overwritten. You are prompted to
confirm this step.
Siemens recommends saving a backup copy of your current database before loading another project (File >
Archive...).

ii NOTE
When dearchiving the previously archived project database after an update of SICAM PAS/PQS, the data-
base is also converted.

Proceed as follows to dearchive a project database:
² Click File > Dearchive... and navigate to the directory with the project database which you want to

restore.

² Select the zipped project database and confirm with Open.
Some items of information stored in the dearchived configuration database must be customized for the new
system, for example, the IP addresses of the computer.

Dearchiving a Project with Automation Functions
After dearchiving a project with automation functions, you must compile the SoftPLC project.
Proceed as follows:
² Open SICAM PAS SoftPLC UI.
² Exit SICAM PAS SoftPLC UI and select Compile and Save from the Close listbox.

Dearchiving a Project with OPC Connection
After dearchiving a project with OPC connections, you must update the information mapping of the OPC
Client.
Proceed as follows:
² Ensure that the connection to the OPC Server is available.

² In the OPC Client application, select the device with the available mapped information and click ... at the
Value selection dialog in the General parameters.

² In the dialog which opens, confirm the mapping with OK.

2.3.2
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Dearchiving Large Projects
For projects with a large data volume, you have the option to transfer the archived project data directly under
Windows.
Proceed as follows:
² Stop the SICAM PAS/PQS runtime environment. To do this, click Start > Run > cmd.exe to open a

command prompt window and enter the net stop ssr command.

² In a Windows Explorer, open the %PAS_APPDATA%\Database folder of the SICAM PAS/PQS database.
Delete or move the Archives folder and the pas.db and pas.log files.

² Unzip the ZIP file of the archived project to the SICAM PAS/PQS database folder.
The database folder must now contain the pas.db and pas.log files and, if required, the Archives folder again.
² Start the SICAM PAS/PQS runtime environment. Enter the net start ssr command in the command

prompt window.

² Enter the cd %PAS_BIN% and Changeloggenerator.exe commands in the command prompt window.
The SICAM PAS/PQS runtime environment restarts with the dearchived project.
Alternatively, you can click Update system to restart the runtime environment in SICAM PAS/PQS UI –
Operation , refer to 3.3.1 Updating the Display.

Dearchiving a Project in SICAM PAS/PQS UI – Operation Client
You can dearchive an archived project in SICAM PAS/PQS UI – Operation Client.
To dearchive a project database:
² Click Dearchive.

The Dearchiving a project database dialog opens.

[sc_Dearchiving_Proj_Data, 1, en_US]

Figure 2-5 Dearchiving Project Database

² Click … , select the required archive and click OK.
Unpacking of the archived project database starts.

² Once done, click OK.
The system is updated.

ii NOTE
If the project is archived using a previous version of SICAM PAS/PQS and is being dearchived in SICAM
PAS/PQS V8.07, you must convert the project database after starting SICAM PAS/PQS UI – Configuration.
If redundancy is not enabled in the system, a project consisting of a redundant configuration cannot be
dearchived in that system and vice versa.

For more information on SICAM PAS/PQS UI – Operation Client, refer to 3.2  Starting SICAM PAS/PQS UI –
Operation and SICAM PAS/PQS UI – Operation Client.
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Creating a New Database

You can create a new project database in the Configuration view. This menu item is disabled in all other
views.
² Select File > New... in order to define a new station configuration.

ii NOTE
Be aware that the active project will be overwritten when creating a new project. You are prompted to
confirm this step.
Create a backup copy of the active project in order to obtain the configuration settings for this project.

ii NOTE
In order to create a database for another station on the basis of an existing project database use the Create
new database from template function.
This ensures that, for example, SICAM PQ Analyzer can distinguish between several individual SICAM
PAS/PQS stations.

Creating a New Database from a Template

To create a project database on the basis of an existing one:
² Select File > New from template in order to dearchive an existing project and use it as a template.

SICAM PAS/PQS assigns new internal identifications, the original project remains unchanged and can be
used for further processing steps.

Compressing the Database and Reducing the Data Points

To reduce the size of the database:
² Click File > Compress database and reduce data points... to remove residues of the deleted data and

deselect or remove the unused data points from the project database.

ii NOTE
Siemens recommends you optimize your project configuration periodically via this option. This ensures the
reduction of the launch time for SICAM PAS/PQS UI – Configuration and SICAM PAS/PQS UI – Operation.

Importing/Exporting
The Import and Export functions of SICAM PAS/PQS UI – Configuration support you in the exchange of
configuration data with other system components or configuration tools.
Configuration data created by another configuration system in (another) SICAM PAS/PQS project can be
transferred into the different SICAM PAS/PQS views.
You can import the following configuration data:

• Several devices (application, interface)

• One single device

• Device templates

• Grid Codes

• Templates for scheduled reports

2.3.3

2.3.4

2.3.5

2.4
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[dw_importing_config, 2, en_US]

Figure 2-6 Importing Configuration Data for Devices

If you import large data volumes, for example, an IEC 61850 Ed. 2 SCD file with several devices, click File >
Compress database and reduce data points to compress the database after the import. Additionally, you can
use this option to reduce the number of mapped/unused data points.
If you have modified imported configuration data by means of an external configuration tool, you can update
the data in SICAM PAS/PQS UI – Configuration. The new and the old parameter data is compared during this
process.

Importing Configuration Data

Configuration Data for Several Devices
Preconfigured configuration data can be imported for several devices on the following levels:

• Project

• Application

• Interface

Project
Complete project configuration files can be created in the TEA-X exchange format. A TEA-X file may include
the configuration for the following applications with/without redundancy enabled:

• IEC 61850 Client/Server

• SNMP

• IEC 60870-5-101 Master/Slave

• IEC 60870-5-104 Master/Slave

• IEC 60870-5-103 Master

• DNP3 Master/Slave

• Automation (Mapping)

• SCC

• Archive

• ScPCCN

2.4.1

2.4.1.1
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ii NOTE
ST programs are exported and imported through the TEA-X file but CFC and SFC programs are not. Before
compiling the ST program, it must be linked to the Active Resource.
For more information on active resource, refer to /7/ SICAM PAS, Automation Blocks.

To import a project configuration:
² Right-click the project in the configuration tree and select Import from the context menu.

² Select the TEA-X project file and confirm with Open.
The Import - select elements dialog opens.

² Select the required project.

[sc_Select_TEAX_project, 1, en_US]

Figure 2-7 Importing Project

² Click OK.
The process can take several minutes. You can view the progress in the Report.

Applications
The import file includes all data of the interfaces and devices assigned to the application.
Preconfigured configuration data can be imported into the following applications on the application level:

• IEC 60870-5-103 Master
The XML file formatted for IEC 60870-5-103 Master is used for data exchange.
The data is created using the SINAUT LSA Converter.

• SINAUT LSA
The XML formatted for SINAUT LSA is used for data exchange.
Using the SINAUT LSA Converter, the file is created from the configuration data of a SINAUT LSA system.

To import device data on the application level:
² Right-click the application in the configuration tree and select Import from the context menu.
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² In the dialog which opens, select the import file and click Open.
The process can take several minutes. You can view the progress in the Report.

Interfaces
The import file includes all data of the interface and the configuration data for devices and substations
assigned to the interface.
Preconfigured configuration data can be imported into the following applications on the interface level:

• IEC 60870-5-103 Master
The TEA-X format is used for data exchange.
The file is created using SICAM PAS/PQS UI – Configuration and DIGSI 5. Versions earlier to DIGSI 5 V6.20
is not supported.

• IEC 60870-5-104 Master
The XML file formatted for IEC 60870-5-104 Master is used for data exchange.
The XML file is created using SICAM PAS/PQS UI – Configuration, SICAM TOOLBOX II, SICAM plusTOOLS or
when exporting the IEC 60870-5-104 Slave.

• IEC 61850 Client
The IID, SCD, or CID data format is used.
The IID, SCD, or CID file is created using the IEC 61850 System Configurator or a station configurator from
a third-party manufacturer.
The IID or CID files can also be directly imported from the online PQ devices.

• PROFINET IO Master
The PNIO format is used for data exchange.
The PNIO file is created using the TIA Portal (≥ SIMATIC Step7 V13 SP1)

• SIPROTEC 4 Service IF Master
The INI format is used for data exchange. The INI file is created by SICAM RecProtec.
The file contains the device configuration data for SIPROTEC 4 devices with fault records that are read by
RecProtec.

• SICAM MIC Master
The XML file formatted for SICAM MIC Master is used for data exchange.
The XML file is created using SICAM TOOLBOX II.

ii NOTE
In order to be able to import GOOSE data, the GOOSE monitoring interface parameter must be set to Yes.
The IP address and Subnet mask parameters must not be equal to 0.0.0.0.

Proceed as follows to import one or several devices on the interface level into your project:
² In the configuration tree, right-click the interface and select Import... from the context menu.
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[sc_Importing_Config_File, 5, en_US]

Figure 2-8 Importing a Device Configuration File

² Select the device configuration file in the file system and click Open to confirm your selection.
If the import file includes several device configurations, the Import – select elements dialog opens. This
dialog shows a default selection of all devices which are available for import.
² In the Import – select elements dialog, select single or multiple devices to insert them under the

selected interface in the configuration tree.

² To import GOOSE data for a device, select the corresponding GOOSE column and the AP (access point) as
configured for GOOSE in the IEC 61850 System Configurator.

[sc_Importing_Several_dev, 3, en_US]

Figure 2-9 Importing Several Devices

In the Reports and logs tab of the IEC 61850 System Configurator (version 5.01 or higher), you can mark
the datasets whose information you want to use in SICAM PAS/PQS as Subset for SICAM in the Properties
section.
This marked information is available for detailed selection when determining the amount of information to
be imported and automatically mapped. For the Import you can either select All information supported by
SICAM PAS/PQS or Only information marked as a Subset for SICAM.

Configuration
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The information for Automatic Mapping is marked during import in the Selected column of the Mapping
view. You can limit the volume of information to be processed to Only information marked as a Subset for
SICAM or to Only frequently used information.
If the import file does not contain any information marked by the IEC 61850 System Configurator, the options
for limiting the amount of information to the subset for SICAM are not available. The option for automatic
mapping of frequently used information is only available if all information supported by SICAM PAS/PQS is
imported. The selection of the information to be used by SICAM PAS/PQS can be manually adjusted after
import in the Mapping view.

ii NOTE
These import settings only influence devices for which the pre-selection has been defined via the corre-
sponding parameter in the IEC 61850 System Configurator (version 5.01 or higher). All other devices are
imported via the standard mode.
In the standard mode all information is always imported and the frequently used items are preselected.
Once the import process has been completed, the user performs the definitive selection in the Mapping
view.
For the standard mode there is a differentiation between devices only supporting static datasets and
devices also supporting dynamic datasets (for example SIPROTEC).

• Static dataset
All information contained in static datasets is always imported and pre-selected. Subsequently, you
can select and deselect further data.

• Dynamic dataset
All information is imported, but only a part is pre-selected. You can select and deselect further data.

² To insert the selected information in your system configuration, click OK.
To import control center data into a device (Master protocol) in systems with a cascaded structure on the
interfaces level, proceed as described above. All control centers which have been exported for the interface of
the Slave protocol are now displayed in a selection list.

ii NOTE
When importing devices all the information in monitoring and command direction is set as Used in the
Mapping view.
If you use the IEC 61850 Client - Monitoring license for connecting devices in monitoring direction, only
the commands of the LN types LLN0 and RDRE may be used. For this reason, all the information which
is not assigned to the LN types LLN0 and RDRE must be deactivated in the Mapping view, Information -
command direction section.

Configuration Data for Individual Devices
You can import configuration data for individual devices for a number of protocols.
The import files include the configuration data of one or several devices. The contents depend on the
configuration tool with which they were created. After the import, you must customize the data to meet the
requirements of SICAM PAS/PQS.
Configuration data on the level of individual devices can be imported for the following applications:

• IEC 60870-5-103 Master
The DBF, DigT103, XML, or TEA-X data exchange format is used. The files are created in DIGSI.

• IEC 61850 Client
The IID or ICD format is used for data exchange.
The IID or ICD file is created by means of the IEC 61850 System Configurator or a station configurator
from a third-party manufacturer.

2.4.1.2
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• DNP3 Master
The DIGDNP and TEA-X (from DIGSI5 V6.20) format is used for data exchange. The file is created in DIGSI.

• PROFIBUS DP Master
The DIGPRODP format is used for data exchange. The file is created in DIGSI.

• Modbus Master
The DIGMOD format is used for data exchange. The file is created in DIGSI.

• SIPROTEC 4 Service IF Master
The XML format is used for data exchange. The file is created in DIGSI. The file contains the device data
for a SIPROTEC 4 device whose fault records are read by RecProtec.

• SIMEAS R Master
The SRP format is used for data exchange. The file is created using SIMEAS R PAR or OSCOP P. This data is
imported by using SIMEAS R PAR. SIMEAS R PAR is called up from the Configuration view. As soon as all
device parameters have been defined, the parameters are saved in the SICAM PAS/PQS database.

• SICAM Q80 Master
To create the configuration data of a SICAM Q80 device, use the SICAM Q80 Manager. The SICAM Q80
Manager is called up from the Configuration view. As soon as all device parameters have been defined,
the parameters are saved in the SICAM PAS/PQS database.

• For the OPC Client, you can transfer OPC Server data on the device level. A dialog for selecting informa-
tion opens when inserting the device.

Importing Configuration Data for Creating a Device
Proceed as follows to import a device into your project:
² Select the interface in the configuration tree. Select Device from the context menu.

² In the Insert – Device dialog, select the import file which includes the configuration data.

² Complete the rest of the parameters and click OK to confirm.
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[sc_Importing_Dev, 3, en_US]

Figure 2-10 Importing a Device

The import process is displayed in the Report.

Importing a Device Using a TEA-X File
You can import a device at the interface level using a TEA-X file which is exported from DIGSI 5 V6.20 and later
for the DNP3 Master and IEC 60870-5-103 Master protocols.
Proceed as follows to import a device at the interface level using a TEA-X file:
² From the configuration tree, select the interface that is assigned to the DNP3 Master/IEC 60870-5-103

Master application.

² Click Import… from the context menu.

² Select the required TEA-X file and click Open.
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[sc_103MasterImport, 1, en_US]

Figure 2-11 Importing Selected Devices

² In the Import – select elements dialog, select the required devices in the Selected column.

² Assign Channels for the selected devices in the Port column.

² Click OK, to import the selected devices.

Importing Data for Device Parameterization
To create the device data for SIMEAS R and SICAM Q80 devices, you use the SIMEAS R PAR and SICAM Q80
Manager parameterization tools. As soon as the parameterization has been completed, this data is transferred
into the database of SICAM PAS/PQS. The following example illustrates how to display SIMEAS R PAR.
Proceed as follows to import a SIMEAS R device into your project:
² Insert the device into the configuration.
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[sc_Starting_SIMEAS_R_Par, 3, en_US]

² To open the SIMEAS R PAR parameterization tool, click Open... from the context menu.

[sc_Parameters_SIMEAS_R_Par, 3, en_US]

Figure 2-12 Defining the Parameters of a Device by Using SIMEAS R PAR

² Define the device parameters according to your operational requirements or import a SRP parameter file,
for example, from OSCOP P.
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² Save and close the application.
The parameterization data is saved in the SICAM PAS/PQS database and the process is logged in the Report.
For more information on how to define the parameters of a SIMEAS R device, refer to /16/ SIMEAS R PAR,
Parameterization Tool.
For more information on how to define the parameters of a SICAM Q80 device, refer to the System Manual
and the Operating Instuction of SICAM Q80 Power Quality Recorder.

ii NOTE
When SIMEAS R is configured and you change the language of SICAM PAS/PQS, the channel names are
changed and must be re-assigned in topology and reports.

Configuration Data for Online PQ Devices

ii NOTE
To be able to download an IID file, the self-signed certificates of the device must be added to the Web
browser.
For more information refer to the Trusting Self-Signed Certificates in Browsers application note
which can be downloaded from https://new.siemens.com/global/en/products/energy/energy-automation-
and-smart-grid/grid-security.html.

Opening the Device Homepage
The Web user interface of the PQ devices SICAM Q100, SICAM Q200, and SICAM P855 which are connected via
IEC 61850 Client can be opened for configuring the device, viewing online data, and downloading records.
² Right-click the device and select Open device homepage... from the context menu.

- or -

² Double-click the device.
The device configuration homepage is opened on the default browser of your computer.

Importing/Updating Configuration Data of Online PQ Devices
The configuration data (IID and CID files) of SICAM Q100, SICAM Q200, and SICAM P855 devices can be
imported/updated directly from the online PQ devices.
Proceed as follows to import the configuration:
² Right-click the IEC 61850 Client interface and select Import/Update (online PQ devices)... from the

context menu.

² In the dialog which opens, enter the IP address range and click Scan.

² Select one or multiple devices to be imported or updated and click OK to confirm.

2.4.1.3

Configuration
2.4 Importing/Exporting

34 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023

https://new.siemens.com/global/en/products/energy/energy-automation-and-smart-grid/grid-security.html
https://new.siemens.com/global/en/products/energy/energy-automation-and-smart-grid/grid-security.html


[sc_ImportupdateonlinePQdevices, 1, en_US]

Figure 2-13 Importing or Updating Online PQ Devices

Configuration Data of Redundantly Connected Devices
If a device is connected through the redundant interface of the IEC 61850 Ed. 2 application, its parameteriza-
tion must include 2 access points.

Device Templates
In the Templates view, you can import or update device template files in TXT format. For more information,
refer to 2.11 Working with Device Templates.

Grid Codes
You can import Grid Codes in the Grid Codes view. Grid Codes define limit values for power quality evalua-
tion. For more information, refer to 2.16 Grid Codes.

Templates for Scheduled Reports
In the Reports view, you can import templates for scheduled reports. Scheduled reports are created for the
evaluation of PQ data. For more information, refer to 2.14 Reports.

2.4.1.4

2.4.1.5

2.4.1.6

2.4.1.7
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Updating Device Data

If you have adjusted the imported configuration data using one of the external configuration tools, you can
update the data in SICAM PAS/PQS UI – Configuration. The new and the old parameter data is compared
during this process.

Updating Several Devices
If your import file includes the configuration data for several devices, you can simultaneously update several
devices on the interface level.
This type of update is possible for the following applications:

• IEC 61850 Client (SCD)

• IEC 60870-5-101 Master

• IEC 60870-5-104 Master

• SICAM MIC Master
To update the configuration data for several devices:
² Right-click the Interface in the configuration tree and select Update... from the context menu.

[sc_Updating_Dev_selection, 5, en_US]

Figure 2-14 Updating Device Configurations (Selection)

² Open the configuration file from which you want to update the devices. All devices which are available
for an update are selected.

² In the Update – Select elements dialog, deselect all devices which you do not want to update (disable)
and click OK to confirm.

The selected device configurations are overwritten with the information from the update file.

2.4.2
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ii NOTE
When updating an IEC 61850 Ed. 2 device, make sure that you update with the file of the same device
which you have used for import.
If the IED name for a configured IEC 61850 device is changed, it cannot be updated further in SICAM
PAS/PQS UI – Configuration.

Updating Individual Devices
If your import file includes the configuration data for an individual device, you can update the device data on
the device level.
This type of update is possible for the following applications:

• IEC 61850 Client (CID, IID)

• IEC 60870-5-103 Master

• DNP3 Master (serial, TCP/IP)

• Modbus Master (serial, TCP/IP)

• PROFIBUS DP
To update the configuration data for an individual device:
² Right-click the device in the configuration tree and select Update... from the context menu.

² In the dialog which opens, open the configuration file from which you want to update the device.
The device is now overwritten with the information from the update file.
If your configuration file includes the data for several devices although you only want to update an individual
device, proceed as described above and select just one single device.
To update the configuration data for an individual device from the online PQ devices:
² Right-click the device in the configuration tree and select Update (online)... from the context menu.
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[sc_UpdateOnline, 2, en_US]

Figure 2-15 Updating Configuration Data of a Device

The configuration data for the PQ device supporting IEC 61850 protocol is updated by downloading the
configuration file (IID or CID) from the online PQ devices.

ii NOTE
If an SCL file is updated due to configuration changes for devices supporting PQ data, the IEC 61850 Client
driver processes only those channels from the PQDIF files according to the updated SCL file. The channels
that are no longer defined in the latest SCL file are skipped from the old PQDIF files.

Updating a Device Using a TEA-X File
You can update a device using a TEA-X file, which is exported from DIGSI 5 V6.20 and later for the DNP3
Master and IEC 60870-5-103 Master protocols.
Proceed as follows to update a device using a TEA-X file:
² In the Configuration view, right-click the DNP3 Master/IEC 60870-5-103 Master device and select

Update… from the context menu.

² Select the required TEA-X file and click Open.

Configuration
2.4 Importing/Exporting

38 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



[sc_DNPUpdateRequired, 1, en_US]

Figure 2-16 Updating Selected Device

ii NOTE
If the imported TEA-X file has the same device address as the configured device address, Identical is
displayed in the Update column. Otherwise, Required is displayed, which implies that the configured
device address is overwritten with the TEA-X file device address.

² In the Update - Select elements dialog, assign the Channels in the Port column to the devices.

² Click OK, to update the devices.

Exporting Configuration Data

SICAM PAS/PQS UI – Configuration provides functions for exporting configured and parameterized data. This
data can be used in other components of SICAM PAS/PQS or other systems.
You can export the following configuration data:
2.4.3.1 Control Center Interface (for example, Power CC)
2.4.3.2 SICAM SCC
2.4.3.3 Device Templates
2.4.3.4 Grid Codes
2.4.3.5 Devices

2.4.3
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[dw_export_TC, 2, en_US]

Figure 2-17 Exporting SICAM PAS/PQS Configuration Data to Higher-level Applications and Reuse for Other
Projects

In addition, you can export the configuration data for devices.

[dw_export_data, 2, en_US]

Figure 2-18 Exporting SICAM PAS/PQS Configuration Data for Devices

Control Center Interface
SICAM PAS/PQS UI – Configuration exports the data which you have selected for communication with a control
center.
Data can be exported for the following applications:

• IEC 61850 Server
The IID format, IEC 61850 Ed.2, is used for data exchange.

• IEC 60870-5-101 Slave
The XML format is used for data exchange.

• IEC 60870-5-104 Slave
The XML format is used for data exchange.

To export the configuration data for a control center:
² Right-click the Interface in the configuration tree and select Export... from the context menu.

2.4.3.1
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[sc_Exporting_Control_data, 2, en_US]

Figure 2-19 Exporting Control Center Data

² In the dialog which opens, enter the storage path for the control center's export data.
The export data for an IEC 61850 Server includes:

• Configuration data

• Mapped items of information and their topological assignments

• List assignments

SICAM SCC
SICAM PAS/PQS UI – Configuration exports the configuration data which you have selected for further use on
the SICAM SCC HMI.
The configuration data for the SCC application is exported in the TEA-X or PXD data exchange format.
To export the data for SCC:
² From the configuration tree, select a control center which is assigned to the SCC application. Select

Export from the context menu.

² In the dialog which opens, enter the storage path for the control center's configuration data.

ii NOTE
If you have modified the topological assignment of SCC data after the export, you can update the tag
names before any further export. Click Edit > Replace SCC tag names. In the dialog which opens, you can
decide whether you want to export the data with the modified topological designations or the original tag
names.
If you are using modified tag names, be aware that the links to graphical picture objects must be re-estab-
lished.

2.4.3.2
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Device Templates
In the Templates view, you can export device template files in TXT format. For more information, refer to
2.11 Working with Device Templates.

Grid Codes
You can export Grid Codes in the Grid Codes view. Grid Codes define limit values for power quality evaluation.
For more information, refer to 2.16 Grid Codes.

Devices
SICAM PAS/PQS UI – Configuration exports the device configuration for further use by other configuration
tools, for example, DIGSI.
Data can be exported for the following applications:

• IEC 60870-5-103 Master
The TEA-X format is used for data exchange.

• DNP3 Master
The TEA-X format is used for data exchange.

Data can be exported on different structure levels in the Configuration view:

• Application
The export file includes all configuration data of the interfaces and devices assigned to the application.

• Interface
The export file includes the configuration data of all devices which are assigned to the interface.

• Device
The export file includes the configuration data of the device.

Mapping

When importing a configuration file, a device's complete information is imported. If you do not want to use
all items of information, you can define a typical selection in the Mapping view. Afterwards, you can export
this selection as a template for other devices with the same volume of information. Afterwards, you can use
the import function in order to apply your selection to other devices. This procedure reduces the configuration
expenditure for devices of the same type.
In addition to the mapping of an item of information, additional parameters, for example, the Name param-
eter for IEC 61850 Ed. 2, are included in the import/export.
Mappings which you have previously exported can be further used in the same or another SICAM PAS/PQS
project.
In SICAM PAS/PQS, the import/export of mapping information is supported for the IEC 61850 application.

Exporting Mapping Information
To export mapping information for a device:
² In the configuration tree in the Mapping view, select the device and select Export mapping... from the

context menu.

² In the dialog which opens, enter the storage path for the control device's mapping information.

2.4.3.3

2.4.3.4

2.4.3.5

2.4.4

2.4.4.1
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[sc_Exporting_Mapping_info, 3, en_US]

Figure 2-20 Exporting Mapping Information

Importing Mapping Information
To import the mapping information for a device:
² Right-click a device and select Import mapping... from the context menu.

2.4.4.2
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[sc_Importing_Mapping_info, 3, en_US]

Figure 2-21 Importing Mapping Information

² Open the XML file from which you want to import mapping information.
The Import – select elements dialog opens.

² Select the elements to be imported and click OK to confirm.
The elements have the same names as the corresponding columns in the Mapping view.
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[sc_Selecting_Elements, 1, en_US]

Figure 2-22 Selecting Elements

To import the mapping information for several devices of an interface in the Configuration view:
² Click an interface in order to import its mapping information. Select Import mapping... from the context

menu.

² Open the XML file from which you want to import mapping information.
The Import – Select devices dialog opens.

² Select the devices for which you want to import mapping information and click OK to confirm.
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[sc_Selecting_Dev, 1, en_US]

Figure 2-23 Selecting Devices

Managing the Objects of a Project
You can edit the tree structures in the different edit views of your project.
The following options are available:

• 2.5.1 Copying Objects

• 2.5.2 Pasting Objects

• 2.5.3 Moving Objects

• 2.5.4 Deleting Objects

• 2.5.5 Renaming Objects
If you use the context menu, the context menu shows you for each selected structure element which edit step
is possible.

[sc_Context_menu_ex, 1, en_US]

Figure 2-24 Context Menu, Example

Copying Objects

To copy an object into the clipboard of SICAM PAS/PQS:
² Select the object which you want to copy, for example, a device in a configuration tree.

2.5

2.5.1
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² Select Copy from the context menu.
The context menu shows the copy function only on those structural levels and for those tree objects for which
the Copy function technically makes sense. This also applies to the Cut function.

ii NOTE
The project and the Full Server cannot be copied.
Copied objects can only be pasted to locations where they can also be created directly by using the Create
function. Lower-level objects are also copied.

Pasting Objects

When pasting an object, be aware to select the correct level in the tree structure.
² Select for example, an interface in the configuration tree in order to insert the device on this interface.

² Select Paste from the context menu, to create multiple copies of the objects.

ii NOTE
Different names must be assigned to subordinated objects within the same level. For example, the names
of devices which communicate with SICAM PAS/PQS by using the same interface must be unique. However,
devices which communicate by using different interfaces can have the same name.

Moving Objects

To move an object, cut it and paste it to another place in the tree structure.
² Select the object which you want to move, for example, a device on Interface 1.

² Select Cut from the context menu.

² Select the level under which you want to create the object, for example, Interface 2.
Click Edit > Paste to paste the object.

ii NOTE
Drag and drop is a user-friendly and time-saving method for moving objects.

• Click the object.

• Hold down the mouse button and drag the object to the new position.

• Release the mouse button.
If you try to drag an object to a position where it cannot be pasted, this step will be rejected. The mouse
pointer shows a black prohibition sign.
If you move the object to a level on which an object of the same type already exists (for example, an object
with the same name or the same address), a dialog opens. In the dialog which opens, the fields to be
adapted are highlighted in red.

Deleting Objects

To permanently remove an object from your station structure:
² Right-click the object and select Delete from the context menu.

2.5.2

2.5.3

2.5.4
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Renaming Objects

To rename an object in the tree structure:
² Right-click an object and select Rename from the context menu.

² Overwrite the object name in the tree structure.
- or -

² Left-click to select the object in the tree structure.

² Overwrite the object name in the Properties window.

ii NOTE
If you change the computer name following the installation of SICAM PAS/PQS, you must adapt the
environment information stored. To do this, you require administrator rights.
Proceed as follows:

• Change the computer name under Windows and restart the computer.

• Right-click the FixHostname.exe application and select Run as administrator from the context menu.
You will find this application in the SICAM PAS installation folder for binary files (%PAS_BIN%\FixHost-
name.exe).

• Restart the computer.

• Open SICAM PAS/PQS UI – Configuration, select the system from the tree structure and enter the
current name of the computer under Computer name.

• For opening SICAM PAS/PQS UI – Configuration Client, add the new computer name to the shortcut of
UI - Operation Client.
– Click Start and scroll through the app list.
– Select UI - Operation Client from the SICAM PAS/PQS folder.
– Select Properties from the context menu.
– Modify the computer name in the Target field accordingly.
– Confirm with Ok.

• Open SICAM PAS/PQS UI – Operation and click Update system in the Status window.

Setting Up and Editing the Configuration
In the Configuration view, you can configure and parameterize your SICAM PAS/PQS project. The configura-
tion data is saved in the %PAS_APPDATA%\Database\pas.db installation directory in the project database.
When opening SICAM PAS/PQS, the currently active project database is loaded and shown automatically.
Archive the current project database before modifying the configuration or mapping of your project. This
ensures that this data version is available for later use, refer to 2.3 Working with Project Databases.

How to Proceed
To set up a station configuration with SICAM PAS/PQS, consider the following order:

• 2.6.1 Defining a Project

• 2.6.2 Inserting and Managing Systems

• 2.6.3 Selecting an Application

• 2.6.4 Inserting an Interface

2.5.5

2.6
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• 2.6.5 Inserting a Device/Control Center

• 2.6.6 Inserting a List (General)
The created system components are shown in the hierarchical structure in the navigation tree.

Defining a Project

In a new SICAM PAS/PQS project, the project level is only entered in the configuration tree.
On this level, you identify a project by assigning a unique designation, a brief explanation text and a project
ID. The SICAM SCC HMI recognizes the project by its project ID.

Entering Project Data
To enter General parameters or Project settings or modify the default settings:
² In the input area, select a parameter name or a parameter value. Overwrite the parameter value or select

the setting from the selection list.
Explanations on the parameters are available in the information field.

[sc_General_Parameters, 3, en_US]

Figure 2-25 General Project Parameters

Table 2-1 SICAM PAS/PQS Project: General Parameters

Parameter Name Explanation
Name Here, you can enter the project name. This name is suggested while archiving/

exporting the project database and also appears in the configuration, mapping,
and topology tree.

Description Here, you can enter further information about the project.
Company name Here, you can enter the company name.
Created by Here, you can enter the name of the person creating the project.
Created on Here, you can enter the project creation date.
Updated by Here, you can enter the name of the person editing the project.
Updated on Here, you can enter the last project modification date.
Project ID This parameter provides a unique identification number for a SICAM PAS project

in a SICAM SCC system connected to multiple SICAM PAS systems.

2.6.1
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Parameter Name Explanation
Command processing
mode

Number of commands which may be executed simultaneously. In the Mapping
view, for each command, you must specify if it is subject to command
processing. To disable the command processing mode, enter the value ‘0’.
To enable the command processing mode, enter any positive integer, for
example 2, which means that 2 commands are executed at the same time.

Hide warnings Here, you can hide or show configuration warnings.
(Value range: Yes, No)
(Default value: No)

Runtime language Here, you can select the language for the output of spontaneous indications,
process indications, or PQ reports.
This parameter does not change the user interface language.

Inserting and Managing Systems

SICAM PAS/PQS supports distributed station configurations. A distributed system is located on multiple
computers.
The station configuration includes:

• Full Server
1 computer acts as SICAM PAS/PQS server. In addition to the applications, the data distribution system,
the DSI server and the relational database are located on this computer.

• DIP (Device Interface Processor)
All other computers in the configuration act as device interface processors (DIPs).
The Full Server database can be accessed by using an ODBC interface.
All applications on the DIP are connected to the Full Server with the help of the TCP/IP.
A DIP can be used in order to process large data volumes. In large systems with a large number of
SIPROTEC 4 devices, you connect the devices to a DIP. The HMI functions are realized by using the Full
Server.

ii NOTE
The first system in a SICAM PAS/PQS project is automatically entered as Full Server. All other systems are
automatically inserted as DIPs. These assignments cannot be modified.

Full Server and DIPs can operate on redundant hardware components.
For more information on redundancy, refer to /9/ SICAM PAS, Redundancy.

Inserting a System
Proceed as follows to insert a system:
² Select the project and select System from the context menu.
Your own computer is automatically inserted as the first system, which acts as the Full Server.

Configuring a System
To configure a system:
² Select the system in the configuration tree. The system parameters are displayed in the input area.

2.6.2

2.6.2.1

2.6.2.2
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[sc_System_Parameters, 3, en_US]

Figure 2-26 System Parameters of the Full Server

² Select a parameter name or a value in the input area and modify this parameter value.

² Overwrite the value or click the button to the right of the value ( ... ). You can specify the parameter
value in the dialog which opens.

² To apply your settings, select another parameter.

Configurable System Parameters
These parameters are automatically entered when you create the Full Server or the DIPs. You can modify them
afterwards.

Table 2-2 System General Parameters

Parameter Name Explanation
Name The system name is a free text input area.

The name of your own computer is shown as a default name for the Full Server, but
you can modify this name as desired.
The system suggests Device Interface Processor (DIP) as the name for a DIP. You can
change this name as desired.

Description Description regarding the added system (free text input)

2.6.2.3
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Parameter Name Explanation
Computer name The name of your own computer is shown as a default name for the Full Server,but

you can modify this name as desired.
The computer name may consist of up to 128 characters and must not include any
special characters (exception _).
If your computer is part of an active network, the first 2 IP addresses of the network
adaptor are automatically assigned.
To use another computer in the network as Full Server, click the input box for the
computer name. Click ... to open the Browse for computer window. Select the desired
computer in the network. The computer name and the corresponding IP addresses are
assigned. Change the system name.
The system suggests DIP as the name for a Device Interface Processor (DIP). You can
freely modify this name and/or browse for a computer in the network.
When setting up a station configuration offline, you can enter the system name as text.
Make sure that the defined name corresponds to the actual name of the computer in
the network and correct it later on the destination system. If you change the computer
name following the installation of SICAM PAS/PQS, the environment information stored
must be adapted accordingly. For more information, refer to 2.5.5 Renaming Objects.
Ensure that the computer name only contains alphanumeric characters excluding few
extended characters.
Some older operating systems machine names with multiple '-' may not work in certain
configurations and you should always consult Operating System documentation for
conformance.
For more information, see https://support.microsoft.com/en-us/kb/909264.

System resources In SICAM PAS/PQS, all serial interfaces, modem connections via TAPI interface, and
CP5613/14 modules of a computer in your station are referred to as system resources.
Network cards and addresses are separately managed.
System resources can be freely defined. To do this, click the input box. Click ... to open
the Manage system resources dialog.
In this dialog, click Delete or Insert to manually edit the resources list.
As long as no system resources are entered under System resources, you cannot insert
interfaces for this system. This applies to serial interfaces, modem connections, and
CP5613/14 modules.

Type of system SICAM PAS/PQS automatically assigns the type of system:
The system which was inserted first always acts as Full Server.
Each additional system is automatically classified as a Device Interface Processor (DIP).
The system type cannot be modified.

IP address 1 First IP address of the system
The IP address is identified by using the system name (see Name).
If the computer is not integrated in an active network, 127.0.0.1 is entered by default
as the first IP address.

IP address 2 IP address of the second network card in the system
The system can be equipped with a second network card for interfaces of the station
configuration.

Standby buffer
timeout [s]

Maximum switchover time of a redundant system component
If the connection to the device is disturbed, SICAM PAS/PQS stores its messages in a
temporary buffer during this time in order to prevent the loss of information until the
switchover to the redundant system. Select a standby buffer time which is greater than
the sum of the switchover time and the detection time. The switchover time depends
on the error detection time and the necessity of a computer switchover. The detection
time depends on the protocol and the configuration.
The value for the standby buffer time must lie between 0 to +2 147 483 647.
For more information on redundancy, refer to /9/ SICAM PAS, Redundancy.
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Table 2-3 System Project Settings

Parameter Name Explanation
Redundancy Indicates whether the Full Server or the DIP runs on a redundant hardware component

For more information on redundancy, refer to /9/ SICAM PAS, Redundancy.

Setting up a Distributed Configuration
To set up a distributed configuration, insert further systems into your station configuration:
² Select the project name in the configuration tree and select System from the context menu.

[sc_Inserting_DIP, 3, en_US]

Figure 2-27 Inserting a DIP

Creating a Redundant System
To create a redundant system:
² In the Redundancy field under Project settings in the input area, select Yes.

² Enter the computer name of the redundant system or click the ... button to find the computer.

² Enter the IP address of the redundant computer.

2.6.2.4

2.6.2.5
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[sc_Inserting_Redundant_Sys, 3, en_US]

Figure 2-28 Dialog Window for Inserting a Redundant System

The project is run in hot standby mode. If a system component fails the process is switched over.
For more information on the different options for the redundant configuration of system components, refer
to /9/ SICAM PAS, Redundancy.

Managing System Resources
In the Manage system resources dialog, you can determine and manage connections available for data links
in the system.
Network connections, that is, IP addresses, cannot be managed in this dialog.

2.6.2.6
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The following connection types can be determined and managed:

• COM Port for the serial connection of devices

• Modem for the connection of devices through dial-up connection

• CP5613/14 interface card for the connection of PROFIBUS devices

[sc_Manage_Sys_Resources, 1, en_US]

Figure 2-29 Manage System Resources Dialog

Automatic Determination of Connections
To automatically determine all connections of this system:
² Click Search.

ii NOTE
The connections available on a system can only be determined automatically by using this method, if the
computer name can be determined from the station’s IP address (DHCP Client or by using the Host file).

Manually Inserting a System Interface
System interfaces which are not available can be added manually. This is required, for example, if you define a
system configuration offline in order to use it later on another system.
² Click Insert to open a selection window.

² Select the interface type from the list box.

² Enter the serial interface number of the new COM port in the Insert system resources dialog.

² Enter a name for the modems.
The new interface is inserted into the Manage system resources dialog.

2.6.2.7

2.6.2.8
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Deleting a System Interface
System interfaces which you no longer need in your configuration can be removed from the list of system
resources.
² To do this, click the interface in the Manage system resources dialog and then click Delete.
The interface is removed from the list and is no longer available for the definition of data links.

Selecting an Application

Select the application which you want to use for communication.
For protocols via which you communicate with devices or control centers, the following 2 applications variants
are distinguished:
For serial or modem connections:

• Master for setting up data links to devices

• Slave for setting up a data link to a control center
For network connections:

• Client for setting up data links to devices

• Server for setting up a data link to a control center

You establish the connection to further SICAM PAS/PQS system components by using the following applica-
tions:

• SCC
SICAM SCC Human-Machine Interface (HMI)

• SoftPLC
Configuration of customer-specific functions with CFC, SFC and ST

• Archive
Storage of archive data, including fault records, events, PQ measuring data, and PDR records

• PDR Recorder
Recording of selected network data for the evaluation of power network faults

• PQS Automatic Fault Location
Determination of the fault location in the network

• PQS Automatic Import
Import of fault records or PQDIF data for power network quality evaluation

• PQS Automatic Export
Export of fault records, PQ data, Grid Code violations, and reports

• PQS Scheduled Reports
Scheduled reports with selected measured values for power network quality evaluation

• PQS Automatic Notification
Notification by SMS and/or e-mail as soon as an alarm has occurred or a report is available for example,
on PQ violations, fault locations or the receipt of a fault record. You are also notified by e-mail on the
completion of scheduled reports.

You configure the applications in SICAM PAS/PQS UI – Configuration. For the evaluation of archived data,
you use the different views of the SICAM PQ Analyzer, for example, Report Browser. The fault location is
determined by the SICAM PQS Fault Locator.
To insert an application in your station configuration:
² In the configuration tree, right-click the system via which the data link is realized (Full Server or DIP) and

select the application from the context menu.

2.6.2.9

2.6.3
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[sc_Inserting_Apps, 2, en_US]

Figure 2-30 Inserting an Application

² Customize the application parameters in the input area.
For more information on the parameters, refer to the application descriptions in the online help.

ii NOTE
Each application can be inserted only once in the configuration tree below a system. Depending on the
individual application, you can operate one or several interfaces.

Inserting an Interface

Interface
You can select the connection type and the connection parameters on the interface level. Some applications
allow the operation of several interfaces.
For the interface to be inserted, a connection must be available in the system resources.
To insert an interface, proceed as follows:

2.6.4
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² In the configuration tree, right-click the application for which you want to insert an interface and select
Interface from the context menu.

[sc_Inserting_Interface, 3, en_US]

Figure 2-31 Inserting an Interface

² Define the parameters of the interface in the input area.
It is possible to modify the interface parameters later.

ii NOTE
The names of the interfaces of an application must be unique.
A new interface is automatically assigned to the next free COM port, CP5613 port, the next free modem or
an IP address.
In the IEC 61850 protocol, if the IP address has also been assigned using a system configurator such as
DIGSI, you must enter the same IP address in the transmission parameters of the interface.
Check the automatically assigned connection parameters and customize them according to your require-
ments.

For more information on the interface parameters, refer to the application descriptions in the Online help.

Inserting a Device/Control Center

Device
You can communicate with one or several devices through an interface.
The device data can be available as device templates or can be imported. The import files are created with
DIGSI, SICAM Toolbox II or SICAM Webmic. You do not need to customize any further parameters for this
device. Some protocols support the import of several devices.
To insert a device:
² Right-click the interface for which you want to insert a device and select Device from the context menu.
The Insert – Device dialog opens.

2.6.5
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[sc_Inserting_Dev, 7, en_US]

Figure 2-32 Inserting a Device
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[sc_Selecting_Dev_Template, 4, en_US]

Figure 2-33 Selecting a Device Template

² Select either a device template or an import file and click OK to confirm.

² Fill in all fields which are highlighted in red.

ii NOTE
Device configuration files cannot be imported for all applications. You use templates for these devices. For
more information, refer to 2.4.1.1 Configuration Data for Several Devices.
To define the parameters of SIMEAS R and SICAM Q80 devices, you must use device-specific parameteriza-
tion tools. Insert the devices in your configuration and call up the parameterization tool from the configura-
tion. For more information, refer to 2.4.1.1 Configuration Data for Several Devices as well as /16/ SIMEAS
R PAR, Parameterization Tool and the System Manual and the Operating Instruction of SICAM Q80 Power
Quality Recorder.
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ii NOTE
If you do not enter a specific name for the device, the name will be applied from the device template/
import file during the import process. For more information on the import of device data, refer to
2.4.1.2 Configuration Data for Individual Devices.

Control Center
Under the applications which serve for the communication with control centers or SICAM SCC, insert a control
center under the interface level.
To insert a control center:
² Right-click the interface in the configuration tree and select Control center from the context menu.

² Assign a name for the control center or the SICAM SCC connection.

[sc_Inserting_Control_Center, 3, en_US]

Figure 2-34 Inserting a Control Center

Inserting a List (General)

For many devices and control centers, you can create lists in the Configuration view. In the Mapping view,
you assign these lists items of information.
To create a list:
² Right-click the device or the control center in the configuration tree and select List from the context

menu.

2.6.6
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[sc_Creating_Interrogation_list, 3, en_US]

Figure 2-35 Creating a General Interrogation List

² Configure the general interrogation list. You can select other lists to configure from the Type field.

[sc_Defining_Interrogation_Parameters, 3, en_US]

Figure 2-36 Defining General Interrogation Parameters

For more information on the general interrogation list parameters, refer to the application descriptions in the
online help.
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Inserting Lists with IEC 61850 Client

When using the IEC 61850 protocol, the mapping (reporting) can be defined as follows:

• Fixed definition in the protection device (static reporting)

• Flexible definition in the substation controller (dynamic reporting)

Static Reporting
Static reporting is defined using the configuration tool of the protection device or the IEC 61850 system
configurator tool. Afterwards, these settings are transferred to the protection device and imported into SICAM
PAS/PQS via an SCD file. The ReportControl and the corresponding DataSet in the SCD file are represented as
a list. To map additional messages in such a list, the system configurator, protection device configuration and
SICAM PAS/PQS import chain must be run again.
If a ReportControl has been created in the SCD file and if this ReportControl is linked to another address
than the IP address of the corresponding SICAM PAS/PQS interface (via the ClientLN attribute), this list is not
imported by SICAM PAS/PQS in order to avoid resource conflicts with other substation controllers.
However, if the IP address of the Client interface has been linked to the ReportControl, it is preferred during
the import.

Dynamic Reporting
For certain protection devices which support dynamic reporting, the mapping can be modified in SICAM
PAS/PQS. The new configuration is transferred automatically into the protection devices via the IEC 61850
protocol. The protection device configuration or the system configurator tool are not required for this
purpose.
The lists for dynamic reporting can be created by:

• Inserting a list

• Importing an SCD file via the interface
2 internal lists are created when importing the SCD file of these devices:

• Buffered list

• Unbuffered list
Each mapped value is automatically assigned to the corresponding (buffered or unbufferd) list if it has not yet
been assigned to another list via import or parameterization.

Importing a List
To import a list:
² Select the interface in the configuration tree and select Import... from the context menu.

² In the dialog which opens next, select the SCD file and click Open.
During the import, the MMS address, the Report identifier and the Report control block are deter-
mined from the import file and entered in the list.

2.6.7
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[sc_Importing_SCD_file, 3, en_US]

Figure 2-37 IEC 61850, Importing an SCD File with Dynamic Reporting

If this is not possible, the fields remain empty and the IEC 61850 Client application tries to determine these
values during runtime.

Inserting Lists with IEC 61850 Server

ii NOTE
The IEC 61850 Server application supports the IEC 61850 standard Edition 2 and 2.1 based on your
selection.

 
By creating the first list you define the standard used by the interface which can run either as MMS or as
GOOSE.

• MMS designates the connection-oriented (TCP/IP) data transmission between the IEC 61850 Server
(SICAM PAS) and IEC 61850 Clients (e.g. control center).

• GOOSE designates the transmission of data between bay units or (in this case) from the substation
controller to the bay units/IEDs as a multicast transmission without a direct connection. GOOSE data is
not transmitted to a particular receiver. The receivers are assigned a specific MAC address destination via
which they can filter the data. Since it cannot be determined for sure that the data has been successfully
transmitted to the receiver when using this procedure, the information is transmitted at cyclical intervals.

ii NOTE
A GOOSE list can be created only, if no interface redundancy is set and if the IP address is not equal to
0.0.0.0.

2.6.8
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Inserting GOOSE Lists
GOOSE works with the MAC address determined by the IP address. If you do not enter an IP address, the first
MAC address (connection) found will be used. Siemens recommends always enter the IP address when using
GOOSE. This ensures that always the right MAC address/network interface card is addressed even if multiple
MAC addresses exist, for example when using multiple network interface cards or networks.
To define a GOOSE list:
² Right-click the IEC 61850 Server application and select Interface from the context menu.

² In the Transmission parameters area of the interface, set the GOOSE parameter to Yes.

² Enter the IP address at which the application will be accessible. This IP address is written to the IID export
file too.
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[sc_Defining_GOOSE_interface, 3, en_US]

Figure 2-38 IEC 61850 Server, Defining the Interface with GOOSE List

² Insert a station and select GOOSEList from the context menu.
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[sc_Selecting_GOOSE_list, 3, en_US]

Figure 2-39 IEC 61850 Server, Selecting a GOOSE List

ii NOTE
A maximum of 20 GOOSE lists per station can be inserted.
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[sc_GOOSE_list_inserted, 3, en_US]

Figure 2-40 IEC 61850 Server, GOOSE List Inserted

ii NOTE
If you delete a GOOSE list or change the mapping of a GOOSE list, you must update the IEC 61850 station
in the IEC 61850 System Configurator accordingly.
The GOOSE list parameters of an exported SCL file, which are changed in the IEC 61850 System Configu-
rator can be updated on an interface level.

ii NOTE
In case of redundancy configuration, the destination MAC address must be the same for both primary and
secondary SICAM PAS/PQS system.

Archive

By using the Archive application, you can add the connection to a (source) archive on a Full Server. This
archive stores:

• Fault events

• Fault records

• Events (process information)

• Fault location reports

• Scheduled reports

• PQ violation reports

• PDR records

2.6.9
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The SICAM PQ Analyzer serves for the evaluation of the archived data in several views according to different
criteria.
For the evaluation of fault records, the Incident Explorer uses the COMTRADE Viewer or SIGRA. PDR records
are viewed using the PDR Viewer.
The fault event, the associated fault records, and the related events which occured in the power network are
visualized in the Fault Event Viewer.
The events selected in the Mapping view are visualized in the Event Viewer.
For more information on the SICAM PQ Analyzer, refer to /13/ SICAM PQ Analyzer and /14/ SICAM PQ Analyzer,
Incident Explorer.

Configuring the Archive
To configure an archive:
² Select the system in the configuration tree and insert the Archive application.

² In the dialog which opens, enter the storage location under Archive directory. Network directories or
removable media are not permissible as archive directory.

ii NOTE
The SICAM PAS PQS Users user group must have write permission for the directory.
To achieve this, open the Properties of the directory, select the Security tab and add the SICAM PAS PQS
Users user group to the Group and user names via Edit... > Add... . Grant the write permission.

² Specify the size (0.4 - 100 GB) of the archive in the Archive size field.

[sc_Inserting_Archive, 4, en_US]

Figure 2-41 Configuring an Archive

ii NOTE
When the SICAM PQ Analyzer is connecting to an archive, the user is authenticated by default. Secure
authentication can be disabled to allow access to the archive, for example, if both computers do not belong
to the same domain. To disable the secure authentication feature, the SICAM PQ Analyzer must be updated
to V3.11 HF2 or later.

2.6.9.1
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Storing Process Information
The following information selected in the Mapping view is stored in the archive and can be displayed in the
Event Viewer of the SICAM PQ Analyzer:

• Single-point, double-point, and bit-pattern indications (for process-value changes)

• Fleeting indications, indications with value

• Command messages
The process states determined by startup general interrogation are not archived.

ii NOTE
Operational measured values are not logged in the event list and, thus, are not stored in the archive.

² Right-click the Archive application and select Process information from the context menu.

² Right-click Process information and select Event list from the context menu.

² Right-click the Event list and select Go to... from the context menu.

² In the dialog which opens, confirm the Mapping view.

² Select all the items of information that you want to be stored for displaying in the Event Viewer.

ii NOTE
For storing the events in the archive the Event List / Fault Events feature must be enabled via the SICAM
PAS/PQS Feature Enabler.

Configuring Fault Events
The fault event, the associated fault records, and the related events which occurred in the power network can
be visualized in the Fault Event Viewer of the SICAM PQ Analyzer.
To configure the fault events:
² Right-click the Archive application and select Fault event information from the context menu.

² Enter the Pre-trigger duration [s] and Post-trigger duration [s].
The pre-trigger duration refers to the time span prior to the trigger point of the fault event. If the
pre-trigger record duration of the fault record is greater than the configured Pre-trigger duration [s], the
pre-trigger record duration of the fault record is considered.
The post-trigger duration refers to the time span after the trigger point of the fault event. All the
fault records generated during the Post-trigger duration [s] are included in the fault event. If the
post-trigger record duration of the fault record is greater than the configured Post-trigger duration [s],
the posttrigger record duration of the fault record is considered.

ii NOTE
For generating fault events and storing them in the archive the Event List / Fault Events feature must be
enabled via the SICAM PAS/PQS Feature Enabler.

PDR Recorder

The PDR Recorder records selected information of a station over a selectable period of time. These records
allow the precise analysis of the causes of network faults.
To insert the PDR Recorder application:
² In the configuration tree, select the name of the system and insert the PDR Recorder application.

² Select this application and select PDR archive from the context menu.

2.6.9.2

2.6.9.3

2.6.10
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² In the Support of the legacy RECPRO archive field, select Yes if you want to collect PDR records by
SICAM Recpro Collector V6.

² Select PDR archive and insert a PDR group.

² In the PDR parameters input area, define the time window through which the information of this group
is recorded upon triggering.

[sc_Inserting_ PDR_group, 3, en_US]

Figure 2-42 Inserting a PDR group

In the Topology assignment input area, you see the topological level which is assigned to the PDR group. The
PDR record is stored in the archive, under this topological assignment. The PDR record is selected and viewed
in the SICAM PQ Analyzer in the Incident Explorer view.
In the Mapping view, you select which items of information is to be included in the PDR group and which
information acts as a trigger.
For more information on the PDR records, refer to /14/ SICAM PQ Analyzer, Incident Explorer.

PQS Automatic Fault Locator

The Fault Locator is used to calculate the fault location in order to ensure that the cause of a network fault can
be detected within a short time. It can be used:

• As a single-ended or two-ended Fault Locator in systems with single or double lines

• For parallel line compensation

• It also supports fault location based on travelling wave algorithm
To insert the PQS Automatic Fault Location application:
² Select the system in the configuration tree and insert the PQS Automatic Fault Location application.

2.6.11
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[sc_Inserting_PQS Automatic_App, 3, en_US]

Figure 2-43 Inserting the PQS Automatic Fault Location Application

In the Topology view, Properties tab, you define the parameters required for calculating the fault location,
including the number of lines, the line length and the starpoint position.
In addition, you assign the measuring channels for the evaluation of the fault records' voltage and current
channels.
The Global line overview tab provides an overview of all line data for which parameters have been defined.
For more information on the functionality and parameterization of the Fault Locator, refer to /12/ SICAM PQS,
Fault Locator.

PQS Automatic Fault Locator Based on Travelling Wave Algorithm

The PQS Automatic Fault Location application supports the fault location calculation based on travelling wave
algorithm in addition to the other fault location algorithms available. For more information on configuration
of importing the fault records from a device which supports the travelling wave algorithm and creating a fault
location report for that device, refer to Fault Records Sorted by Device, Page 80

ii NOTE
Single-ended fault location based on traveling wave algorithm is not supported.

PQS Automatic Import

The Automatic Import is used to transfer data in PQDIF and COMTRADE format from a user-defined path.
This is because, based on the configuration of virtual devices, you transfer PQ data and fault records from
devices which do not communicate through a protocol supported by SICAM PAS/PQS. Fault records can also be
transmitted via File Transfer Protocol (FTP) and from the device which supports Travelling wave algorithm.
The import path must always be defined as a complete network path (UNC path), mapped drives are not
permissible.

2.6.12

2.6.13
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ii NOTE
If the PQDIF file name contains Unicode characters that are not supported by the current language setting
of the operating system and an error is encountered during the import, the Report displays non-readable
characters as the PQDIF file cannot be read.

In this way, you transfer data in the following formats:

• PQDIF (Power Quality Data Interchange Format) for PQ data

• COMTRADE (Common Format for Transient Data Exchange) for fault records
After you have inserted the PQS Automatic Import application into the system, configure the data import as
follows:

• 2.6.13.1 Importing PQ Data

• 2.6.13.3 Importing Fault Records

ii NOTE
The SICAM PAS PQS Users user group must have write permission for the directory.
To achieve this, open the Properties of the directory, select the Security tab and add the SICAM PAS PQS
Users user group to the Group and user names via Edit... > Add... . Grant the write permission.

Importing PQ Data
To import the PQ Data, proceed with the following steps:
² Right-click PQS Automatic Import and select Device group from the context menu.

² In the dialog which opens, select PQDIF in the Import type field under General parameters.
Automatically, the Import mode is set to File-based.

² In the Import directory field under PQDIF import configuration, select the import path for the PQ data.

² In the Delete PQDIF data field, select whether the PQ data shall be removed from the source directory
after the import.

[sc_Insert_Dev_Group_PQDIF, 2, en_US]

Figure 2-44 Insert - Device Group PQDIF
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ii NOTE
To ensure that the size of the Import directory does not increase continuously, set the value of Delete
PQDIF data to Yes.

² Confirm with OK.

² Select the Device group and insert a Device.

² Under the General parameters of the device, select Sample Device PQDIF in the Device template field.

² Confirm with OK.

[sc_PQS_Automatic_Import_PQDIF, 4, en_US]

Figure 2-45 PQS Automatic Import PQDIF

DDRecCreation for third party devices

Overview
DDRecCreation is a command line tool for creating a device template file and a ddrec file. Based on such files,
SICAM PQS will be able to import the third-party PQDIF files.
To precisely interpret the PQDIF-content, SICAM PQS requires the respective channel descriptions of PQ Data
in PQDIF-files.
Power Quality data from third-party PQ devices that provide data with PQDIF-files (*.pqd) can potentially be
integrated into SICAM PQS in two ways:
Use case a
3rd-party devices which are not connected to SICAM PQS with IEC 61850:
PQDIF files can be imported from directory using SICAM PQS Automatic PQDIF Import Service. The import
service is supported since the first SICAM PQS version V7.0.
Use case b
3rd-party devices supporting IEC 61850 and transmitting PQDIF-files via IEC 61850:

2.6.13.2
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Such devices can be connected to SICAM PQS IEC 61850 Client. This service is supported since SICAM PQS
version V8.19.

Challenge
Up to V8.18, such channel descriptions must be created manually, either in the SICAM PQS UI Configuration’s
Template view or in device description text files. Manual creation of channel descriptions needs expert
know-how and high effort.

Improvement / Solution
With SICAM PAS/PQS V8.19, the additional tool DDRecCreationTool is available and can be used for creating
the following:

• Information files about the channels that are not supported

• Device description file (Automatic PQDIF Import Service) and ddrec file (IEC61850-connected devices)
Both the file-types can be used to import/update in SICAM PQS UI Configuration’s Template view.

The DDRecCreationTool requires a third-party PQDIF-file (created by a third-party PQ device) as an input file to
create such files.

ii NOTE

• The template file is created based on one PQDIF file from a third-party device.
If the third-party device splits the characteristics/channel information (PQ data) into multiple PQDIF
files, select the file that best suits your purpose.

• After importing/updating files created by DDRecCreationTool, the operating values must be entered by
the user in the UI-Configuration -> Template.

• The files …_ImportService.txt and …ddrec created by the DDRecCreationTool, can be used for
multiple devices of the same device type with the same channel names used in PQDIF-files from
the devices.
– In case of automatic import service, the device description file …_ImportService.txt will be

imported once in template view of UI Configuration and referenced for each device created in the
Configuration view. The device name for the device created needs to be identical with the device
name used in PQDIF-file transmitted from a connected device.

– In case of devices connected with IEC 61850 (by importing IEC 61850-SCL-files), each correlated
device template in template view of UI Configuration needs to be updated with the ddrec-file
created with DDRecCreationTool.

Launching DDRecCreationTool and Files Created
DDRecCreationTool will launch in a Command Line window with these two parameters:
DDRecCreationTool.exe -dir <folderpath> - pqdfile <file>
The files below are created just for information:

• …-NotSupportedChannels.txt
Contains channels that are not supported by SICAM PQS due to PQDIF tag mismatch.

• …-NotMappedChannels.txt
Contains channels that are not supported by the system since the characteristics are not used in SICAM
PQS and SICAM PQ Analyzer.

• …_unknown.txt
Contains channels, for which the abbreviations used are unknown.

The files below are created for import/update in UI Configuration’s Template view:
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• DeviceDescription-file …-SupportedChannels_ImportService.txt for being imported for “Automatic PQDIF
Import” service (compare use case a. on previous page)

• ddrec-file …-SupportedChannels.ddrec which will be used for updating the device templates in case of
IEC 61850 connected devices (compare use case b on previous page).

Number of Supported Channels
Channels listed in ddrec- and device template-file are selected as supported based on SICAM PQS knowledge
base used for IEC61850.
Not all the channels (number mentioned in DDRecCreationTool’s command line reply and listed in files) are
really supported due to various other reasons:

• ImportService (use case a) uses a different knowledge base resulting in less channels supported

• Tags/attributes of channels in PQDIF-file do not match with SICAM PQS tags/attributes

• Channels are declared in the data source section of the PQDIF file, but PQDIF-file does not contain related
data

With SICAM PQS ≥ V8.19, the DDRecCreationTool is available in directory %PAS_BIN%. If executed in Command
line window without any parameters, it will display information about the usage.

Importing Fault Records
To import the fault records, proceed with the following steps:
² Right-click PQS Automatic Import and select Device group from the context menu.

² Select COMTRADE in the Import type field under General parameters.

² Select the desired Import mode.

3 options are available:

• File-based.
For using a third-party application or for manually copying fault records to the Import directory.

• FTP
For automatically copying fault records from the FTP directory to the Import directory.

• Travelling wave recorder
For automatically downloading of fault records from the traveling-wave recorder of the device.

 

2.6.13.3
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[sc_Importing Fault records, 1, en_US]

Figure 2-46 Fault-Records Import Mode

These fault records are automatically imported to the PQS Archive.

ii NOTE
If you have selected the FTP import mode, you need to define the parameters under COMTRADE record
transmission:

• For the cyclical request of fault records enter the Interrogation cycle [min] in minutes.

• From the Transmit data stored in device list select:
– All, to transmit all records
– From point in time, to transmit data starting from the entered Start date and Start time

For more information, refer to the online help.

Fault records can be stored in different ways:

• All Fault Records in One Directory, Page 78 independent of the device name

• Fault Records Sorted by Device, Page 80 in different directories
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All Fault Records in One Directory
If all fault records are stored in 1 shared directory:
² Select the Single folder import directory structure in the COMTRADE import configuration input area.

² In the Import directory field, select the import path for the COMTRADE fault records.

[sc_COMTRADE_Dire_Struct, 2, en_US]

Figure 2-47 PQS Automatic Import, COMTRADE Directory Structure

² Confirm with OK.

² Select the Device group and insert a Device.

² Under the General parameters of the device, select Sample Device COMTRADE in the Device template
field.

² In the COMTRADE import configuration input area, in the File name contains field, you can define the
COMTRADE files of the import directory that are assigned to a device.
Enter a maximum number of 3 colon separated strings that are part of the COMTRADE file name. The
strings are logically interconnected by an AND.
If the field remains empty, all data from the import directory are assigned to the device.

² In the Delete fault records field, select whether the fault records must be removed from the source
directory after the import.
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ii NOTE
If the FTP import mode is enabled, you must define the following:

• Under Communication parameters for FTP, enter the IP address, the Port, and the FTP directory of
the device where it internally stores the fault records.

• Under Security configuration, enter the Authentication user name which is required for the secure
communication with the device and the Authentication password if the user name is different to
Anonymous.

For more information, refer to the online help.

² Confirm with OK.

Example
The following fault record files are stored in a shared folder:
2013-2-28_10-29-33_NBG_North_Feeder01.CFG
2013-2-28_10-29-33_NBG_North_Feeder01.DAT
2013-2-28_10-29-33_NBG_North_Feeder01.INF (if available in the device)
2013-2-28_10-29-33_NBG_North_Feeder01.HDR (if available in the device)

2013-2-28_10-29-33_NBG_North_Feeder02.CFG
2013-2-28_10-29-33_NBG_North_Feeder02.DAT
2013-2-28_10-29-33_NBG_North_Feeder02.INF (if available in the device)
2013-2-28_10-29-33_NBG_North_Feeder02.HDR (if available in the device)

2013-2-28_10-29-33_NBG_South_Feeder01.CFG
2013-2-28_10-29-33_NBG_South_Feeder01.DAT
2013-2-28_10-29-33_NBG_South_Feeder01.INF (if available in the device)
2013-2-28_10-29-33_NBG_South_Feeder01.HDR (if available in the device)

2013-2-28_10-29-33_NBG_South_Feeder02.CFG
2013-2-28_10-29-33_NBG_South_Feeder02.DAT
2013-2-28_10-29-33_NBG_South_Feeder02.INF (if available in the device)
2013-2-28_10-29-33_NBG_South_Feeder02.HDR (if available in the device)

When entering north: Feeder02 in the File name contains field, the following data are imported into the PQS
Archive:
2013-2-28_10-29-33_NBG_North_Feeder02.CFG
2013-2-28_10-29-33_NBG_North_Feeder02.DAT
2013-2-28_10-29-33_NBG_North_Feeder02.INF (if available in the device)
2013-2-28_10-29-33_NBG_North_Feeder02.HDR (if available in the device)
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[sc_COMTRADE_with_Filter, 4, en_US]

Figure 2-48 PQS Automatic Import, COMTRADE with Filter

Fault Records Sorted by Device

² If fault records sorted by device are stored in different directories, select the Multiple folders import
directory structure in the COMTRADE import configuration input area.

² Confirm with OK.

² Select the Device group and insert a Device.

² Under General parameters, select Sample Device COMTRADE in Device template.

² Under COMTRADE import configuration input area, in Device-specific import directory, select the
directory of the COMTRADE fault records that you want to import.

² In Delete fault records, select whether the fault records can be removed from the source directory after
the import.

² Under the Communication parameters for Travelling-wave recorder input area, in IP address, enter
the IP address of the device which is compatible with the travelling wave.

² In Subnet, enter the subnet mask of the device which is compatible with the travelling wave.

² In Gateway, enter the gateway of the device which is compatible with the travelling wave.
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ii NOTE

• If the Templates view does not include an appropriate import file, you can create a customized
template which describes the structure of the data recorded. For more information, refer to
2.11.8 Recording Channels.
By using the Import function of the Templates view, you can also import customized templates which
describe the structure of the data recorded. For more information, refer to 2.11.5 Importing/Exporting
a Device Template.

• To ensure that the size of the Import directory does not increase continuously, set the value of
Delete fault records to Yes.

In the Topology assignment input area, you see the topological level which is assigned to the device group.
The fault records are saved in the archive under this topological assignment and displayed in the SICAM PQ
Analyzer, Incident Explorer view.

Displaying Trigger Information of Fault Records
For the fault records generated from a SIPROTEC 7KE85 device, the COMTRADE header file (HDR) contains
information on the trigger, cause, and fault number, whereas the fault records that are generated from OSCOP
contain information about trigger and cause only. During the automatic import of these fault records, the
information on trigger, cause, and fault number present inside the HDR file is imported and stored in the
archive along with the fault record.
In the Incident Explorer view of the SICAM PQ Analyzer, the Fault number, Trigger, and Cause are displayed.
For more information, refer to /13/ SICAM PQ Analyzer and /14/ SICAM PQ Analyzer, Incident Explorer.

PQS Automatic Export

If you require PQ data and fault records from the archive for evaluation by other programs, you can automati-
cally export this data. During this procedure, the current archive data is stored in defined directories.
The PQS Automatic Export application exports:

• PQ data in PQDIF (Power Quality Data Interchange Format) format

• PQ data in CSV (Comma Separated Value) format

• Voltage events classified according to IEEE 1159.3 in PQDIF format

• Fault records in COMTRADE (Common Format for Transient Data Exchange) format

• Reports in PDF format
The corresponding, archive data is stored in the directories defined. The archive directory, the configured
import paths of the PQS Automatic Import application, and the export paths of the PQS Automatic Export
application for the same export types are not permissible as export root directory. The export path must
always be defined as a complete network path (UNC path), mapped drives are not permissible.

ii NOTE
The SICAM PAS PQS Users user group must have write permission for the directory.
To achieve this, open the Properties of the directory, select the Security tab and add the SICAM PAS PQS
Users user group to the Group and user names via Edit... > Add... . Grant the write permission.

After you have inserted the PQS Automatic Export application into the system, configure the data export
according to the description for:

• 2.6.14.1 Exporting PQ Data

• 2.6.14.2 Exporting Fault Records

• 2.6.14.4 Exporting Reports

2.6.13.4

2.6.14
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Exporting PQ Data
For more information on customizing the default mapping file for PQDIF export, refer to A.2 Updating a
User-Defined Mapping File.
For more information on customizing the default channel list file for CSV export, refer to A.3 Updating a
User-Defined Channel List File.
To export the PQ Data, proceed with the following steps:
² Right-click PQS Automatic Export and select Export Service from the context menu.

The Insert - Export Service dialog opens.

² In the General parameters input area, in the Export type field, select either PQ data (CSV) or PQ data
(PQDIF) format.
In case of a PQDIF export, a single file is exported for the whole device or the measuring group
depending on the Export folder structure. In case of a CSV export, a CSV file is exported for each
characteristic type and measurement value type.
The PQ data export configuration input area is enabled and the default option for Export PQ violations
field is No.

ii NOTE

• If the configuration, device name, topology, measurement group name, channel name, or Grid Code
name contains Unicode characters that are not supported by the current language setting of the
operating system, exporting of PQ data files do not work.

• The date and time format for the automatic CSV export is always defined by the Region and
Language settings of the operating system of the PASRuntimeUser.

² In the Export root directory field, select the path under which the exported PQ data is stored based on
the topological structure configured or the Configuration view. For each device, a subdirectory with PQ
data is created for each export time.

² In the Export folder structure field, select the structure how the PQ data are exported to the Export root
directory.

• With Based on Configuration view (multiple folders), measured data of a device is exported to a
single folder. PQ Violations are exported to the respective subfolders based on Grid Codes.

• With Based on Configuration view (single folder), measured data and the PQ Violations of a
device are exported to a single folder.

• With Based on Topology view (multiple folders), measured data of each measuring group
assigned to a bay is exported to a single folder. PQ Violations are exported to respective subfolders
based on Grid Codes.

• With Based on Topology view (single folder), measured data and the PQ Violations of each
measuring group assigned to a bay are exported to a single folder.

 

² In the Time zone field, select the time zone to which all the time information of the exported data is
referred.
If the timezone contains DST, during the day-light switch the exported PQ data splits depending on the
configured interval.

² In the PQ data export configuration input area, in the Interval field, select the time interval in hours,
day, or week after which the PQ data is stored in the export directory, for example, 1 hour for hourly
export or 1 day for daily export. The time intervals refer to 00:00 AM.

ii NOTE
To reduce the total number of exported reports, you can select 1 week as the Interval.
The PQ data for a device is exported to the destination folder if all the characteristics of the device are
available in the archive for the requested interval.

2.6.14.1
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² With the Export of already archived data parameter, you define whether PQ data already recorded in
the archive will be subsequently exported as PQDIF or CSV files.

• If you select Yes, you define in the Start date and Start time field the time when the export starts.
• If you select No, the export begins as soon as the export service in SICAM PAS/PQS UI – Operation

has been enabled for the first time.

 

[sc_Inserting_Export_Ser, 6, en_US]

Figure 2-49 Inserting an Export Service for PQ Data

² To configure the exporting of Grid Code violations, select Yes from the Export PQ violations field.

Exporting Fault Records

To export the fault records, proceed with the following steps:
² Right-click PQS Automatic Export and select Export Service from the context menu.

² In the dialog which opens in the General parameters input area in the Export type field, select the
COMTRADE format.

² In the Export root directory field, select the path under which the exported fault records are stored anal-
ogous to the topological structure configured or the Configuration view. For each device, a subdirectory
with COMTRADE files is created for each export time.

² In the Export folder structure field, select the structure how the COMTRADE files are exported to the
Export root directory.

2.6.14.2

Configuration
2.6 Setting Up and Editing the Configuration

SICAM, SICAM PAS/PQS, Configuration and Operation 83
E50417-P8976-C433-C9, Edition 05.2023



• With Based on Configuration view (multiple folders), fault records are exported to the respective
folders based on each record type of a device.

• With Based on Configuration view (single folder), fault records of a device are exported to a
single folder (independent of the fault record type).

• With Based on Topology view (multiple folders), a folder is created for each assigned measuring
group, which contains subfolders for each fault record type of a device. The records of the assigned
device are exported to the respective subfolders based on their type.

• With Based on Topology view (single folder), fault records of a device for which at least one
measuring group has been assigned to a bay are exported to a single folder (independent of the
fault record type).

 

² In the Time zone field, select the time zone to which all the time information of the exported data is
referred.

² In the COMTRADE export configuration input area in the Export COMTRADE records from archive
field, you define whether the fault records already stored in the archive will be exported.

• If you select From point in time, the fault records stored from the time defined in the Start date
and Start time field are exported.

• If you select All, all the fault records stored in the archive are exported.

 

² In the COMTRADE version field, select the version for the COMTRADE 1997, COMTRADE 1999,
COMTRADE 2001, or COMTRADE 2013 export.

² In the COMTRADE format field, select the ASCII, Binary, Binary32, or Float32 export format.
Only the COMTRADE version 2013 supports the Binary32 and Float32 formats.

² In the Save as field, select the file format in which you want to save the COMTRADE files (cfg, dat, hdr,
and inf):

• With Individual files, the COMTRADE files are saved individually in the export folder.
• With ZIP files, the COMTRADE files are saved in 1 ZIP file in the export folder.

 

² In the Modification of the sampling frequency field, select whether you want to reduce the sampling
frequency of the fault record data during export. The sampling frequency must be reduced if the evalua-
tion program cannot operate with the recorded sampling frequency.

² In the Sampling frequency [Hz] field, enter the frequency for data resampling.

² In the File naming convention field, select the file name structure of the exported COMTRADE records.

• With Legacy, the file name is structured depending on the option selected in the Export folder
structure.
For the (multiple folder) options, the file name structure is Start date and time.
For the Based on Configuration view (single folder) option, the file name structure is Record
type, Start date and time.
For the Based on Topology view (single folder) option, the file name structure is Record type,
Device name, Start date and time.

• With IEEE Std C37.232-2011, the file name is structured according to the IEEE Std C37.232-2011:
Start Date, Start Time, Time Code, Station Identifier, Device Identifier, Company Name, Duration,
Record Type
where
Record Type is either slow-scan (sl), phasor (ph), or transient (tr). For fast-scan records, the Record
Type is omitted.
Company Name is the name of the company entered at the project level in the Configuration
view.
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ii NOTE
The special characters \, /, :, *, ?, ", <, >, and | in the Company Name are replaced by _ in the file name.

² In the Device identifier format, select the file name format in which you want to identify the exported
fault record.

• With Device name, the exported fault record is named as the device name configured in the
Configuration view.

• With Voltage level, bay, and device name, the exported fault record is named as a combination
of the voltage level and bay name from the Topology view and the device name from the Configu-
ration view separated by hyphens.

 

ii NOTE
The Device identifier format field is enabled only for the IEEE Std C37.232-2011 option in File naming
convention.
If the Export folder structure is based on configuration view, the Voltage level, bay, and device name
option cannot be selected in the Device identifier format.

[sc_Inserting_ Export_Ser_Fault, 6, en_US]

Figure 2-50 Inserting an Export Service for Fault Records
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Exporting Events as CSV File

To map the relevant events to the archive, proceed with the following steps:
² Right-click the Archive application and select Process information from the context menu.

² Right-click Process information and select Event list from the context menu.

² Right-click the Event list and select Go to... from the context menu.

² In the dialog which opens, confirm the Mapping view.

² Select all the items of information that you want to be stored for displaying in the Event Viewer.
To export events as a CSV file, proceed with the following steps:
² In the Export events to file field, select Yes to enable automatic export of event list along with fault

records as a CSV file.
The CSV file will be stored in Events folder. An Event folder is created along with the COMTRADE device
or Topology export folder.

² Enter the Pre-trigger duration [s] and Post-trigger duration [s].
The pre-trigger duration refers to the time span prior to the trigger point of the fault event. If the
pre-trigger record duration of the fault record is greater than the configured Pre-trigger duration [s], the
pre-trigger record duration of the fault record is considered.
The post-trigger duration refers to the time span after the trigger point of the fault event. All the
fault records generated during the Post-trigger duration [s] are included in the fault event. If the
post-trigger record duration of the fault record is greater than the configured Post-trigger duration [s],
the posttrigger record duration of the fault record is considered.

ii NOTE

• Only events from the device providing the fault record will be included in the exported CSV file.

• You can only enter a Pre-trigger duration [s] and Post-trigger duration [s] when Export events to
file is set to Yes.

2.6.14.3
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[sc_Inserting_Export_Ser, 6, en_US]

Figure 2-51 Inserting an Export Service for Fault Records

Exporting Reports

ii NOTE
If Unicode characters which are not supported by the installed Siemens font are used in the configuration,
topology, device name, channel name, measurement group name, Grid Codes, or comments, the reports
can contain replacement characters such as □ or ?.
You can resolve the same by installing a font that supports these characters and updating the font name in
the FontFamily section of the PMPDFStyleSettings.xml file which is available in the %pas_bin% directory.

To export the reports, proceed with the following steps:
² Right-click PQS Automatic Export and select Export Service from the context menu.

² In the dialog which opens in the General Parameters input area in the Export type field, select the
Reports format.

² In the Export root directory field, select the path under which the exported reports are stored.

² In the Export folder structure field, select the structure how the reports are exported to the Export root
directory.

2.6.14.4
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• With Based on Configuration view (multiple folders), the reports are exported to the respective
folders based on each of the configured scheduled report template. PQ Violation reports and Fault
location reports are exported to the respective subfolders based on the measuring groups under
the device folder.

• With Based on Topology view (multiple folders), a folder is created for each assigned measuring
group, which contains subfolders for each scheduled report template (whose diagrams were
assigned to this measuring group). The scheduled reports are exported to the respective subfolders
based on the template and the assigned measuring group. PQ Violation reports and Fault location
reports are exported to the measuring group folders.

 

² In the Time zone field, select the time zone to which all the time information of the exported data is
referred.

Reports are stored in the following directories:

• Scheduled reports under their name

• PQ violation reports and fault location reports analog to the topological structure configured or the
Configuration view

[sc_Inserting_Export_Ser_Reports, 4, en_US]

Figure 2-52 Inserting an Export Service for Reports

Exporting Event Reports

ii NOTE
If Unicode characters which are not supported by the installed Siemens font are used in the configuration,
topology, device name, channel name, measurement group name, Grid Codes, or comments, the reports
can contain replacement characters such as □or ?.
You can resolve this issue by installing a font that supports these characters and updating the font name in
the FontFamily section of the PMPDFStyleSettings.xml file which is available in the %pas_bin% directory.

To export the event reports, proceed with the following steps:
² Right-click PQS Automatic Export and select Export Service from the context menu.

² In the dialog which opens in the General Parameters input area in the Export type field, select the
Reports format.

² In the Export root directory field, select the path under which the exported reports are stored.

² In the Export folder structure field, select the structure how the reports are exported to the Export root
directory.

2.6.14.5
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• With Based on Configuration view (multiple folders), the event reports are exported to the
respective folders based on each of the configured scheduled report template.

• With Based on Topology view (multiple folders), a folder is created for each assigned measuring
group, which contains subfolders for each scheduled report template (whose diagrams were
assigned to this measuring group). The scheduled event reports are exported to the respective
subfolders based on the template and the assigned measuring group.

 

• In the Time zone field, select the time zone to which all the time information of the exported data is
referred.

• In the Report export configuration input area in the Event driven reports field, you define whether you
want to export voltage event reports based on device Grid Codes, PQS Grid Codes, or both.

[sc_report_export_ser, 2, en_US]

Figure 2-53 Exporting Event Reports

PQS Scheduled Reports

In the Reports view, you define report templates for the scheduled reports of selected and measured values
of data. The PQS Scheduled Reports application activates the creation of these reports at the time which you
have defined in the template.
To insert the PQS Scheduled Reports application:
² Select the system in the configuration tree and insert the PQS Scheduled Reports application.
Apart from a name, no other parameters are required.

2.6.15
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[sc_Inserting_PQS_Scheduled_Reports, 3, en_US]

Figure 2-54 Inserting PQS Scheduled Reports

For more information on report templates, refer to 2.14.5 Inserting a Report Template.

ii NOTE
If you delete the PQS Scheduled Reports application, all the configured report templates are also deleted.

PQS Automatic Notification

The PQS Automatic Notification application notifies you by e-mail and/or SMS on various system events. The
events are classified into alarms and reports.

ii NOTE
Avoid the usage of Unicode characters in the e-mail address and domain names.

You can define to be notified on the following events:

• Process and status information
You will be notified by e-mail and/or SMS on a status change of selectable process or status information.

• Fault records
When a new fault record arrives, you will receive an SMS with brief information on the topological origin
and the time when the fault occurred.

• PQ violations
If a PQ violation has occurred, you will receive an SMS with brief information on the topological origin
and the type of limit value violation. In addition, you will receive the PQ violation report in PDF format by
e-mail.

• Scheduled reports
On completion of a scheduled report, you will receive the report in PDF format by e-mail.

2.6.16
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• Fault location reports
On completion of a fault location report, you will receive an SMS with brief information on the topolog-
ical origin, the fault type and the distance to the fault location. In addition, you will receive the fault
location report in PDF format by e-mail.

ii NOTE
To be notified on PQ violations, scheduled reports and fault location reports, the functions and the archive
must have been created and configured. For more information, refer to the online help.

ii NOTE
By PQS Automatic Notification application, you will not get notified on manually imported PQDIF or
COMTRADE records.

ii NOTE
If a time zone different from your operating system time is selected for exporting fault records, the time
specified in the file name of the fault records attached to the e-mail and the exported fault records will be
different.

Creating the Application
To insert the PQS Automatic Notification application:
² In the configuration tree, select the system and insert the PQS Automatic Notification application.

² Right-click the application and select E-mail and SMS from the context menu.
The Insert – E-mail and SMS dialog opens.

² In the General parameters input area in the Maximum time for redirection [h] field, define the period
during which the event shall still be transmitted after an established notification service has failed.

² In the SMS configuration input area, you define whether you want to be notified by an SMS and enter
the data of the sending SMS port. Enter the telephone number with a + sign and the country code.

² In the E-mail configuration input area, you define whether you want to be notified by e-mail and enter
the data of the sending SMTP server address and its port.
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[sc_Creating_EMail_SMS_Not, 1, en_US]

Figure 2-55 Creating an E-Mail and an SMS Notification

² Select E-mail and SMS in the configuration tree.

² In the Recipients input area, click Add recipient.
² Enter the Name of the recipient, the E-mail address and the Telephone number of the recipient of the

notification.
The telephone number must contain the country code starting with a + sign, for example,
+49(911)433-7415.
If you enter the phone number in letters, a number sequence is displayed in the Telephone number
(numeric) field.
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[sc_Inserting_Recipient_Data, 3, en_US]

Figure 2-56 Inserting Recipient Data

Setting up a Notification for Alarms
To set up a notification for alarms:
² Right-click E-mail and SMS in the configuration tree and select Device > Alarms from the context menu.

² In the SMS message surge suppression input area, enter the number of SMS to be sent before the
defined suppression time becomes effective. If the number of arriving alarms exceeds the parameterized
value, no further SMS will be sent to the assigned receiver during the surge suppression time defined.

² Open the Mapping view and select Alarms in the configuration tree.

² In the Process or Status tab, select the information for which you want a notification to be sent if there
is a status change. To perform the selection, you can use the sorting and filter options described in
2.8.2 Optimizing the View.

² Click ... in the Recipients column.

² In the dialog which opens select the people to be notified by e-mail and/or SMS.
The selection performed is shown in the Recipients column.
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[sc_Assigning_Not_Alarms, 3, en_US]

Figure 2-57 Assigning Notifications for Alarms

Setting up a Notification for Reports
To set up a notification for reports:
² In the configuration tree, right-click E-mail and SMS and select Reports from the context menu.

² In the SMS message surge suppression input area, select the number of SMS to be sent before the
defined suppression time becomes effective. If the number of arriving alarms exceeds the parameterized
value, no further SMS will be sent to the assigned receiver during the surge suppression time defined.
The number is separately defined for fault records, fault location reports, and PQ violations.

² In the Preferences input area, in the Event-driven reports field, select whether you want to receive an
e-mail and SMS notification containing:

• All reports
• PQ violation reports
• Voltage event reports (based on Device Grid Codes)
• Voltage event reports (based on PQS Grid Codes)

 

If you select All Reports or Voltage event reports (based on Device Grid Codes), the PQ Violations input
area in the Mapping view, you define the recipients you want to be notified on the arrival of all reports or
voltage event reports based on device Grid Codes.
In the Grid Code used in device line, click ... in the Recipients column. In the dialog which opens, select the
people to be notified by e-mail and/or SMS.
² In the Scheduled reports field, select whether you want to receive an e-mail containing:

• All reports
• Reports with violations
• Reports with violations, warnings, or gaps
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² In the Scheduled report content field, select whether you want to receive an e-mail containing:

• Full report
• Only the table of contents of the report

 

² In the E-mail attachments input area, in the Attach fault records field, select whether or not the fault
record is attached to the e-mail.

² In the Attachment type field, select the type in which you want to attach the fault records:

• With COMTRADE, the fault records are attached as COMTRADE files (cfg, dat, hdr, and inf).
• With COMTRADE and PDF, the fault records are attached as COMTRADE files and PDF file.
• With PDF, the fault records are attached as a PDF file.

 

² In the Attach COMTRADE fault records as field, select the file format in which you want to attach the
COMTRADE files (cfg, dat, hdr, and inf):

• With Individual files, the COMTRADE files are attached as separate files.
• With ZIP file, 1 ZIP file containing the COMTRADE files is attached.

 

² In the File naming convention, select the file name structure of the attached COMTRADE records.

• With Legacy, the file name is a combination of device name, date, and time separated by blanks,
for example, 7KE85 2019-06-03 09-25-04_451.
Date and time are defined by the Region and language settings of the operating system of the
PASRuntimeUser.

• With IEEE Std C37.232-2011, the file name is structured according to the IEEE Std C37.232-2011:
Start Date, Start Time, Time Code, Station Identifier, Device Identifier, Company Name, Duration,
Record Type
where
Record Type is either slow-scan (sl), phasor (ph), or transient (tr). For fast-scan records, the Record
Type is omitted.
Company Name is the name of the company entered at the project level in the Configuration
view.

 

ii NOTE
The special characters \, /, :, *, ?, ", <, >, and | in the Company Name are replaced by _ in the file name.

² If IEEE Std C37.232-2011 is selected as file naming convention, select in the Device identifier format
field the file name of the attached fault record.

• With Device name, the attached fault record is named as the device name configured in the
Configuration view.

• With Voltage level, bay, and device name, the attached fault record is named as a combination of
the voltage level and bay name from the Topology view and the device name from the Configura-
tion view separated by hyphens.

 

² In the Maximum attachment size [KB] field, enter the maximum permissible size of the attachment. If
the attachment exceeds the limit defined, it is not attached to the e-mail.

² Select Reports in the configuration tree and open the Mapping view.

Fault Records and Fault Location Reports
In the Fault recording input area in the Mapping view, you define whether you want to be notified on the
arrival of a fault record or fault location report.
² In the Fault record or Fault location line, click ... in the Recipients column. In the dialog which opens,

select which people you want to be notified by e-mail and/or SMS.
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The selection performed is shown in the Recipients column.

PQ Violations
The PQ violations input area in the Mapping view shows all the Grid Codes which you have previously
defined in the Grid Codes view. For each Grid Code, you can define whether you want to be notified if there is
a PQ violation.
² Click ... in the Recipients column. In the dialog which opens, select the people to be notified by e-mail

and/or SMS.
The selection performed is shown in the Recipients column.

Scheduled Reports
The Scheduled reports input area in the Mapping view shows all the reports which you have previously
defined in the Reports view. For each report you can define whether you want to be notified upon its
completion.
² Click ... in the Recipients column. In the dialog which opens, select the people to be notified by e-mail.
The selection performed is shown in the Recipients column.

[sc_Assigning_Not_Reports, 3, en_US]

Figure 2-58 Assigning a Notification for Reports

Defining PQ Data Transmission
The feature PQ Data Transmission allows you to transmit records from SIMEAS R and SICAM Q80 devices
from the date and time selected by you. To transmit records, perform the following steps:
² In the Configuration view, select a SIMEAS R Master or a SICAM Q80 Master interface.

² Select All from the Transmit data stored in device list to transmit all records.

2.7
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- or -

² Select From point in time to transmit data starting from the entered date and time.

[sc_Defined_data_fetch, 3, en_US]

Figure 2-59 Transmitting Data from User-Defined Selection

² Select the Start date and the Start time from the list box.
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[sc_Select_date, 5, en_US]

Figure 2-60 Selecting Start Date of Transmitting Measured Data in Devices
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[sc_Select_time, 5, en_US]

Figure 2-61 Selecting Start Time of Transmitting Measured Data in Devices

² Start the SICAM PQ Analyzer and verify in the Incident Explorer view if the data is transmitted to the
archive as per the selected date and time.

ii NOTE
If multiple devices are connected to an interface, more time is required to transmit data from SIMEAS R and
SICAM Q80 devices.

Defining the Mapping
After you have configured and parameterized a data link, open the Mapping view. In this view, you select for
example, which items of information you want to use and to which locations you want to forward them.
Proceed as follows to map information:

• 2.8.1 Selecting a Data Link

• 2.8.2 Optimizing the View

• 2.8.3 Mapping the Information

Selecting a Data Link

After you have switched to the Mapping view, the device or the control center connection which you have
previously edited in this view is selected.
The Go to... context menu item selects the device which you have previously selected in the Configuration
view.

2.8

2.8.1
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² Select the device or the control center connection and select the items of information which you want to
use in the monitoring and command direction.

[sc_Selecting_data_link_Mapping, 3, en_US]

Figure 2-62 Selecting the Data Link in the Mapping View

Optimizing the View

The right-hand section of the Mapping view includes all items of information which are provided by a device
and which are available for forwarding to the control centers and to SICAM SCC.
The information is subdivided into the following areas:

• Information – Monitoring direction

• Information – Command direction
Depending on the protocol through which the device or the control center is connected, the areas are
subdivided into several tabs, for example, Process, Status, and LN state.
SICAM PAS/PQS provides several tools which help you to optimize the representation of information for the
corresponding process step.
The following options are possible:

• Sorting Information, Page 100

• Filtering Information, Page 102

• Adjusting the Column Width, Page 103

• Showing/Hiding Columns, Page 104

• Fixing a Column/Undoing the Fixing, Page 104

Sorting Information
To sort information in a table:

2.8.2
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² Double-click the column header in the table in order to sort information according to the contents of this
column (in ascending order), for example, according to information type.

² Double-click a second time to reverse the sorting (in descending order).

² To sort multiple columns, double-click another column header to sort the information.
Multiple column sorting is indicated by an up arrow (ascending order) and a down arrow (descending
order) along with numerical indications. A numerical indication in the column header shows the
sequence of the columns according to which the information is sorted. If sorting is applied on a single
column, no numerical indication is displayed.

ii NOTE
A maximum of 5 columns can be sorted at a time.

² To undo the sorting sequence of a column, right-click on the column header and select Reset sorting
from the context menu.

² To remove all the sorting sequences, right-click on the column header and select Reset all sorting from
the context menu

ii NOTE
This menu option is displayed if multiple columns are sorted.

[sc_Sorting_Info_Multiple_Columns, 3, en_US]

Figure 2-63 Sorting Information in Multiple Columns
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ii NOTE
Use the sorting function in order to specifically copy certain items of information into an EXCEL table. When
copying back the information in the Mapping view, make sure that the same sorting criteria are defined.
This ensures that no information parameters are accidentally confused.

ii NOTE
Multiple column sorting is applicable for the Templates view and Mapping view and not for the Topology
view

Filtering Information
You can filter the information according to the criteria of one or several columns. Filtering focuses the display
to these criteria.
Proceed as follows to filter information:
² Open the selection list, for example, in the Information Type column.

² Select an information type. The selected information type is displayed as filter criterion.
The view now only includes information of this type.

[sc_Filtering_Info, 3, en_US]

Figure 2-64 Filtering Information, Example

To define customized filter criteria:
² Select the (User) criterion in the filter line.

² Select the filter criterion in the User filter window.
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[sc_Defining_Filter_Criteria, 1, en_US]

Figure 2-65 Defining Customized Filter Criteria

The table only shows information which meets the defined filter criterion.
To reset filter criteria:
² Open the selection list and select (None) to reset the filter.

- or -

² Select any column header and select Reset all filters from the context menu. The filters of all the
columns are reset.

[sc_Resetting_Filters, 3, en_US]

Figure 2-66 Resetting all Filters

Adjusting the Column Width
If column entries are too long for the currently defined column width, you can adjust the column width.
² Double-click the dividing line between the 2 columns in the column header. The column is adjusted to

the text width of the entries.
- or -

² In the column header, select the dividing line between 2 columns, hold down the mouse button and drag
the pointer to the right (to enlarge the column) or to the left (to reduce the column).
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Showing/Hiding Columns
If you do not require all the parameters for the current parameterization, you can temporarily show or hide
individual columns.
² Select the column header. Click Show/hide columns in the context menu in order to select or deselect

the column display.
The context menu is only displayed if the mouse pointer is placed on the column header.

[sc_Show_Hide_Columns, 1, en_US]

Figure 2-67 Show/Hide Columns

Fixing a Column/Undoing the Fixing
If a table is particularly wide, you can use the scroll bars or the tab buttons to scroll to the right in order to
view this part of the table.
In order to ensure that one or several columns always remain on the left-hand table margin while scrolling,
you can fix these columns (for example, the Use and Name columns).
² To select the columns (shaded in blue), select the column headers and select Fix from the context menu.
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[sc_Fixing column, 3, en_US]

Figure 2-68 Fixing a Column

² To undo the fixing, select the column header line in the table window and select Unfix from the context
menu.

The context menu is only displayed if the mouse pointer is placed on the column header.

ii NOTE
The control options for optimizing the view also apply to the Templates view, the Assignments tab of the
Topology view, and the input area for the Recipients of the PQS Automatic Notification function.

Mapping the Information

To map information, specify whether and where you want to use each individual item of information.
For example, you select whether the information shall be

• displayed or logged on the SICAM SCC Human-Machine Interface (HMI)

• forwarded to other control centers
If you have used an import file with mapping information to insert a device, this configuration step is not
required, for example, for the IEC 61850 Ed. 2 protocol.
Proceed as follows to map individual items of information:

• Using Information, Page 106

• Lists (Protocol-Dependent), Page 108

• Switching Authority, Page 109

2.8.3

Configuration
2.8 Defining the Mapping

SICAM, SICAM PAS/PQS, Configuration and Operation 105
E50417-P8976-C433-C9, Edition 05.2023



• Selecting Normalization (Optional), Page 111

• Automatic Notification for Alarms, Page 111

Using Information
To mark that you want to use an item of information:
² Select the information in the Use column.

[sc_Using_Info, 4, en_US]

Figure 2-69 Using Information

If the parameters for the item of information have not been completely defined, the column number and
mandatory parameters are highlighted in red.
² Place your mouse pointer on a red field. The cause of the error is displayed as a tooltip.

- or -

² Select a red field. The cause of the error is indicated in a tooltip.
- or -

² Open the error field  at the bottom of the information description. The cause of the error is described
in this field.

² Complete the parameterization and correct the entry.

² To apply your settings, select another parameter.
If you close the table window without clearing all errors, a box with a safety question opens. In this box,
you are prompted to select whether you want to continue your corrections or undo the entries.

Incomplete mappings can also lead to a warning. The warning field  provides information on the item of
information detected. The warning pops up for example, when mapping the information for an IEC 61850
control center connection because an item of information is available in monitoring direction although the
corresponding item is missing in command direction.
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In addition to mandatory parameters which must be entered in any case, you can modify the default values
of other parameters. All fields highlighted in white can be edited in the tables of the Mapping view. Fields
displayed in gray cannot be modified. They originate from the device template or the import file. Any change
in a device template influences all devices which use the corresponding template.

ii NOTE
The topological names are considered for the tag names which are created for SICAM SCC. Tag names
define for example, the assignment to graphic objects.
The tag names are created when selecting the information for SICAM SCC. If you have defined the topo-
logical structure of your station before mapping the information to SICAM SCC, this assignment will be
transferred. If you modify the topological structure afterwards, you can update the tag names by using a
menu command. Update the tag names before exporting the configuration data for SICAM SCC.

ii NOTE
The Information which becomes a part of a fault record as markers, for example, Dev. pickup or Device
OFF, must always be selected in the Use column.

ii NOTE
If only monitoring direction licenses have been installed for the connection of protection devices by using
IEC 61850 or IEC 60870-5-103, you must disable all information in the command direction tab in the Use
column.

 

Mapping IEC 61850 Server
In the Mapping view of the control center connection, all IEC 61850 parameters are applied which you have
previously defined in the Templates view for the information of a device.
The Templates view allows you to generate proposed values for the MMS addresses for devices connected to
SICAM PAS/PQS by using the IEC 61850. These proposed values are generated based on the available address
information of the template. To generate the values, use the Create MMS addresses menu.
If status values (for example, _ComFault of any interface) are mapped, the corresponding MMS addresses are
preset with generated default values.
The parameters can be overwritten in the Mapping view. As soon as you deactivate the Use selection, the
original parameterization from the template is displayed again.
The example below shows an incomplete configuration from the Templates view in which only the parame-
ters for the information direction have been entered. A warning is thus attached to the item of information in
order to indicate that the command direction is missing.
If you also mark the correlative item of information as used in the command direction, the parameters are
highlighted in red as incorrect for this direction. The error messages and warnings disappear as soon as you
have completed all missing parameters.
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[sc_Mapping_IEC_61850_Ser, 4, en_US]

Figure 2-70 Mapping IEC 61850 Server, Example

The DO Beh data object (behavior of the logical node) cannot be selected. It is calculated from the DO Mod
data object (mode of the logical node).
The selectable data objects are defined in IEC 61850 Ed.2 standard.
If you have assigned one or several lists to the station, be aware that the information type of an item of
information matches the list selected. A warning pops up if you assign an item of information of the Event
type to a general interrogation list. The warning also pops up if there is a subsequent change of the trigger
condition for the list in the Configuration view.
The assignment of the Logical Device LD and Logical Node LN address parameters of the list in the Configura-
tion view and the assignment of LD and LN of the item of information in the Mapping view are independent.
For more information on the parameterization of object model templates, refer to Changing the Parameters of
an Item of Information, Page 149.

Lists (Protocol-Dependent)
A list is created in the Configuration view for data links to control centers.
Information in monitoring direction which is included in a list must be assigned to a List, for example, an
alarm list, in the Mapping view.
² Activate the assignment in the General interrogation list (list name) column.
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[sc_Assigning_Mapped_Info, 4, en_US]

Figure 2-71 Assigning Mapped Information to a List

Switching Authority
In the Mapping view, you can select for individual commands of devices and substations whether the
command output is subject to a switching authority check.
If the selection is enabled, the switching authority of the topological level to which the information is assigned
is effective.
If the selection is disabled, the command output is without a check.
The switching authority itself can be parameterized for any structure level in the Topology view.
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[sc_Assigning_Switching_Authority, 3, en_US]

Figure 2-72 Assigning an Information-Specific Switching Authority

For more information on the parameterization of the switching authority and switching permissions for
individual users, refer to 2.9 Mapping the Topological Structures, 6.3 Administrating Users, the online help of
the User Administration, A.14 Information – Switching Authority, and /8/ SICAM PAS/PQS, Security.

Operating Mode (Select Before Operate)
If the substation expects a 2-step command, the command is always executed in 2 steps (Select and
Execute). The Execute command is only forwarded if the substation has positively acknowledged the previous
Select command.
² Select Direct operate, if the control center only sends the Execute command and the application creates

the required Select command.
- or -

² Select Select before operate, if the Select and Execute commands are transmitted from a control center.

Command Termination
For the information from a control center, you select by using a Command termination how the command
shall be terminated.
If the selection is enabled, the application expects a command termination message.
If the selection is disabled, the application only expects the confirmation from the substation that the
command has been accepted.
“M of N” Check
For commands from devices and substations, you can select individually whether the command output of a
check is subject to “M of N“ monitoring.
If the selection has been activated, the command is only transmitted if the permissible number of simultane-
ously transmittable commands has not yet been reached. The number can be defined on the project level
(command processing mode).
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If the selection is deactivated, the command is forwarded independently of the number of command outputs
to the device which are currently in progress.
Blocking
For items of information which originate from devices and substations, you can select individually whether the
communication in the command or monitoring direction is subject to bay or telecontrol blocks.
If a bay block has been set, no items of information from devices or substations are transferred to the Full
Server.
If a telecontrol block has been set, no items of information are transmitted to the control center.
If Check all has been defined, the bay and the telecontrol block are observed.
If Check bay blocking has been set, only the bay block is observed and the telecontrol block is ignored.
If Check telecontrol blocking has been set, only the telecontrol block is observed and the bay block is
ignored.
If Ignore all has been set, the information from the device or the substations will be accepted and forwarded
independently of a bay or telecontrol block.

Selecting Normalization (Optional)
You can define normalization procedures in the Templates view. In the Mapping view, you assign these
normalization procedures to individual items of information.
To assign an item of information a normalization procedure:
² In the Normalization field, open the selection list of all available normalizations. Select a procedure.

[sc_Normalization_Procedures, 3, en_US]

Figure 2-73 Normalization Procedures

For more information, refer to 2.12 Working with Normalizations.

Automatic Notification for Alarms
In order to be notified by e-mail and/or SMS on the status change of process and status information
² Select PQS Automatic Notification application.

For more information refer, to 2.6.16 PQS Automatic Notification.
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Mapping the Topological Structures
In the Topology view, you map the structure of your station configuration according to operational aspects.
This topological structure is accepted by other system components and used for the display and evaluation
functions.
The topological designations are transferred to the tag names of the Human-Machine Interface (SICAM SCC
tags).
The topological device assignment is transferred to the archive and is used for archive evaluation in the
different views of the SICAM PQ Analyzer.

You perform different tasks in the Topology view:

• Assigning information to a hierarchical, topological structure

• Level-specific assignment of measuring channels, Grid Codes, and switching authority

• Parameterizing data for manual and automatic fault location

Structure of the Topology view
The topological tree shows the topological structure of your system data.
The right window is structured with the following tabs:

• Assignments for the assignment of information to the topological levels
For more information, refer to 2.9.2 Assigning Information.

• Properties for the parameterization of the functions, for example, fault locator
The display of the properties categories depends on the selection in the structure tree.
For more information, refer to 2.9.3 Defining the Properties of Topological Levels.

• Global line overview for displaying line data for the fault locator
You cannot change parameters in this tab. This tab is only visible for the project level.
For more information, refer to 2.9.3.5 Defining the SICAM PQS Fault Locator.

Editing the Topology Structure
You perform following steps to edit the topology structure of your system:

• 2.9.1 Defining the Topological Tree Structure

• 2.9.2 Assigning Information

• 2.9.3 Defining the Properties of Topological Levels

• 2.9.3.5 Defining the SICAM PQS Fault Locator

Defining the Topological Tree Structure

Use one of the following objects in order to map your station's configuration:

• Region

• Station

• Voltage level

• Bay

• User-defined group
The context menu and the header of the topological tree only make available those objects which can actually
be used under a level.
Objects can be converted to user-defined groups under the Bay level.

2.9

2.9.1
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In order to assign a device-specific switching authority, click Edit > Create topology hierarchy to convert your
station's configuration structure to a topological structure. All items of information are automatically assigned
to the topological structure levels. The structure corresponds to the structure in the configuration tree in the
Configuration view.

Inserting an Object
To define the topological tree structure:
² Select the project and select a first object from the context menu, for example, Station.

² Add further topological levels to the tree structure.

[sc_Defining_Topological_Struct, 2, en_US]

Figure 2-74 Defining the Topological Tree Structure

You can move the objects within the structure or remove them.

Assigning Information

After defining your station configuration's topological basic structure, assign the items of information which
you have configured for the project to the individual topological levels.
This assignment is displayed in the Configuration view (Topology assignment input area) and in the
Mapping view (Topology column).

How to Proceed
To distribute mapped information to different topological levels, perform the following steps:

• Optimizing the View, Page 113

• Assigning Information, Page 114

Optimizing the View
Unless you have created the topological structure automatically, all mapped items of information of the SICAM
PAS/PQS project are located on the uppermost level of the topological tree structure.
Additional items of information which you configure later are first located on the project level of the Topology
view again.

2.9.2
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[sc_Info_Topology_view, 3, en_US]

Figure 2-75 Information in the Topology View

The table shows:

• The origin of the item of information (Technology (Source))

• The name of the item of information (Name)

• The type of information (Information Type)

• The control centers to which the information is forwarded (control center)
Since all columns are disabled (gray), you cannot change these definitions here.
SICAM PAS/PQS UI – Configuration provides numerous options for the sorting or filtering of information in the
Topology view. To do this, you proceed almost in the same way as in the Mapping view.
You can consider the following steps:

• Sorting Information, Page 100

• Filtering Information, Page 102

• Adjusting the Column Width, Page 103

• Showing/Hiding Columns, Page 104

• Fixing a Column/Undoing the Fixing, Page 104
For more information, refer to 2.8.2 Optimizing the View.

Assigning Information
To assign a topological element an item of information:
² Select the first column with the consecutive number in order to select an item of information.

² Hold down the SHIFT or CTRL key, select additional rows in order to expand your selection and drag your
selection to a topological object.
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- or -

² Define a filter criterion, for example, the name of a device.

² Click the first column with a consecutive number in order to select the row including this information.

² Click Select all rows in the context menu and drag the selection to a topological object.
- or -

² From the configuration tree in the Configuration view, right-click a device and select Copy for topology
from the context menu.

² In the Topology view, right-click the structure level to which you want to assign the device and select
Paste from the context menu.

[sc_Assigning_Info_Topology_view, 3, en_US]

Figure 2-76 Assigning Information in the Topology View

The information is now assigned to the topological structure level. You can freely modify the assignment
between the topological structure levels. For more information, refer to 2.5 Managing the Objects of a
Project.

Defining the Properties of Topological Levels

The display in the Properties tab depends on the selection in the structure tree. The tab contains the following
properties categories:

• General parameters for assigning the switching authority
For more information, refer to 2.9.3.1 Switching Authority.

• Grid Codes for assigning up to 4 Grid Codes
For more information, refer to 2.9.3.2 Grid Codes.

2.9.3
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• Measuring group assignment for a topological assignment of the PQ data and fault records
For more information, refer to 2.9.3.4 Measuring Channels.

• Measurement parameters for defining the power frequency, voltage level, and declared supply voltage
For more information, refer to 2.9.3.3 Measurement Parameters.

• Fault location to activate and parameterize central information for the fault-location determination
For more information, refer to 2.9.3.5 Defining the SICAM PQS Fault Locator.

• Line for the parameterization of line data
For more information, refer to 2.9.3.5 Defining the SICAM PQS Fault Locator.

• Segments for the parameterization of the line or line sections
For more information, refer to 2.9.3.5 Defining the SICAM PQS Fault Locator.

Switching Authority
In the Topology view, you can define a specific switching authority tag on each level of the topological
structure. By using these switching authority tags, you implement for example, a station level-specific or
voltage level-specific switching authority.
The switching authority tag is set by SICAM SCC, a control center or the Value Viewer during the runtime of
the system. A Local x or Remote x switching authority can be assigned. The different options are defined on
the level of the corresponding application to which you can assign as a switching authority.
In order to transmit a command independently of a defined switching authority tag, the check can be
deactivated in the Mapping view.
To assign a topology level-specify switching authority:
² Select the structural level.

² In the input area, select Yes under Activate specific switching authority.
A switching authority tag is created in the Name of switching authority information field.
Tag names can be freely defined.

2.9.3.1
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[sc_Assigning_Switching_Authority_Top_level, 3, en_US]

Figure 2-77 Assigning a Specific Switching Authority for a Topological Level

For more information on the switching authority, refer to A.14 Information – Switching Authority.
For more information on the parameterization of the switching authority on the SICAM SCC Human-Machine
Interface (HMI), refer to /5/ SICAM SCC, Human Machine Interface SICAM SCC.

Grid Codes
Grid Codes are defined in the Grid Codes view in the SICAM PAS/PQS system and assigned to the individual
topological structure levels in the Topology view.
To assign Grid Codes:
² Select the structure level and assign up to 4 Grid Codes in the input area.
The Grid Codes include limit values which serve as a basis for the evaluation of PQ measuring data.

2.9.3.2
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[sc_Assigning_Grid_Codes, 3, en_US]

Figure 2-78 Assigning Grid Codes

For more information on the import of Grid Codes and change options for the limit values defined in these
Grid Codes, refer to 2.16 Grid Codes.

Measurement Parameters
You can parameterize the following data in the Measurement parameters section:

• Power frequency of the system (Nominal frequency in Hz)

• Voltage level of the system as phase-to-phase voltage (Nominal voltage in kV)

• Declared supply voltage of the system as phase-to-phase voltage (Operating voltage in kV)
These data are used for the fault-location calculation.

Measuring Channels
Measuring channels include a description of the information transmitted from the devices. They include for
example, the phase assignment of the voltage and current channels. This assignment is required for example,
for the fault location function.
The measuring channels are created automatically during:

• Parameterization of a SIMEAS R or SICAM Q80 device

• Import of the XML files for protection devices created with DIGSI 4 or DIGSI 5
For the following application cases, you must define these measuring channels yourself in the Templates
view:

2.9.3.3

2.9.3.4
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• Protection devices which provide fault records

• Visualization of fault records from IEC 60870-5-103 devices which include non-standardized channels or
channel texts

• Virtual devices of the PQS Automatic Import function
Templates are available for this purpose. For more information, refer to 2.11.8 Recording Channels.
In the Measuring group assignment section, you assign the measuring group with the related measuring
channels to the topological level where the PQ data and fault records shall be available for analysis.

Defining the SICAM PQS Fault Locator
The SICAM PQS Fault Locator creates fault location reports which you can evaluate using the SICAM PQ
Analyzer. The fault location reports are created either automatically or manually. You can define to be notified
by e-mail and/or SMS on completion of a fault location report. For more information, refer to 2.6.16 PQS
Automatic Notification.
For automatic fault location, you insert the PQS Automatic Fault Location application in the project structure
in the Configuration view.
The Topology view allows you to parameterize the data of the automatic and manual fault location function.

ii NOTE
In the Topology view, if

• the user-defined group and the station or

• the user-defined group and the voltage level or

• the user-defined group and the bay level
are present at the same topology level, fault location reports are not generated for the user-defined group.

On the bay level, you define line data, the rated current, the maximum load current, and the star point
direction. In addition, you activate the automatic fault location function on this level.
On the voltage and bay levels, you select all measuring channels in the Measuring group assignment section
that are used for the fault-location calculation, refer to 2.9.3.4 Measuring Channels.
On the bay level, you assign the measuring channels in the Fault location section that are used for the
automatic fault location function. The assignment is done separately for the voltage and current measuring
channels.
In the Segments table, you configure the single line sections used for the fault location calculation. You
define, for example, the line type (overhead line, 3-pole or 1-pole cable), the line length, the resistance and
the capacity for each line section.
On the project level, the line data defined for the overall project are displayed in the Global line overview tab.
You cannot change any parameters in this tab.

2.9.3.5
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[sc_Parameters_Fault_Locator, 3, en_US]

Figure 2-79 Defining the Parameters of the Fault Locator

Defining Line Segments
The segment table allows you to define the single line sections. The type and number depend on the lines
between the stations.
A line must consist of at least one line segment. The length of a line is calculated as the sum of the lengths of
all line segments.
A double line consists of 2 parallel lines with identical line data.
The performance characteristics of the Fault Locator include:

• Single-ended fault location
Single line: 1 line is connected to one single bay of a station
Double line: 2 parallel lines are connected to 2 bays of a station

• Two-ended fault location
Single line: 1 line connected to 2 bays of 2 stations
Double line: 2 parallel lines connected to 4 bays of 2 stations

• Parallel line compensation
– For segment-wise coupled lines
– Direct support of double lines
– For identical or different voltage levels

The segment in the first row of the list corresponds to the segment on the highlighted bay. The segment in
the last row of the list corresponds to the segment on the remote bay.
The display of the columns (parameters) in the segment table depends on the input-format selection in the
dialog Options for line parameters.
² To do this, select Tools > Options for line parameters... .
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[sc_Options_Line_Parameters, 1, en_US]

Figure 2-80 Defining the Input Format of Line Parameters

You can copy and delete segments or change their order.
You can either enter the capacities or have them calculated from the reactance.
The following table shows the possible parameters of the segment table.

Table 2-4 Line Parameters

Bay Meaning
Segment Name of the line segment
Coupling Selection of the parallel line segment which is to be coupled to the current

segment
Type Segment type

The following entries are possible: Overhead, 3-pole cable or Single-pole cable.
Length Length of the line segment in km or miles

The unit depends on the regional settings of the operating system.
Central phase Phase in the center of the phase arrangement For twisted lines, None/Unknown

must be defined here.
Resistance R1’ Positive-sequence resistance in Ω/km or in Ω/mile
Reactance X1’ Positive-sequence reactance in Ω/km or in Ω/mile
Capacity C1’ Positive-sequence capacity in μF/km or in μF/mile

C1’ is equal to the CB’ operating capacity.
Resistance R0’ Zero-sequence resistance in Ω/km or in Ω/mile
Reactance X0’ Zero-sequence reactance in Ω/km or in Ω/mile
Capacity C0’ Zero-sequence capacity in μF/km or in μF/mile
Phi angle Angle between R1 and X1 (positive sequence) in degrees
RE/RL Scalar factor of the resistance ratio

RE = resistance (ground), RL= resistance (line)
XE/XL Scalar factor of the reactance ratio

XE = reactance (ground), XL= reactance (line)
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Bay Meaning
kL amount Amount of the impedance ratio, ZE/Z1

(ZE = amount of the ground impedance, Z1= amount of the positive-sequence
impedance)
kL corresponds to the k0 parameter

kL angle Angle between the ZE and Z1 impedances in degrees
kL corresponds to the k0 parameter

Z0/Z1 amount Amount of the impedance ratio, Z0/Z1

(Z0 = amount of the zero-sequence impedance,
Z1= amount of the positive-sequence impedance)

Z0/Z1 angle Angle between the Z0 and Z1 impedances in degrees
RM/RL Parallel line coupling

RM = resistance (coupling impedance), RL = resistance (line)
R0m’ Mutual zero-sequence resistance (coupling resistance) of the line in Ω/km
XM/XL Parallel line coupling

XM = reactance (coupling impedance), XL = reactance (line)
X0m’ Mutual zero-sequence reactance (coupling reactance) of the line in Ω/km

For more information on the functionality and parameterization, refer to /12/ SICAM PQS, Fault Locator.

Assigning Fault Records
Fault records are created by PQ devices and protection devices or transferred by the PQS Automatic Import
function in SICAM PAS/PQS.
Afterwards, fault records can be selected in the Configuration view of the SICAM PQ Analyzer, Incident
Explorer view.
In order to also display fault records in the topological view of the SICAM PQ Analyzer, link the device
information in SICAM PAS/PQS UI – Configuration, Topology view, with a topological level.
If the device has a description of the recording channels (Templates view), the linkage with the topological
level is performed by assigning the measuring channels of the device (Topology view). If the fault records are
used for the Fault Locator, the linkage must be performed in this way.
For all other devices, you assign the _Opr tags of those devices which transmit fault records to the topological
levels on which the fault records are to be displayed.
To assign the _Opr tag:
² Select the project in the tree structure of the Topology view.

² In the Assignments tab, select the row of the device's with _Opr tag.

² Drag the tag to the topological level on which you want to display the fault record in the topological view
of the SICAM PQ Analyzer.

ii NOTE
In case of a redundant configuration (system redundancy, interface redundancy, or full redundancy),
ensure that the _Opr tag of the device in primary system is assigned to the topological level.

The fault record is also stored in the archive under this topological assignment.
If you copy a device in the Configuration view and paste it in the Topology view, all items of information
of the device are transferred to the selected topological level. If this happens, no additional linkage of the
device's _Opr tag is required. Fault records are displayed under the topological level to which the device is
assigned.

2.9.3.6
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Formula-Based Device Configuration
By the means of a formula, you copy the configured device and its redundant (interface and system) devices
including mapping information, topology assignments, and lists and create definable quantities of the device
with unique names (case-insensitive). During copying control center mappings, the control center mappings
and the topology assignments of the selected device are copied to all devices of the same device group.
During updating, the properties of the devices are updated collectively with respect to the base device.

[dw_Workflow_FBDC, 1, en_US]

Figure 2-81 Workflow for Formula-Based Device Configuration

(1) 2.10.1 Preliminary Steps
(2) 2.10.2 Pasting Multiple Objects
(3) 2.10.3 Copying Control Center Mappings
(4) 2.10.4 Updating Multiple Objects

2.10
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Preliminary Steps

Before you copy devices using a formula:
² Configure a device and create a list (for example, an interrogation list).

For more information, refer to 2.6 Setting Up and Editing the Configuration.

² Define mappings for the device.
For more information, refer to 2.8 Defining the Mapping.

² Map the topological structures to the device.
For more information, refer to 2.9 Mapping the Topological Structures.

ii NOTE
The configuration of the device can be changed by using Update multiple… feature and overwriting
manually.

How to Proceed
To configure the devices using a formula, consider the following order:
2.10.2 Pasting Multiple Objects
2.10.3 Copying Control Center Mappings
2.10.4 Updating Multiple Objects

ii NOTE
These functions can be applied to the devices in redundancy configurations.

Pasting Multiple Objects

The purpose of this function is to create a definable quantity of copies of a configured device. The selected
device is referred as a base device. When pasting an object, select a target interface from the same applica-
tion type in the tree structure (either in the Full Server or the DIP).
The Paste multiple... function can only be used for the following applications:

• IEC 60870-5-101 Master

• IEC 60870-5-103 Master

• IEC 60870-5-104 Master

• DNP3 Master

• Modbus Master

ii NOTE
The mandatory attributes (red fields) of a device and its redundant device need to be unique, for example,
Link address for IEC 60870-5-101 Master.

To paste multiple objects:
² Select the device, which you want to use as the base device and select Copy from the context menu.

2.10.1

2.10.2
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[sc_Copy_Multiple, 3, en_US]

Figure 2-82 Selecting Copy from the Context Menu

² Select the desired interface from the same application type and select Paste multiple… from the context
menu.

[sc_Paste_Multiple, 3, en_US]

Figure 2-83 Pasting Multiple

The Create multiple devices dialog opens.
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² In the Number of copies field, enter the number of copies of the device you want to create.

[sc_Number_of_Copies, 1, en_US]

Figure 2-84 Create Multiple Devices

Defining Formula
A formula is used to create unique parameters such as names, device addresses, and topology information. A
new formula can be created or an existing formula can be edited.
² Click New formula or Edit formula.

The New formula or Edit formula dialog opens.
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[sc_New_Formula, 1, en_US]

Figure 2-85 New Formula

² In the Name field, enter a name for the formula you want to create.
This field is enabled only while creating a new formula.

² In the Start value field, enter a starting value for the formula.

² From the Function and Operand field, select an operating function and an operand to be implemented
on the starting value respectively.

² Click Apply.
The formula created is displayed in the Formulae list and can be used for parameterizing the device
properties.
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[sc_Create_Multiple_Dev_without_Redund, 1, en_US]

Figure 2-86 Creating Multiple Devices without Redundancy Enabled
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[sc_Create_Multiple_Dev_with_Sys_Redund, 1, en_US]

Figure 2-87 Creating Multiple Devices with System Redundancy Enabled
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[le_Create_Multiple_Devices, 1, en_US]

Figure 2-88 Creating Multiple Devices with Redundancy Enabled

(1) Interface redundancy, for example IP address in Communication parameters
(2) Interface redundancy and system redundancy, for example IP address in Communication parame-

ters

Defining Devices by means of Formulae
To create multiple copies of the device with unique names, a formula is used as follows:

Name of the device{$Name of the formula:Formatter value}
Optionally, a formatter value can be used along with the name of the formula. It gives the minimum number
of numericals to be displayed after the name of the device.
² Under the Applied formulae column, in the Name field, enter the name of the device.

² Select the name and select a formula from the context menu.
A formatter value can be optionally added.

² In the Device group field, enter a name for the group.
The Device group is the group to which the base device and all the copied devices are assigned to, so
they can be edited together.

² Select any editable field in the Applied formulae column and select a formula from the context menu.
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[sc_Formulae_Selection, 1, en_US]

Figure 2-89 Selecting Formula from List

ii NOTE
If there are no errors (red fields), Generate preview is enabled.

Generating Preview
Generate preview is used to display the parameter values of the devices which are meant to be created.
² To preview the parameter values specified for the devices, click Generate preview.

If you edit the editable fields of the properties of the created devices, Manual overwrite is displayed in
the Applied formulae column in the corresponding row.
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[sc_Generate_Preview, 1, en_US]

Figure 2-90 Generate Preview

ii NOTE
The Create multiple devices dialog displays all the information of the devices which are going to be
created. The Create button is only enabled if there are no errors (red fields).

² Click Create.
During the Creating multiple devices process a progress bar is displayed.
The devices created are listed under the targeted interface.
The topology assignments are also copied from the base device to the created devices. The base device
is specified by  (yellow) symbol.

[sc_Creating_Multiple_Dev, 1, en_US]

Figure 2-91 Creating Multiple Devices

Example
To create 3 copies of 7SJ611, namely 7SJ611_02, and 7SJ611_03, proceed as follows:
Enter 3 as the Number of copies. Create a New formula named AutoAddition with the Start value as 2,
Function as Addition, Operand as 1, and Formatter value as 2.

Configuration
2.10 Formula-Based Device Configuration

132 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



Edit the Name field to 7SJ611_{AutoAddition:2}. On applying the created formula, the copies of the device
are created and listed under the Interface.

[sc_Created_Dev, 3, en_US]

Figure 2-92 Created Devices

Importing/Exporting
Export/Import is used to save/retrieve all the parameters (including mapping, topological assignments, user-
defined formulae, and type of the device) of the base device to/from a user-defined path.
² Click Export, to save the values of all the parameters of the base device as displayed in the Applied

formulae column from Create multiple devices dialog to a user-defined path.

² Click Import, to delete all the generated data, retrieve the saved file from the user-defined path, and
displays the user interface with the retrieved values.

Copying Control Center Mappings

The purpose of this function is to implement the mappings from the desired device to the selected devices in
the same device group. For more information, refer to 2.8 Defining the Mapping.
The Copy control center mappings... function can only be used for the following applications:

• IEC 60870-5-101 Slave

• IEC 60870-5-104 Slave

• IEC 61850 Server

• DNP3 Slave

• Modbus Slave

2.10.3
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• SCC

• Automation (SoftPLC)
To copy control center mappings:
² Open the Mapping view.

² Configure all the items of information of the base device, as required.

² Select the Control center of the selected device and select Copy control center mappings... from the
context menu.

[sc_Copy_Control_Center, 3, en_US]

Figure 2-93 Selecting Copy Control Center Mappings

The Copy control center mappings dialog opens.
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[sc_Select_Dev_Mapping, 1, en_US]

Figure 2-94 Selecting Device for Mapping

² Select any device from the Available devices list.
In the Available devices list, all the devices which are mapped to the control center are listed. Select the
device whose mappings should be applied to the selected target devices belonging to its device group.

² Select the devices from the Available target devices list to which you want to apply the mappings of the
selected device from the Available devices list.
In the Available target devices list, all the devices of the same device group (excluding the selected
device) are listed.

ii NOTE
In case of the SCC application, the changes made manually in the Message group, Tag group, and Tag
logging (hierarchy) columns are not copied or overwritten.

² Click Next >.
The Configure mapping values dialog opens.
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[sc_Configure_Mapping_Values, 1, en_US]

Figure 2-95 Configuring Mapping Values

In the Configure mapping values dialog, you can create a new formula or edit a formula displayed in the
Formulae list.
The Selection of device properties list only displays the address properties of the mapped device.
These properties are already configured and can only be edited in the Configuration view.

ii NOTE
The Configure mapping values dialog is not applicable for the SCC application.

² Select the editable field of the columns and edit it manually or use one of the selections from the context
menu. For mapping, unique information addresses (of Telegram address, Byte3, Byte2, and Byte1) are
required.
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[sc_Selecting_Formulae_Mapping, 1, en_US]

Figure 2-96 Selecting Formulae for Mapping

From the Formulae menu, you can select a formula to create a unique address.
From the Control center properties and Device properties menu, you can select a property value already
mapped in the Control center, these values can be used instead of a formula to create a unique address.

Importing/Exporting
Import/Export is used to retrieve/save the topological assignments, user-defined formulae, and user-defined
parameters to/from a user-defined path.
² Click Apply.

The data is generated.
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[sc_Applied_Mapping_Values, 2, en_US]

Figure 2-97 Mapped Devices

Updating Multiple Objects

The purpose of this function is to select the base device and update all the devices, which belong to the same
device group.
The Update multiple... function can only be used for the following applications:

• IEC 60870-5-101 Master

• IEC 60870-5-104 Master

• IEC 60870-5-103 Master

• DNP3 Master

• Modbus Master

• IEC 61850 Client
To update multiple devices:
² Open the Configuration view.

² Select the base device and select Update multiple... from the context menu.

2.10.4
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[sc_Update_Multiple, 2, en_US]

Figure 2-98 Selecting Update Multiple

The Update multiple devices dialog opens. The Base device column displays the properties of the base
device.
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[sc_Update_Multiple_Dev_without_Redund, 1, en_US]

Figure 2-99 Update Multiple Devices without Redundancy
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[sc_Update_Multiple_Dev_with_Sys_Redund, 1, en_US]

Figure 2-100 Update Multiple Devices with System Redundancy
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[le_Update_Multiple_Devices, 1, en_US]

Figure 2-101 Update Multiple Devices with Redundancy Enabled

(1) Interface redundancy, for example IP address in Communication parameters
(2) Interface redundancy and system redundancy, for example IP address in Communication parame-

ters

You can make any changes either manually or using a formula.
For more information on formula, refer to Defining Formula, Page 126.

ii NOTE
Update is enabled after validating all the device parameter values.

ii NOTE
If a device group does not have a base device, the device which was created first in that group is displayed
in the Base device column in the Update multiple device. On clicking Update, it becomes the base
device for the group.
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ii NOTE
When the devices in a group are updated, the lists, the mapping information, and the topology assign-
ments for the devices are overwritten by the entries of the base device.
In case of IEC 61850 Client, only the mapping information and the topology assignments are updated, lists
are neither copied nor overwritten.
The device properties and names of the bays are updated according to the user-defined entries.

² Click Update.
During the Updating multiple devices process, a progress bar is displayed.

[sc_Updating, 1, en_US]

Figure 2-102 Updating Multiple Devices

The devices are updated.

[sc_Created_Dev, 3, en_US]

Figure 2-103 Updated Devices
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Working with Device Templates

Device Templates

A device template describes a device's volume of information in the monitoring and command direction. The
volume of information includes both process information and status information of the device.
Device templates are used if no import templates for the devices' configuration data are available.
The scope of delivery of SICAM PAS/PQS UI – Configuration includes device templates for:

• Each communication protocol

• PQS Automatic Import

• SoftPLC

• OPC Client

• SNMP

• SICAM MIC Master
You can directly use these templates for the configuration of your station or customize them to your individual
requirements.
Configuration data which have been imported from devices are saved as templates and used for further
devices.
Device templates are also available as device descriptions (text files). Storage location:

%PUBLICDOCUMENTS%Siemens\SICAM PAS PQS\DeviceDescriptions
Using the import function of SICAM PAS/PQS UI – Configuration, you can import either these device templates
or customized device templates.
Device templates should be created in the UTF-8 or ANSI format, since only these formats are supported by the
import function. Do not use special characters or umlauts.
To edit your device templates, use the

• Notepad editor and save them in the ANSI format.

• Wordpad and save them as a text document.
Various device parameters can only be modified in the Templates view, for example, the assignment of
commands and feedbacks or telegram numbers.
You can define IEC 61850 Ed.2 object models for devices which are not connected by using the IEC 61850
protocol and whose information is transmitted to a control center by using the IEC 61850 Ed.2. These object
models include specific parameters and mappings which can be used for mapping the device information to
an IEC 61850 Server.
In the General recording channels and Triggered recording channels only tabs, you define the measuring
channels of the PQ measuring data and fault records used for fault location. Assign channels and phases and
define the channel for the signal which triggers the fault recording.

How to Proceed
The following options are available for editing device templates:

• 2.11.2 Showing a Device Template

• 2.11.3 Filtering Information Tables

• 2.11.4 Editing Information

• 2.11.7 Deleting a Device Template

• 2.11.6 Updating a Device Template

2.11

2.11.1
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• 2.11.5 Importing/Exporting a Device Template

• 2.11.8 Recording Channels

Showing a Device Template

To show a device template:
² Select the communication protocol for which you want to show the device template.

² Click the arrow next to a communication protocol in order to open the list of device templates available
for this protocol.

[sc_Dev_Template, 3, en_US]

Figure 2-104 Device Template, Example

The Templates view is subdivided into the following areas:

• Configuration tree

• Input area

• Properties, General parameters
The input area is subdivided into the following tabs:

• Information
The Information points is available for each application. The tab includes the process and status infor-
mation of the application, classified according to Information – Monitoring direction and Information
– Command direction. For the IEC 61850 Ed. 2 protocol, protocol-specific process information is also
summarized in the LN state (Logical Node) tab.

2.11.2
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• General recording channels
The General recording channels tab is available for applications which create PQ measuring data or
fault records for fault location. They define for example, the assignment of the measuring channel and
the phase.

• Triggered recording channels only
The Triggered recording channels only tab is available for applications which create PQ measuring data
or fault records for fault location. The tab shows a description of the channel assignment for the trigger
signal which starts the fault recording.

Filtering Information Tables

A filter function is available for the individual information columns. By using this function, you can define
column-specific filter criteria.
To use the filter function:
² Open the drop-down list box below the column header:

² Select an entry from the drop-down list box, for example, the DP filter criterion for double-point informa-
tion in the Information type column.

The table now only shows information of the type DP.
² To show again the complete information, select (None) from the drop-down list box.

- or -

² Select (User) in the drop-down list box to open the User filter.

² Enter your filter criteria and click OK to confirm.

Editing Information

Using SICAM PAS/PQS UI – Configuration, you can edit the information included in a device template. Each
item of information is shown in a separate row of the list and consists of several parameters. Parameters
which cannot be modified are shown in gray.
The following options are available:

• Copying Information, Page 146 and Duplicating Items of Information, Page 147

• Deleting Items of Information, Page 147

• Changing the Names of Items of Information, Page 147

• Changing the Parameters of an Item of Information, Page 149
The changes influence the project database. However, they do not influence the text files installed in the
installation directory. To use the customized device templates in another project, export them in the TXT data
format. For more information on export, refer to 2.11.5 Importing/Exporting a Device Template.

Copying Information
To copy an item of information:
² Select the row number of the item of information which you want to copy.

² Select Copy from the context menu.

² Select Paste from the context menu.
The information is pasted. It is possible that pasted information is not displayed in the current selection if the
filter and sorting criteria have been defined accordingly.
The parameters of the copied and pasted item of information are highlighted in red. Under Name, enter a
unique name for the new item of information in order to ensure that your change becomes effective.
Place your mouse pointer on the cell highlighted in red. The cause of the error is now described in a tooltip.

2.11.3

2.11.4
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² Open the error field  or the warning field . The cause is explained line by line in this field.

If you exit the table in an invalid state with fields highlighted in red, for example, without entering a unique
name, a dialog opens. In this dialog, you are prompted to confirm whether you want to correct or cancel your
change.
You can also use the copy function to edit the information of an MS EXCEL table template. The filter and
sorting options provided by the system support you in the selection of data to be modified, refer to 2.8.2 Opti-
mizing the View.
When copying back the information in the Templates view, make sure that the same sorting criteria are
defined. This ensures that no information parameters are accidentally confused.

Duplicating Items of Information
To paste items of information of the same type at several different places, use the Duplicate function.
To duplicate an item of information:
² Select the row number of the item of information which you want to duplicate. Select Duplicate from

the context menu.

[sc_Entering_No_Dupli, 1, en_US]

Figure 2-105 Entering the Number of Duplicates

² Enter the number of duplicates and click OK to confirm.
The duplicates are pasted at the bottom of the input area. The row numbers of the pasted items of informa-
tion are highlighted in yellow. The parameters of the copied and pasted items of information are highlighted
in red.
² Open the error field  or the warning field . The cause is explained line by line in this field.

² Double-click the blue text in the error field in order to display the erroneous parameter.
If you exit the table in an invalid state with fields highlighted in red, a dialog opens. In this dialog, you are
prompted to confirm whether you want to correct or cancel your change.

Deleting Items of Information
You can delete one or several items of information from a device template.
To delete an item of information:
² Select the row number of the item of information which you want to delete.

² Select Delete from the context menu.

² Confirm the Delete command with OK. The selected item of information is deleted from the device
template.

ii NOTE
If you delete the information from templates, this information is also deleted at other positions in your
station configuration where you have used and mapped the template.

Changing the Names of Items of Information
In device templates, you can browse for the names of items of information according to a defined string and
replace this string by a different string.
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By using the Find/Replace function, you can search according to the following criteria:

• The names of items of information in the individual tables of a device template

• All names of the items of information included in a device template

• The names of items of information in all device templates of a protocol
The search includes all lower-level areas. If you select for example, an application, all assigned device
templates will be searched.
To search for a specific string in a device template:
² In the Monitoring direction tab, select for example, the Name column header.

² Select Find... from the context menu.
The Find and Replace dialog opens.

[sc_Finding_Char_String, 3, en_US]

Figure 2-106 Finding a Character String

² Under Find..., enter the string and click Find.
The search result is displayed in the Report.

To find a specific string in all device templates of an application:
² Select the application in the configuration tree. Select Find... from the context menu.

The Find and Replace dialog opens.

² Under Find..., enter the search string and click Find.
The search result is displayed in the Report.

To replace a specific string in a device template:
² Select the device template in which you want to search for a character string and select Replace from the

context menu.
The Find and Replace dialog opens.
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² Enter the string to be replaced under Find:.
² Under Replace with, enter the new character string and click Replace.

Prior to execution, the changes are shown in the Report. In the dialog, confirm your changes.

² In the Confirm Find and Replace dialog, click Yes.
The changes are executed now.

To replace a character string in all device templates of an application, proceed in the same way as described
for the Find function for a character string in all device templates.

Changing the Parameters of an Item of Information
Some device parameters can only be modified in the Templates view, for example, the assignment of
commands and feedbacks or telegram numbers.
To change a parameter of an item of information:
² Double-click the parameter in order to edit it or select an entry from the drop-down list box.

- or -

² Select the parameter and select a new entry from the context menu.

[sc_Selecting_Entry, 3, en_US]

Figure 2-107 Selecting an Entry from the Drop-Down List Box

Defining Object Models for IEC 61850 Ed.2

² In the Templates view, you can define for all device types specific object models which include the
configuration for the IEC 61850 connection to a higher-level control center.

For example, an object model includes a circuit breaker with its complete configuration of the logical node
assigned.
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The Templates view allows you to generate proposed values for the MMS addresses for devices connected to
SICAM PAS/PQS by using the IEC 61850. These proposed values are generated based on the available address
information of the template. To generate the values, use the Create MMS addresses function.
For all other protocols, the definition of object models considerably facilitates the parameterization of the
control center connection. The object model defined in the Templates view is displayed as a suggestion for
the configuration of information during the mapping of the control center connection.
Some protocols do not provide all parameters expected in accordance with IEC 61850 Ed.2 standard. A
warning is issued if the parameterization is incomplete. The configuration is nevertheless valid.
The columns for defining the object model (LD, LN, DO, DA) are not visible by default. You can change this
option by using the context menu, refer to Showing/Hiding Columns, Page 104.

[sc_Templates_view_IEC 61850, 3, en_US]

Figure 2-108 Templates View, IEC 61850 Object Model Parameterization

For information on how to map the IEC 61850 Server application to the control center connection, refer to
Using Information, Page 106.

Importing/Exporting a Device Template

If you require new device templates in your station configuration or if you want to save a device template
which you have previously modified using SICAM PAS/PQS UI – Configuration, you proceed with:

• Importing a Device Template, Page 150

• Exporting a Device Template , Page 151

Importing a Device Template
In order to insert a device type which does not exist in your station configuration, you must first insert the
corresponding device template. To do this, import a corresponding TXT file.
This text file can be:

• A previously exported device template

• A text file which has been saved as a sample template (sample device) in the installation directory during
installation (...\DeviceDescriptions)

2.11.5
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During the import, the device template is added to the project database.

To import a device template:
² In the templates tree, right-click the communication protocol for which you want to import into the new

device template and select Import... from the context menu.

² In the file selection window, select the TXT file which you want to import as a device template.

² Click Open.
The device template is imported and the import is logged in the Report. Provided that the import is executed
without errors, the device template is shown below the highlighted communication protocol in the template
tree.

Exporting a Device Template
In order to save a modified device template, you can export it into a TXT file and continue your work in this
file.
To export a device template:
² In the templates tree, right-click the device template which you want to export and select Export... from

the context menu.

² Enter the path and the name of the destination file in the Save as dialog.

² Click Save to confirm. The device template is saved as a TXT file.

Updating a Device Template

If a device description has been modified, you can update the device template. The new template must be
available as a text file.
During the update,

• new items of information are added

• items of information which are no longer available are deleted

• changes are overwritten in the parameters
Modifications of the basic parameters of an item of information, such as the information type or the telegram
address, are processed in the same way as new items of information.

To update a device template:
² In the templates tree, select the device template which you want to update. Select Update... from the

context menu.

² In the Open dialog, select the TXT file and click Open.
The text file is read and the progress is shown in the Report.

Deleting a Device Template

If you do not want to use existing device templates in your station configuration, you can remove it from the
templates tree.

ii NOTE
The delete process deletes the device templates from the project database. The text files included in the
scope of delivery are retained in the installation directory. If required, you can re-import the template.
Click Export, to save the templates modified by using SICAM PAS/PQS UI – Configuration. For more
information, refer to 2.11.5 Importing/Exporting a Device Template.

2.11.6

2.11.7
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To delete a device template:
² In the templates tree, click the device template which you want to delete. Select Delete... from the

context menu.
The device template is no longer shown in the template tree.
If you use the device template in your station configuration, the delete function is disabled.

Recording Channels

In the General recording channels and Triggered recording channels only tabs, you define the measuring
channels for the following applications:

• PQ measuring data

• Fault records used for fault location

• Fault records including fault record channels with non-standardized channel texts (IEC 60870-5-103), for
example, from third-party manufacturers.

• Fault records of IEC 61850 devices, that have more than 1 fault record directory.

ii NOTE
For recorder routing in DIGSI 5, several routing modules are available which can differ regarding the
calculation method and the refresh rate of measurands. If you record the same measurands with different
calculation methods and refresh rates you have to route these measurands to different recorders to enable
SICAM PAS/PQS to process these measurands.

Assign for example, channels and phases and define the channel for the signal which triggers the fault
recording. The measuring data is connected by using the PQS Automatic Import application, refer to
2.6.13  PQS Automatic Import.
Tabs are provided for all applications for which PQ measuring data or fault records can be available:

• IEC 61850 Client

• IEC 60870-5-103 Master

• SINAUT LSA ILSA Master

• SIPROTEC 4 Service IF Master

• SIMEAS R Master

• SICAM Q80 Master

• PQS Automatic Import
The scope of delivery of SICAM PAS/PQS UI – Configuration includes templates for the parameterization of the
measuring channels. Templates in the DDREC file format are available under:
%PUBLICDOCUMENTS%\Siemens\SICAM PAS PQS\Recording
To insert pre-configured measuring channels (measuring equipment) in the General recording channels tab:
² From the configuration tree in the Templates view, select a device template and select Update from the

context menu.

² In the dialog which opens, select the DDREC template file.
The preconfigured measuring channels are imported. The import is recorded in the Report.

2.11.8
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[sc_Templates_view_Channels, 3, en_US]

Figure 2-109 Templates View, General Recording Channels Tab

You can also define individual recording channels. To do this, you require:

• A group

• Channels

• Attributes
You require groups and channels for PQ data and fault records. The attributes are only used for PQ data.

Group
To insert a group:
² Select a row number and select Add group from the context menu.

² In the Group name column, enter the name of the group.

Channel
To insert a channel:
² Select a row number and select Add channel from the context menu.

² In the Channel name column, enter the name of the channel.

² In the Phase column, select the channel's phase assignment from the list box.

² Select the unit for the measuring variable from the Unit column.

ii NOTE
For PQ data, you define the phases of the voltage channels depending on the network type.
For the Star network type, you assign the phase-to-ground channels.
For the Delta network type, you assign the phase-to-phase channels.

Attribute
To insert an attribute:
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² Select a row number and select Add attribute from the context menu.

² In the dialog which opens, select the attribute, for example, operational value or average value, from the
list box in the Parameter name field.

² Select a value from the list box in the Characteristic column, for example, Voltage, Harmonic, Pointer or
User-defined.

² Select a value from the list box in the Measurement value type column, for example, Mean Value, PQ
violation or Evaluated event.

² Enter a measured value number in the Operational value column.

Deleting a Group/Channel/Attribute
To delete a group or a channel or an attribute:
² Select the row number.

² Select Remove group from the context menu.

² Select Remove channel from the context menu.

² Select Remove attribute from the context menu.

Configuring Recording Channel for IEC 61850 Devices that have more than 1 Fault Record Directory

² Create a group.
The name of the group can be entered individually. The attributes of the group are not evaluated and can
be set individually.

² Create a new channel for each fault record directory of the device.
The channel name must accord to IEC 61850 address of the related COMTRADE directory in the device:
<Devicename><LDname>\COMTRADE\.

² Set the channel attributes as follows:
– Channel index: Unique value - continuous numbering, Value range: 0...499 (not validated)
– Characteristic: Fault record
– Scaling type: Absolute
– Measurement value type: File

 
 

ii NOTE
For SIPROTC 5 devices, the 108 channel index is used internally and is therefore not available as a fault
record channel for IEC 60870-5-103 Master.

Working with Normalizations
In substations or industrial manufacturing plants many different data acquisition devices are used. Different
components and devices transmit the captured data in many different formats.
By using normalization procedures, you can convert this data to units suitable for further processing and
comparison.

How to Proceed
The data conversion concept applied by SICAM PAS/PQS consists of the following 2 steps:

• Defining Normalization Procedures, Page 155

• Assigning Normalization Procedures, Page 160

2.12
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Defining Normalization Procedures
By selecting a normalization procedure, you define the type of conversion of a certain value.
For frequent requirements, you define the following normalization procedures:

• Measured-Value Filtering, Page 156 (threshold suppression)

• Linear Transformation, Page 157 for analog inputs/outputs (integer and floating point number)

• Conversion, Page 157 for digital inputs/outputs

• Chatter Blocking, Page 159
To create a new normalization procedure:

• In the Templates view, select the Normalizations entry below the device templates.

• Select Normalization and define a new normalization procedure in the Insert – Normalization dialog.

[sc_Insert_Normal, 1, en_US]

Figure 2-110 Insert – Normalization

Table 2-5 Normalization: General parameters

Parameter Name Explanation
Name Unique name of the normalization procedure
Description Brief description of the new procedure (free text input)
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Parameter Name Explanation
Input type Data type for which the normalization procedure applies:

Analog (Integer), Analog (Floating Point) or Digital
Conversion type The conversion types available in this dialog depend on the data type (input type)

which you have selected in the previous dialog.
Digital: none or Conversion
Analog: none or Scaling

Measured-Value Filtering
In power transmission and distribution networks, numerous minor value changes can occur which are not
relevant for system operation.
A measuring and logging system must be able to filter such minor changes, but to log significant changes.
SICAM PAS/PQS filters measured values based on a normalization procedure. You can define a normalization
procedure which only filters measured values or which combines measured value filtering with a threshold
check.
Measured-value filtering is defined by using the Threshold suppression parameter group.

ii NOTE
With the Threshold type, you specify the rule which initiates a measured-value transmission when the
threshold value has been reached or exceeded. In the Mapping view, Information - Monitoring Direction,
you can select the following threshold types:

• Direct

• Integrating

• Direct with dynamic adjustment

• Integrating with dynamic adjustment
For more information refer to the IEC 60850-5-101 Slave and IEC 60850-5-104 Slave online help file.

Table 2-6 Normalization: Threshold Suppression

Parameter Name Explanation
Threshold suppression Enables (Yes) or disables (No) measured-value filtering
Threshold band Cyclically incoming values in the range between the upper and the lower

threshold are not transferred. Values outside the measured value range are
always transferred.
After each transmission of a value, the threshold band is adjusted in such a way
that the last valid value is in the center of the threshold band. Values which are
outside the threshold band or were transmitted after the suppression interval
has elapsed are not transferred.

Suppression interval [s] The cyclically incoming value is always transferred as soon as the suppression
interval has elapsed - no matter whether it is inside or outside the threshold
band.

NOTE
The Suppression interval [s] is only evaluated in the following applications:
- CDT Slave
- OPC Client
- OPC XML DA Server
- PROFIBUS DP Master
- SINAUT LSA ILSA Master
- Telegyr 8979 Master
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Example
Values shown in the gray zone are not transmitted since they are within the threshold band (for example,
200). As soon as the suppression interval has elapsed, for example, 60 seconds, the cyclically transmitted
value is forwarded independently of the defined threshold band. The new value is used as the new reference
point for the threshold band.

Values outside the threshold band are always transmitted and thus also form the new reference point of the
threshold band.

[sc_Measured_Value_Filtering, 1, en_US]

Figure 2-111 Measured-Value Filtering

Linear Transformation
A Linear transformation can be defined in the Scaling parameter group. Enter the Scaling and the Basis.
Value on the output = input x scaling + basis
If the Analog input type (integer value and floating point value) and the Scaling conversion type have been
selected, the input fields of this parameter group are active.

Conversion
A digital input must be converted if systems require the values transmitted from the device in another unit for
further processing.
Define a conversion in the Conversion parameter group. To do this, enter the input/output values. Up to 4
value pairs can be defined.
If the Digital input type and the Conversion type have been selected, the input fields of this parameter
group are active.
In SICAM PAS/PQS, values transmitted by the device have the following meaning:

Table 2-7 Device Values in SICAM PAS/PQS

SICAM PAS/PQS Double-point indication Single-point indication
0 Intermediate position 00
1 OFF Cleared
2 ON Raised
3 Intermediate position 11

An output value must be defined for all input values. For a double-point indication, 4 value pairs must be
defined. For a single-point indication, 2 value pairs must be defined. The input value corresponds to the
process value. The output value corresponds to the value mapped in SICAM PAS/PQS.
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INTERMEDIATE (DI) example Inversion (SI) example
1. pair of values 0:3 1:2
2. pair of values 1:1 2:1
3. pair of values 2:2
4. pair of values 3:3

In the INTERMEDIATE example, SICAM PAS/PQS transmits all incoming intermediate positions with Inter-
mediate position 11.

[sc_Intermediate, 1, en_US]

Figure 2-112 Example: INTERMEDIATE

In the Inversion example, an incoming value (single-point indication) is inverted prior to transmission.
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[sc_Inversion, 1, en_US]

Figure 2-113 Example: Inversion

Chatter Blocking
The chatter blocking prevents system overload by using contact bouncing, that is, signal changes constantly
created by defective message generators. Each status change of the signal input is captured by a meter.
If the number of status changes within the configured check time is higher than the given number, the
respective input is blocked and the quality of the following messages is set to held.
After a defined block time, the blocked input is again checked for contact-chattering. If the input chatters
again, the block remains. This check is repeated cyclically as long as the input is blocked. When the input does
not show contact-chattering anymore when checked, it is released and the quality of the following messages
is set to valid.
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Table 2-8 Normalization: Chatter Blocking

Parameter Name Explanation
Chatter blocking Switches chatter blocking on (Yes) or off (No).

The chatter blocking can only be defined for a Digital input type and cannot be
assigned to Slave data points.

Check time [s] During this time the number of status changes of the input signal gets counted.
If the value set in Number of status changes is reached or exceeded during this
time, the respective input is blocked and the quality of further messages is set to
held within the time set in Block times.

Block time [s] During this time the transmission of messages and values is blocked to avoid
chatter.
After the block time is over the blocked input is checked again.

Number of status
changes

Maximum number of status changes during the time set in Check times.

[sc_Chatter_filter, 1, en_US]

Figure 2-114 Example: Chatter Filter

Assigning Normalization Procedures
A normalization procedure which you have previously defined and named can be assigned when mapping an
item of information.
To assign a normalization procedure in the Mapping view of an item of information:

• Select one of the normalization procedures available in the Normalization drop-down list box.
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[sc_Normalization_Procedures, 3, en_US]

Figure 2-115 Assigning Normalization Procedures

Supporting IEDs in Test Mode
Some communication protocols (for example IEC 61850) support the exchange of information marked as test
information. IEDs supporting and running in test mode use such protocols to:

• Exchange monitoring information marked as test information

• Accept only those commands marked as test information
The main focus in sending monitoring and control information marked as test information is to test and verify
whether the information sent/received serves its intended purpose.
SICAM PAS supports the routing of information items marked as test information both in monitoring
and command direction. Based on the protocol properties, the following SICAM PAS applications support
forwarding of test information through the system:

• IEC 60870-5-101 Master/Slave

• IEC 60870-5-103 Master (monitoring direction only)

• IEC 60870-5-104 Master/Slave

• IEC 61850 Client/Server
Additionally, the following applications support test mode:

• DNP3 Master/Slave

• Modbus Master/Slave

• PROFINET IO Master
Through the configuration in SICAM PAS, the information marked as test information can either be forwarded
or discarded. For example, it can be configured whether a command marked as test information (sent from
the control center using IEC 60870-5-104 protocol) can be forwarded as a normal command to an IED
connected with DNP3 Master or discarded.
From V8.18 onwards, test tagged information is handled from runtime using PAS UI Operation and UI Opera-
tion Client.

2.13
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[sc_PAS UI Operate, 1, en_US]

Master Applications Supporting Test Mode
The figure shows the behavior of the protocols:

• IEC 60870-5-101 Master

• IEC 60870-5-103 Master (only monitoring direction)

• IEC 60870-5-104 Master

• IEC 61850 Client

[dw_Test mode Master supporting test mode, 1, en_US]

Figure 2-116 Master Applications Supporting Test Mode

Users with IEC 60870-5-101 Slave and IEC 60870-5-104 Slave have the flexibility to forward/send test tagged
information with or without a set test bit. If the parameter is set to No, the test tagged information will be
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forwarded/sent without the test bit set. If the parameter is set to Yes, the test tagged information will be
forwarded/sent with the test bit set.

[sc_Forward Info with test tagged, 1, en_US]

Master Applications Not Supporting Test Mode
The figure shows the behavior of the protocols:

• DNP3 Master

• Modbus Master

• PROFINET IO Master

[dw_Test mode Master not supporting test mode, 1, en_US]

Figure 2-117 Master Applications Not Supporting Test Mode

Slave Applications Supporting Test Mode
The figure shows the behavior of the protocols:

• IEC 60870-5-101 Slave

• IEC 60870-5-104 Slave

• IEC 61850 Server
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[dw_Test mode Slave supporting test mode, 1, en_US]

Figure 2-118 Slave Applications Supporting Test Mode

Slave Applications Not Supporting Test Mode
The figure shows the behavior of the protocols:

• DNP3 Slave

• Modbus Slave

[dw_Test mode Slave not supporting test mode, 1, en_US]

Figure 2-119 Slave Applications Not Supporting Test Mode

Fault Records
Fault records from a device running in test mode connected via IEC 61850 Client can be visualized via the
Test mode data archive in SICAM PQ Analyzer.
If Block test information is disabled, the fault records are not saved.
Fault records from a device running in test mode connected via IEC 60870-5-103 Master are saved in the
configured archive.

Automation
SICAM PAS SoftPLC processes information marked as test information. If an automation block used receives
information marked as test information, the test information mark is also added to the output.

Human Machine Interface
Information marked as test information is forwarded to SICAM SCC as an operational information and is
visualized as usual.
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Other Applications
The routing of information marked as test information can not be configured for the following Master
applications:

• OPC Client

• PROFIBUS DP Master

• SINAUT LSA ILSA Master
 Information marked as test information is not routed in command direction.
 
The routing of information marked as test information can not be configured for the following Slave applica-
tions:

• OPC Server and OPC DA XML Server

• Telegyr 8979 Slave

• CDT Slave
 Information marked as test information is not routed in monitoring direction.

Reports
You insert the templates for scheduled reports in the Reports view. The reports include measuring data for
determining the network quality. Their contents can be freely defined.

ii NOTE
If you delete the PQS Scheduled Reports application, all the configured report templates are also deleted.

By using the PQS Automatic Notification application, you can define to be notified by e-mail on the comple-
tion of a report. For more information, refer to 2.6.16 PQS Automatic Notification.
For each template, you can define when a report is created, that is, Every day, Every week, Every month, or
Every year. Additionally, you have the option to insert diagrams.
Different examples for report template files are included in the scope of delivery of SICAM PAS/PQS. The report
template files are available under:

%PUBLICDOCUMENTS%Siemens\SICAM PAS PQS\ReportTemplatesScheduled.
In addition, you can create customized templates. For more information on the structure and contents of a
report template, refer to A.4 Report Templates.

Inserting a Generic Report Template

A generic report template allows you to configure the number of scheduled reports at once based on the valid
combinations of the selected measurement points, Grid Codes, and reporting period. This allows you to create
multiple report templates easily.
To insert a generic report template:
² In the Reports view, right-click the Generic report templates and select Generic report template from

the context menu.
The Insert - Generic report template dialog opens.

² In the Template file field, click ... to select the report template file.

² Select one or more measuring points, report generation intervals, and Grid Codes and click OK.
Based on the selection, individual report templates are created for each of the valid combinations of an
interval, a default measuring point, and a Grid Code.
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The automatic assignment of measuring points for each diagram will happen as follows:

• For measured data diagrams, the most relevant measuring group that is found first by matching the
corresponding measurement value type, characteristics, and phase will be assigned.

• For evaluated data diagrams, the selected measuring point will be assigned.

[sc_Insert Generic Report Template, 1, en_US]

Figure 2-120 Inserting a Generic Report Template

ii NOTE
If the scheduled report template consists of measured and evaluated diagrams, Siemens recommends you
assign the bay level as default measuring point/group for the report template.

Updating a Generic Report Template

To update a generic report template:
² In the Reports view, right-click the generic report template and select Update... from the context menu.

An Update dialog opens with all the current general parameter selections. You can modify any of these
parameters.

² Click OK.
The generic report template is updated accordingly.
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While updating a generic report template:

• New report templates are created according to the latest selection in the General parameters section.

• Existing report templates are updated based on the configuration changes, if it is required.

• If one or more combinations are removed from the General parameters section, the corresponding
report template is deleted.

ii NOTE
After the conversion of a project (created with a version ≤ V8.10) when you update a generic report
template for the first time, all the existing generic report templates are updated. On subsequent updates,
the system decides on its own whether the existing generic report templates require an update.

The generic report templates can be updated under the following conditions:

• 1 or more report generation intervals, measuring points, and Grid Codes are selected

• 1 or more report generation intervals, measuring points, and Grid Codes are deselected.

• Changes from the latest template file are adapted or a different template file is selected

• The existing template configuration has to be made consistent with the overall configuration of devices,
topology, templates, and Grid Codes.

[sc_Update the Generic Report Template, 1, en_US]

Figure 2-121 Updating Generic Report Template

Updating a Generic Report Template Affected by Changes in Other Views

Configuration changes made in other views may affect the existing generic report template configuration. In
this case, Siemens recommends you update the respective generic report templates.
You are notified via warning signs as follows to identify the generic report templates that require an update.
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[sc_Highlight, 1, en_US]

Figure 2-122 Notification for Generic Report Template

Updating a Generic Report Template when a New Version of Template File is
Available

If you are using a template file shipped by the product for the generic report templates, you are notified if a
new version of the template file is available.
To update the template file:
² In the Reports view, right-click the affected Generic report templates and select Update from template

file... from the context menu.

[sc_UpdatefromTemplatefile, 1, en_US]

Figure 2-123 Update from Template File

The generic report templates are updated with the new version of the template file available.

Inserting a Report Template

The report template file defines the general layout and the possible diagrams of the reports. It can be used as
a basis for different report templates.

2.14.4
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To insert a report template file:
² In the Reports view, right-click the Report templates and select Report template from the context

menu.
The Insert - Report template dialog opens.

² In the Template file field, click ... to select the report template file.

² Select the Default measuring point/group. After inserting the report template, this measuring point/
group is used as a default for all diagrams and can be later edited for each diagram individually.

If a measuring group is selected, it will be assigned for all the diagrams in the template as measuring point/
group.
If a measuring point is selected (for example, Bay, User defined group, Voltage level), the measuring point/
group assignment for diagrams will happen as follows:

• For measured data diagrams, the most relevant measuring group that is found first by matching the
corresponding measurement value type, characteristics, and phase will be assigned.

• For evaluated data diagrams, the selected measuring point will be assigned.

[sc_Insert_Rep_Temp, 2, en_US]

Figure 2-124 Inserting a Report Template

ii NOTE
All measuring groups of the devices which provide PQ measuring data can be selected, only if they have
been assigned to the topology. The measuring groups are created after the devices have been configured
and parameterized. For more information on measuring groups, refer to 2.9.3.4 Measuring Channels and
2.11.8 Recording Channels.
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² If evaluated diagrams are included in the report template file, select the Default Grid Code which can be
individually edited later.
For more information on the structure and contents of Grid Codes, refer to A.1 Structure of Grid Codes.

² Confirm with OK.
The report template file is inserted.

ii NOTE
You can also enable or disable automatic generation of a report template.

Editing a Report Template

In the report template, the measuring group (PQ device) and the Grid Code are defined separately for each
diagram. The report generation interval is also defined in the report template.

[sc_Editing_report_template, 1, en_US]

Figure 2-125 Report Template, Example

To edit a report template:
² In the General parameters input area, select the time interval for the report generation, for example,

every day or every week, from the Report generation list box.

² From the Default measuring point/group list box, select the measuring point/group for which you want
to enter measuring variables in the report.

² From the Default Grid Code list box, select the Grid Code whose limit values are used for checking the
PQ measuring data.

ii NOTE
When updating the report template file, the Default measuring point/group and the Default Grid Code
are assigned to all diagrams. If you need diagram specific measuring groups or Grid Codes, you can select
these accordingly.

2.14.6

Configuration
2.14 Reports

170 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



Creating Scheduled Reports Manually

The SICAM PQS – Scheduled Report Creation tool serves to manually create scheduled reports based on the
report templates. This tool allows you to verify the report templates created and create missing reports. The
reports created can be viewed using the tool or the Report Browser view of the SICAM PQ Analyzer.
To be able to use the SICAM PQS – Scheduled Report Creation tool, the following applies:

• The PQS Scheduled Reports feature must be enabled.

• A report template must have been created and the system must have been updated.
In order to be able to view the reports, the SICAM PQ Analyzer Standard license must be activated.
Existing reports will be overwritten. The overwritten reports will not be collected by the Collector.

Starting SICAM PQS – Scheduled Report Creation
Start the SICAM PQS – Scheduled Report Creation tool from the Windows Start menu.
² Click Start and scroll through the app list.

² Select SICAM PAS/PQS > Tools.
The Tools folder opens.
² Double-click Scheduled Report Creation.
The SICAM PQS – Scheduled Report Creation tool opens.
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[sc_Sch_Rep_Creat, 2, en_US]

Figure 2-126 SICAM PQS – Scheduled Report Creation Tool

How to Proceed
To manually create scheduled reports:
² In the Report template field, click ... to select the report templates which you have defined.

The Scheduled reports dialog opens.
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[sc_selectingreports, 1, en_US]

Figure 2-127 Selecting Report Templates

² Select the report templates for which you want to create the scheduled reports and click OK.
The Reporting period is displayed depending on the settings of the Report generation parameter defined in
the report template. It shows the time format (day, week, month, or year) of the report to be created.
² In the Start year field, select the first year from which the reports will be required.

If you select a yearly report template, the start month and the start day are pre-defined.

² In the Start month field, select the first month from which the reports will be required.
If you select a monthly report template, the start year can be entered, but the start day is pre-defined.

² In the Start day field, select the first day from which the reports will be required.
To create a daily report, the start year, start month, and start day must be selected accordingly.

A weekly report is created for the period from Monday to Sunday. If you select a weekly report template, the
Start day field only displays the dates of the Mondays. The Start year, Start month, and Start day must be
selected.
² To define the reports to be created, enter the Number of reports. Alternatively you can specify the last

reporting period for which you want a report to be created by selecting the corresponding dates in the
End date field.
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[sc_Month_selection, 2, en_US]

Figure 2-128 Defining Range of Recurrence

The reports which can be created within the defined period are displayed in the Available reports section.
The icon next to the report indicates its status.
Select/Deselect the Include empty diagrams check box to show/hide the empty diagrams in the reports to be
generated. By default the empty diagrams are not included. When you select Include empty diagrams, you
can verify the format of the report when a new report template is created.
The status icons have the following meaning:
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Icon Explanation
The following conditions are met:

• No limit violations within the period

• The data for the period is complete
The following conditions are met:

• No limit violations within the period

• An event occurs within the period
At least 1 limit violation has occurred within the period

The data for the period is not complete

If no icon is displayed, no report is available for the selected period.

² If you require just one report, click Create and open in order to create and display it.
If you require several reports, click Create reports.
To view a report on screen, double-click it in the Available reports section.
You can also generate additional reports while another report is already being created. The selected
reports will be added to the report generation queue.

While a report is being created, the Cancel button is available instead of the Exit button. Clicking Cancel
closes the tool after you have confirmed this action. The current report is finished; any further reports in the
waiting queue will be rejected.
² To exit the SICAM PQS – Scheduled Report Creation tool, click Exit.

Creating Fault Events Manually

ii NOTE
If the Fault Events feature is enabled, configured, and activated, fault event criteria are checked automati-
cally during runtime. Incoming fault record data for the previous 24 hours is considered in the fault event
creation.
The Fault Event Creation tool provides the possibility to manually start the fault event check and creation
especially in the following use cases:

• Additional devices are connected to SICAM PQS, which have fault records prior to the elapsed 24
hours.

• The device connection was interrupted for more than 24 hours and provides fault records which have
been created in the meantime.

• PQ archive (SICAM PAS/PQS) or Collector archive (SICAM PQ Analyzer) contains fault records from the
past, when the Fault Events feature was not available or not yet activated.

The SICAM PAS/PQS – Fault Event Creation tool is used to manually create fault events for the fault records
occurred during a selected time range. The created fault events are stored in the archive.
In this tool, you define the start and the end date for creating fault events with the Pre-trigger duration [s]
and the Post-trigger duration [s] time defined in the archive.
For information on creating fault events for a (Collector) archive, refer to /14/ SICAM PQ Analyzer, Incident
Explorer.
To be able to use the SICAM PAS/PQS – Fault Event Creation tool, the following applies:

• The Event List / Fault Events feature must be enabled.

• The Archive application including the Fault event Information must be configured, refer to
2.6.9.3 Configuring Fault Events.
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Starting SICAM PAS/PQS – Fault Event Creation
Start the SICAM PAS/PQS – Fault Event Creation tool from the Windows Start menu.
² Click Start and scroll through the app list.

² Select SICAM PAS/PQS > Tools.
The Tools folder opens.
² Double-click Fault Event Creation.
The SICAM PAS/PQS – Fault Event Creation tool opens.

[sc_Fault_Event_Creation, 1, en_US]

Figure 2-129 SICAM PAS/PQS – Fault Event Creation Tool

How to Proceed
To manually create fault events:
² Enter the start date and the end date into the corresponding input boxes.

- or -

² Select the specific period in the calendar.

ii NOTE
The Pre-trigger duration [s] and the Post-trigger duration [s] are taken from the values configured in the
Fault event information under the Archive application.

² Click Start.
The fault events for the specified time period are created and stored in the archive.

Grid Codes
The Grid Codes include normalized or customer-specifically defined limit values for checking measuring data.
Based on the limit value violations, SICAM PQS determines the PQ Index which provides a quick and concise
overview of the network quality.
The automatic flagging feature which is implemented as per the IEC 61000-4-30 standard is available for each
Grid Code to either enable or disable flagging. When flagging is enabled, measurements overlapping with
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voltage events are not evaluated against Grid Code limits. As a result, violation reports are generated only for
voltage events for that time range.
If there are PQ violations, you can define to be notified by e-mail and/or SMS by using the PQS Automatic
Notification application. For more information, refer to 2.6.16 PQS Automatic Notification.
The Grid Codes included in the scope of delivery and based on standards (for example, EN50160LV,
EN50160MV) cannot be modified. For Grid Codes which can be customized to meet customer-specific require-
ments, you receive a template which can be edited in the Grid Codes view. You will find the Grid Codes under
%publicdocuments%Siemens\SICAM PAS PQS\GridCodes.

Grid Codes View

In the Grid Codes view, you can do the following:

• Importing Grid Codes, Page 177

• Exporting Grid Codes, Page 178

• Updating Grid Codes, Page 178

• Modifying Grid Codes, Page 179

• Deleting Grid Codes, Page 179

Importing Grid Codes
To insert a Grid Code:
² In the configuration tree in the Grid Codes view, right-click Available Grid Codes and select Import from

the context menu.

[sc_Importing_Grid_Code, 3, en_US]

Figure 2-130 Importing a Grid Code

² Select the Grid Code in the dialog which opens.

² Select a Flagging option.
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[sc_Grid_Codes, 4, en_US]

Figure 2-131 Grid Codes

ii NOTE
For IEC TS 62749 Grid Codes, you have to manually set the Flagging option to Enabled (excluding
voltage).

• Disabled
All the limit violations (Period limits and Operational limits) are reported.

• Enabled (including voltage)
Limit violations within a voltage event time range are not reported, even not for voltage limit violation.

• Enabled (excluding voltage)
Voltage limit violations only are reported within a voltage event time range.

Exporting Grid Codes
If you have modified the limit values of a Grid Code, you can export the Grid Code.
To export a Grid Code:
² In the navigation window, right-click the Grid Code and select Export from the context menu.

² In the dialog which opens, enter the name and the storage path of the Grid Code.
You can re-import the exported Grid Code, for example, as a template for further Grid Codes, or import it into
another SICAM PAS/PQS system.
If an archive includes data from several PAS/PQS Systems, the Grid Code specific evaluations can only be
performed by using both the systems if the same Grid Code has been used for evaluation.

Updating Grid Codes
If you have modified the limit values of a Grid Code used, you can update the Grid Code.
To update a Grid Code:
² In the navigation window, right-click the Grid Code and select Update from the context menu.

² In the dialog which opens, select the name and the path of the Grid Code which you want to update.
After the update, the PQ measuring data is evaluated with the modified limit values.
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Modifying Grid Codes
For modifiable Grid Code templates, you can customize the parameters defined in the input area in order
to meet project-specific requirements. Changes to the Grid Code structure or the definition of additional
parameters are not possible. For more information on the structure and contents of a Grid Code, refer to
A.1 Structure of Grid Codes.
To modify the parameters of a Grid Code template:
² In the configuration tree, select the area of the Grid Code which you want to modify.

² Enter the new values in the different input areas. for example, you can modify limit values, activate or
deactivate rules or modify time specifications.

[grid_code_bearbeiten, 4, en_US]

Figure 2-132 Modifying a Grid Code

Deleting Grid Codes
If you have not assigned a Grid Code to any topological structure, you can delete the Grid Code.
To delete a Grid Code:
² In the navigation window, right-click the Grid Code and select Delete from the context menu.
However, the evaluation results for the deleted Grid Code are available for analysis in SICAM PQ Analyzer (PQ
Explorer, PQ Inspector, and Report Browser). If the evaluation results are still available in the archive for a
deleted Grid Code, the respective Grid Code is displayed in brackets in the Grid Code view.

Topology View

In the Topology view, you can assign the individual topological levels up to 4 Grid Codes.
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[sc_Assigning_Grid_Codes_Topology, 4, en_US]

Figure 2-133 Topology View, Assigning Grid Codes

If you have assigned the measuring groups to the topological levels, the Grid Codes view shows for each Grid
Code which PQ measuring data items are evaluated with which Grid Codes.
The assignment can only be modified in the Topology view.
² In the configuration tree in the Grid Codes view, select the name of a Grid Code.

The assignments are displayed in the right-hand section.
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[sc_Grid_Code_Assigned_Topological, 4, en_US]

Figure 2-134 Grid Code with Assigned Topological Levels

Reevaluating PQ Data

The SICAM PAS/PQS – PQ Data Reevaluation tool allows you to update all evaluation results caused by the
following changes:

• A new Grid Code has been assigned.

• A rule/limit has been changed in an existing Grid Code.

• The assignment of measuring groups has been changed.

• The topological structure has been changed.
The PQ data is reevaluated depending on the start date and the Grid Codes selected. PQ Index and PQ violation
reports are generated depending on the new configuration in SICAM PAS/PQS UI – Configuration.
To be able to use the SICAM PAS/PQS - PQ Data Reevaluation tool, the following applies:

• The PQS Grid Code Evaluation feature must be enabled.

• The archive must be configured and started on the system on which the SICAM PAS/PQS – PQ data
reevaluation is running.

• At least 1 Grid Code and one measurement group must be configured and assigned to a topology.

• For redundant systems SICAM PAS/PQS – PQ Data Reevaluation must be opened on the system config-
ured in the left-hand section of SICAM PAS/PQS UI – Configuration.

• The archive must contain historical data, otherwise reevaluation is not possible.

Starting SICAM PAS/PQS – PQ Data Reevaluation
Start the SICAM PAS/PQS – PQ Data Reevaluation tool from the Windows Start menu.
² Click Start and scroll through the app list.
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² Select SICAM PAS/PQS > Tools.
The Tools folder opens.
² Double-click PQ Data Reevaluation.
The SICAM PAS/PQS – PQ Data Reevaluation tool opens and displays the Grid Codes configured.

Reevaluating PQ Data

² Select the Start date for PQ data reevaluation from the Calendar.

[sc_Select_start_date, 1, en_US]

Figure 2-135 Selecting the Start Date

² Select the Grid Codes for reevaluation.

² Click Reevaluate.
The reevaluation progress for each Grid Code is shown.
All the dates between the selected start date and the current date are reevaluated.

Canceling the Reevaluation
While reevaluating PQ data the Exit button is replaced by the Cancel button.
² Click Cancel.

The Canceling the PQ data reevaluation dialog opens.

² Click Yes to cancel the reevaluation.
- or -

² Click No to continue the reevaluation.
If you open the tool once again after canceling a reevaluation, the previously defined start date is shown.
The Grid Code for which the reevaluation has not been completed successfully remains selected in order to
avoid an inconsistent archive.
The Grid Codes for which no reevaluation has been started or for which the reevaluation has been successfully
completed remain deselected.
The Grid Codes and the start date can be modified.
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ii NOTE
Canceling the reevaluation leads to an inconsistent archive. The following applies in order to avoid incon-
sistencies in the archive when opening the tool:

• The start date remains unchanged or is older than the start date defined.

• The automatically selected Grid Code is not deselected.

Certificates
For the DNP3 Master/Slave, IEC 60870-5-104 Master/Slave, and IEC 61850 Server/Client protocols, the data
can be transmitted in encrypted format. The certificates required for this purpose are added in the Templates
view.
The function can only be used if you have enabled the Secure Communication feature.
The certificate store includes the following areas:

• Protocol related to add DNP3 and IEC 60870-5-104 protocol certificates
– Certificate Store with user certificates
– Certificate Authority Store with root certificates
– Certificate Revocation Store with invalid certificates

• EST communication can be manually created to add EST protocol certificates
– Client Certificate with EST client cerificate
– EST Certificate Authority with EST Certificate Authority certificate

For more information, refer to /8/ SICAM PAS/PQS, Security.
For more information on EST communication, refer to /24/ SICAM GridPass V1.30, Manual.

Adding Protocol Related Certificate

² Select the Templates view.

² Select Certificates > Protocol related.

² Insert the Certificate Store, the Certificate Authority Store, and the Certificate Revocation Store one
after the other.
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[sc_Certificate Store, 5, en_US]

Figure 2-136 Certificate Store

² Right-click Certificate Authority Store and select Open... from the context menu.
The Certificate Manager opens.

² Insert the root certificates. The function is protected by a password.

² Right-click Certificate Revocation Store and select Open... from the context menu.
The Certificate Manager opens.

² Insert all invalid certificates. The function is protected by a password.

² Right-click Certificate Store and select Open... from the context menu.
The Certificate Manager opens.

² Insert the user certificates for the protocols.

² Enter the password with which the private key is protected in the certificate.
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[sc_Inserting_Certif, 1, en_US]

Figure 2-137 Inserting Certificates

Configuring EST Communication

² Select the Templates view.

² Right-click Certificates and select EST communication from the context menu.
The Insert EST Communication dialog opens.
² Enter the IP address and Port of the EST server under EST Communication parameters.

² Optionally, enter a description for the Client Certificate Parameter and the EST Certificate Authority
Parameter.
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[sc_EST_Properties, 2, en_US]

Figure 2-138 Inserting EST Communication Certificate

² Insert the Client Certificate and the EST Certificate Authority.

[sc_EST_Certificate, 2, en_US]

Figure 2-139 EST Certificates

² Right-click Client Certificate and select Open... from the context menu.
The Certificate Manager opens.

² Insert the client certificate. The function is protected by a password.
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[sc_Inserting_EST_cert, 1, en_US]

Figure 2-140 Inserting EST Certificates

² Right-click EST Certificate Authority and select Open... from the context menu.
The Certificate Manager opens.

² Insert the EST certificate authority certificate.

Assigning Certificates

² Open the Configuration view.

² For the DNP3 Master and IEC 60870-5-104Master applications, select the corresponding Device.
- or -

² For the DNP3 Slave, IEC 60870-5-104 Slave, and IEC 61850 Server/Client applications, select the
corresponding Interface.

² Under Security – TLS encryption in the Activate TLS encryption list box, select whether you want to
use an imported certificate or EST for secure communication.
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[sc_Assigning_Certif, 6, en_US]

Figure 2-141 Assigning a Certificate

ii NOTE
The IEC 61850 protocol supports only EST communication.
The IEC 61850 client supports TLS and A-Profile using EST Communication.

² If you select With imported certificates, click ... in the Local certificate and private key field.
In the Select certificate dialog that opens, select the certificate.
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[sc_select-cert, 1, en_US]

Figure 2-142 Select Certificate

² If you select With EST communication, insert the Client Certificate and the EST Certificate Authority in
the Templates view under EST communication.

Authentication
For the DNP3 Slave and DNP3 Master protocols, you can define a specific authentication for each command.

ii NOTE
The Authentication function without encryption can also be configured for serial connections. When
setting up a TCP/IP connection without encryption, make sure that the connection is secure.

To do this, you create the corresponding users and a default user in the User Administration.
² In the input area of the Configuration view, enter a default user for the interface under Security

Authentication.

² In the Mapping view, select - for the information of the control center in the DNP User column - users
with switching permissions for each command.

For more information on User Administration, refer to 6.1 Starting User Administration and the online help of
the User Administration.
For more information on security measures in SICAM PAS/PQS, refer to /8/ SICAM PAS/PQS, Security.
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SICAM System Outputs

Report

Report logs of import and update procedures in SICAM PAS/PQS can be found in the Report.

[sc_report, 2, en_US]

Figure 2-143 Report

Tabs
If you have installed several software products from the SICAM family on your system, all of them are
displayed in the Report dialog.
A separate tab is available for each SICAM software component.
The Overview tab provides a summary of the protocols of all tabs.

Status Icons
The icons displayed to the left of the text explanations in the rows of the log highlight the status of the log
rows:

 Standard information (white-blue), for example, procedure completed

 Warning (yellow-black), for example, parameter not required

 Problem occurred (red-white), for example, severe error

 Rotating icon (black-white), process in progress

Opening the Report
The Report starts automatically as soon as an import or update has been initiated.

2.18
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You can also open the dialog manually (View > Report).

Buttons of the Report Dialog
To print the log displayed in the dialog:
² Click Print.

To save the log displayed in the dialog:
² Click Export.
² Select a directory path for saving the note texts.

To delete the log displayed in the dialog:
² Click Delete.
Only the log displayed in the currently active tab card is deleted.

To delete the log summary:
² Click Delete all.
All logs (that is, all tabs and the log summary shown in the Overview tab) are deleted.

To close the Report:
² Click Close.
The dialog closes. All messages and notes shown in this dialog are saved and will be available when the dialog
is opened again.

Windows Event Viewer

The SICAM PAS/PQS runtime components store diagnostic entries (warnings and errors) in the Windows event
log. These entries can support you in finding the causes of errors.
To read the entries out of the Windows Event Viewer:
² Click Start, type eventvwr and confirm by pressing <Enter>.
The Event Viewer opens.
Under Windows Logs > Application, the warnings and error messages are displayed under the name of the
runtime component.

2.18.2
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[sc_eventlog, 3, en_US]

Figure 2-144 Windows Event Viewer, Example

Security-related logs, for example, user login/logout, start/stop of system components, modifications in the
archive (import records, import PQDIF, delete records, delete reports, add or edit traffic lights), are displayed
under Applications and Services Logs in the PASSecurity and PQ Analyzer Security folders.

[sc_eventlog_security, 2, en_US]

Figure 2-145 Windows Event Viewer, Security-Related Events

For a list of possible events, refer to A.16 Security-Related Messages.
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Consistency Check

Before you start the SICAM PAS/PQS runtime, you can validate the current configuration. The scope of the
consistency check functionality is expanded gradually.
To start the consistency check:
² Click Consistency check... from the Tools menu.
The consistency check results are displayed in the Report.

[sc_Consistency Check, 2, en_US]

Figure 2-146 Consistency Check

² For more detailed information, click the link at the end of the Consistency check tab.
An HTML file opens providing the following information:
– Inconsistencies detected
– Path to the corresponding inconsistency
– Steps to troubleshoot the corresponding inconsistency

2.18.3
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[sc_HTMLreport, 1, en_US]

Figure 2-147 HTML File Providing Detailed Information

Documenting a Project
The following functions are available for the documentation of your configuration and parameterization:

• 2.19.1 Station Documentation

• 2.19.2 Printing

• 2.19.3 Project Statistic

Station Documentation

² Click File > Station documentation > Print.

2.19

2.19.1
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[sc_Station_Documentation, 1, en_US]

Figure 2-148 Station Documentation Selection Dialog

² In the Station documentation dialog, select which parts of your configuration you want to print.

² Select whether you want to print out the data on paper or save it in the HTML or XML format.
You can display your configuration via Station documentation > Print preview....

ii NOTE
If more than 3000 pages are to be printed, select lesser views for printing.

Printing

The print function allows you to print your SICAM PAS/PQS project data on paper or save it in multiple formats,
for example, PDF.
The active section is printed. If you have for example, highlighted an element in the configuration tree, the
function prints the configuration tree.

How to Proceed
The SICAM PAS/PQS print function consists of the following steps:

• Print, Page 195

• Print Preview, Page 196

Print
To set up the printer:
² Select File > Print.
² Select the printer and the printer settings in the dialog that opens.

2.19.2
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Print Preview
To show a print preview and print the display contents:
² Select the section (for example, the configuration tree) which you want to display in the print preview.

² Select File > Print preview....
A page view of the currently possible print output is shown on screen.

² To print the display, click Print.
In the print preview, you can set up the page, page up or down, enlarge or minimize the view and define
settings of the page preview.

Project Statistic

The project statistic serves for analyzing your project’s configuration and displays a summary of the following
project data:

• Total number of devices and control centers

• Total number of master data points

• Total number of slave data points

• Total number of data points mapped, but not used

• Total number of license-relevant data points.
For each level of the configuration tree, you can also see how many items of information are available and
mapped, and how many items of information are not used. In Master and Slave applications, the columns
have a different significance.
Application Available Mapped Unused
Master Number of available data

points
Number of data points selected
in the Mapping view, Use
column

Number of data points selected
in the Use column, but not yet
mapped to a Slave application

Slave Number of data points of
the Master applications
selected in the Mapping
view, Use column,
including system values

Number of Slave data points
highlighted in the Mapping
view, Use column

0

For more information on how to use and map the data points, refer to 2.4.4 Mapping.
The following applications are considered for counting the license-relevant data points:

• IEC 61850 Client

• IEC 60870-5-103 Master

• IEC 60870-5-104 Master (also SICAM MIC Master)

• IEC 60870-5-101 Master

• DNP3 Master

• Modbus Master

• PROFIBUS DP Master

• SINAUT LSA ILSA Master

• SICAM Q80 Master

• SIMEAS R Master
The data points of the following applications are not considered:

2.19.3

Configuration
2.19 Documenting a Project

196 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



• SNMP

• SoftPLC (Automation)

• OPC Client

• Digital I/O (SICAM Station Unit)
For the SICAM SCC Slave applications (switching authority values are not displayed in SICAM PAS/PQS UI –
Configuration) and SoftPLC (individual SoftPLC values are not displayed in SICAM PAS/PQS UI – Configuration),
inadequately high values might be displayed for the number of available information for system reasons.

[sc_sicamPAS05, 2, en_US]

Figure 2-149 Project Statistics

Export
The data of the project statistic is exported in the following data formats:

• stat
Data exchange format of the Project Statistic Viewer

• txt
Text file for further processing in Excel. The text file includes a list of data separated by commas.
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Import
For diagnostic purposes, you can import a stat file in the Project Statistic Viewer.

SICAM PQS – Easy Configuration
The SICAM PQS – Easy Configuration tool simplifies the process of configuring a SICAM PAS/PQS project. This
project can be used as-is or modified further using SICAM PAS/PQS – UI Configuration thus reducing the total
amount of time spent in creating a project.
SIPROTEC devices and 3rd party devices which communicate via the IEC 61850 Client application are scanned.
If the scanned devices are SIEMENS power quality devices like SICAM P855, SICAM Q100, and SICAM Q200,
then the IID files are automatically downloaded from the devices and imported into the project. For all
other types of scanned devices, IID files which contain minimal entries like the device name, OSI protocol
parameters, a logical node and a logical device, and the device type are created and imported into the project.

ii NOTE
To be able to download an IID file, the self-signed certificates of the device must be added to the Web
browser.
For more information refer to the Trusting Self-Signed Certificates in Browsers application note
which can be downloaded from https://new.siemens.com/global/en/products/energy/energy-automation-
and-smart-grid/grid-security.html.

Additionally, you can select the following features which are imported into the project:

• Grid Codes

• PQS Scheduled Reports

• PQS Automatic Export

• Archive
By automatically importing Grid Codes, creating the Topology assignments based on the PQ devices and
generating report templates, the tool reduces the effort for the data engineer. Also, it is not required to have
an in-depth knowledge about SICAM PAS/PQS configuration techniques for using these basic SICAM PAS/PQS
features.

Starting SICAM PAS/PQS – Easy Configuration
Start the Easy Configuration tool from the Windows Start menu.

• Click Start and scroll through the app list.

• Select SICAM PAS/PQS > Tools.
The Tools folder opens.

• Double-click Easy Configuration.

2.20
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[sc_EasyConfiguration, 2, en_US]

Figure 2-150 SICAM PAS/PQS – Easy Configuration

Custom Scheduled Report Template Naming Guidelines
The report templates that are created manually are available for configuring in SICAM PAS/PQS – Easy Config-
uration. The creation of report templates is skipped in SICAM PAS/PQS – Easy Configuration if the report
template name is not compatible with the Grid Code name.
For example, report template is not created for the combination of EN50160 report template file and IEC
61000 family of Grid Codes.
When creating a report template, the name of the report template file should start with the Grid Code file
name for the valid combination.
For example, if the report template is created for EN50160 standard, Low voltage and Star connection, the
valid standard Grid Code file name is EN50160-Delta-LV. Therefore, the report template file name should start
with EN50160-Delta-LV.
You can have any text or identifier separated by a dot (.). The report template file name is read till the
separator (.) and it will be compared with the Grid Code file name to check the compatibility.
Following table is an example of custom report template names and their corresponding Grid Codes for which
report templates can be created using SICAM PAS/PQS – Easy Configuration.
Report template file name Compatible Grid Codes in SICAM PAS/PQS – Easy

Configuration
EN50160-Star.CutomReportTemplate.txt EN50160-Star-MV, EN50160-Star-LV
IEC61000-Star-Class1.txt IEC61000-Star-Class1
IEC61000-Delta-Class1.txt IEC61000-Delta-Class1
UserDefined_EN50160.CustomReportTemplate.txt UserDefined_EN50160HV, UserDefined_EN50160LV,

UserDefined_EN50160MV
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Report template file name Compatible Grid Codes in SICAM PAS/PQS – Easy
Configuration

New report template.txt None
EN50160_NewTemplate.txt None

For more information on configuration options and the workflow, refer to the SICAM PAS/PQS – Easy Configu-
ration online help.

Working with COMFEDE Logs
Common Format for Event Data Exchange (COMFEDE) for Power Systems

This standard defines a common format for the data files needed for the exchange of various types of power
system events in order to facilitate event data integration and analysis from multiple data sources and from
different vendor devices. This feature enables you to download and view COMFEDE logs from the IEC 61850
devices which will make it easier to integrate and analyze different types of event data.

Configuring COMFEDE Logs

To use this feature, you must configure the following 2 parameters:

• COMFEDE record directory

• Activate COMFEDE record transmission

COMFEDE Record Directory
This parameter determines the location where the COMFEDE log is stored in the system.
The default storage path is C:\ProgramData\Siemens\SICAM PAS PQS\Persistent. The COMFEDE file is saved
as "<computer>_<application>_<interface>_<device>.ced". For example, DESKTOP-CMRAD8Q_IEC 61850
Client_Interface1_E1Q1SB1.

[sc_COMFEDE record directory, 2, en_US]

Figure 2-151 COMFEDE record directory

Activate COMFEDE Record Transmission
If this parameter is set to Yes, SICAM PAS will automatically download the COMFEDE log from a device (any
device under the interface) whenever the $ST$RcdMade value is set to high for the device, also when a
device is initiallly connected. By default, the value is set to No.
(Value range: Yes, No)
(Default value: No)
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[sc_Activate COMFEDE record transmission, 2, en_US]

Figure 2-152 Activate COMFEDE record transmission

Downloading/Viewing COMFEDE Logs

ii NOTE
This feature is supported only for IEC 61850 Client Protocol.

This feature is used to download the COMFEDE logs manually for all the devices within the selected interface
or the selected device.
To download or view COMFEDE logs:
² Select an interface or the device in the configuration tree.

² In the Status section, next to COMFEDE Log, click Download to download the COMFEDE log.

- or -

2.21.2
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² Click View to view the COMFEDE log.

Configuring COMFEDE Client

COMFEDE client enables to download COMFEDE logs from multiple devices.
The logs can be downloaded using a batch file or a ComfedeClient.exe file.
To download the logs using a batch file:
² Go to Start in Microsoft Windows, use the Run command and enter %pas_bin%ui.

² Click OK.
The File Explorer opens.
² Now run the Command Prompt from this folder.

² Enter ComfedeClientLaunch.bat to launch the batch file.
The following values are displayed:

• 1: if the download is successful

• -100: No connection with PAS runtime

• -200: Download not completed

• -300: User is not a member of the SICAM PAS PQS Users user group

2.21.3
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² To display the Commands and the Return Codes, type ComfedeClient.exe ? in the command
prompt.

Once the operation of COMFEDE client is completed, the file containing the summary of the logs is created in
the same location as the COMFEDE logs.

ii NOTE
Also, if one of the devices fails while downloading the logs, the COMFEDE client will still download the
logs for the rest of the devices. Downloaded logs are stored in the same location as the COMFEDE record
directory: C:\ProgramData\Siemens\SICAM PAS PQS\Persistent.
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Operation

This chapter explains how to use SICAM PAS/PQS UI – Operation.
SICAM PAS/PQS UI – Operation provides you with an overview of the runtime status of your station. The
configuration is displayed in the tree structure. The different colors show the status of interfaces, devices, and
other applications.
With SICAM PAS/PQS UI – Operation you activate and deactivate individual components, set a bay block
or telecontrol block and also update device information. In redundant systems, you see which component
is active. SICAM PAS/PQS UI – Operation allows you to switch over individual components, for example, the
interface for the data traffic to devices or control centers.
With SICAM PAS/PQS UI – Operation Client you can start and stop all redundant connections independently
from each other. SICAM PAS/PQS UI – Operation Client provides the functions of SICAM PAS/PQS UI – Opera-
tion from a local computer or a remote computer with improved performance by an Internet browser.
For the diagnosis of pending faults, useful notes on possible fault causes are displayed.
3.1 Requirements for SICAM PAS/PQS UI – Operation Client 205
3.2 Starting SICAM PAS/PQS UI – Operation and SICAM PAS/PQS UI – Operation Client 213
3.3 Working with SICAM PAS/PQS UI – Operation and SICAM PAS/PQS UI – Operation Client 216
3.4 Redundancy 220
3.5 Controlling Connections 222
3.6 GOOSE Status Monitoring 225
3.7 Operating State 226
3.8 Archive Activity Monitor 228

3
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Requirements for SICAM PAS/PQS UI – Operation Client
Internet Browser

To access SICAM PAS/PQS UI – Operation Client, Siemens recommends you use the latest versions of the
following browsers:

• Firefox

• Chrome

• Internet Explorer

• Microsoft Edge

ii NOTE
To run SICAM PAS/PQS UI – Operation Client on Internet Explorer 9 or 10, you must download a
KB2888505 patch from http://technet.microsoft.com/en-us/security/bulletin/ms13-088, according to the
operating system and execute it.

Enabling JavaScript
To access SICAM PAS/PQS UI – Operation Client, JavaScript must be enabled in the browser.
To enable JavaScript in Internet Explorer:
² Select Internet options from the Tools menu.
The Internet options dialog opens.
² In the Security tab, select Internet and click Custom level... in the Security level for this zone section.
The Security Settings - Internet Zone dialog opens.
² In the Settings section, activate Active Scripting below the Scripting topic.

² Click OK to apply the selected settings and exit the Security Settings - Internet Zone dialog.

² Click OK in the Internet Options dialog.
JavaScript is enabled.
To enable JavaScript in Firefox:
² Click Firefox from the toolbar and select Options/Settings from the Options menu.
The Options dialog opens.
² Select the Content tab.

² Enable JavaScript.
² Click OK.
JavaScript is enabled.

ii NOTE
From Firefox V22 the JavaScript is always enabled.

To enable JavaScript in Chrome:
² Click the Customize and control Chrome icon.
The Settings dialog opens.
² Click Show advanced settings....
The advanced settings are displayed.
² Under Privacy click Content settings....
The Content Settings... dialog opens.

3.1
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² Under JavaScript enable Allow all sites to run JavaScript (recommended).
² Click Done.
JavaScript is enabled.
To enable JavaScript in Microsoft Edge:
² Click Start and enter gpedit.msc.
The Local Group Policy Editor dialog opens.
² Click Local Computer Policy > Computer Configuration > Administrative Templates > Windows

Components > Microsoft Edge.

² In the Microsoft Edge section, double click the option Allows you to run scripts, like Javascript.

² In the dialog which opens, select Enabled and click OK.
JavaScript is enabled.

Viewing the Online Help Content
Due to security aspects, the operating system deactivates the displaying of CHM files. If only the navigation
structure in the left frame of a Windows online help file (CHM) is shown, but not the content in the right
frame, this probably results from a Microsoft security update.
The additional Windows registry key MaxAllowedZone has to be added to determine the desired security
zone in order to view the online help correctly. To do this:
² Double-click the MaxAllowedZone.reg file located in the <path>\RegFiles directory of the SICAM

PAS/PQS DVD. The <path> corresponds to the letter of your DVD drive.
The MaxAllowedZone value is set to 4, that means the security zone Limited Sites is permitted.

For more information, refer to Microsoft report KB896054, http://support.microsoft.com/kb/896054.

ii NOTE
To use SICAM PAS/PQS UI – Operation Client, the logged in or active user must be a member of the
PASRuntimeUser group.

Required Settings for Internet Explorer
To view SICAM PAS/PQS UI – Operation Client in Internet Explorer:
² Select Compatibility View Settings from the Tools menu.
The Compatibility View Settings dialog opens.
² Uncheck the Display intranet sites in Compatibility View option and click Close.
You can view SICAM PAS/PQS UI – Operation Client.

ii NOTE
This setting is not applicable in Firefox and Chrome.

Required Settings for Microsoft Edge
To view SICAM PAS/PQS UI – Operation Client in Microsoft Edge:
² Click Startand enter Internet Options.
The Internet Properties dialog opens.
² In the Security tab, click the Local intranet option and click Sites.
The Local intranet dialog opens.
² Select Automatically detect intranet network and click OK.
You can start the SICAM PAS/PQS UI - Operation Client from the Start menu to open via Microsoft Edge.
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Validating Security Certificates
For Internet Explorer and Firefox, the security certificates must be validated on the first access of SICAM
PAS/PQS UI – Operation Client.

ii NOTE
Chrome validate certificates issued by third party only and not other certificates, hence to which the https
text in the address bar will appear to be struck off.

To import the security certificate to Internet Explorer:
² Click the lock icon in the address bar.
The Website Identification dialog opens.

[sc_Web_Identification, 1, en_US]

Figure 3-1 Website Identification

² Click View certificates from the dialog.
The Certificate dialog opens.
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[sc_Certificate, 2, en_US]

Figure 3-2 Certificate

² Click Install Certificate….
The Certificate Import Wizard dialog opens.
² Select Current User from the list box and click Next.
² Select Place all certificates in the following store and click Browse….
The Select Certificate Store dialog opens.
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[sc_Cert_Store, 2, en_US]

Figure 3-3 Select Certificate Store

² Select Trusted Root Certification Authorities from the list box, click OK, and click Next.
² Select Certificate Store Selected by User from the list box and click Finish.
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[sc_Importing_Certificate, 2, en_US]

Figure 3-4 Importing Certificate

² Confirm the The import was successful message with OK.
The certificates are imported successfully.
² Click OK, to exit the dialog.

Downloading Files Using Internet Explorer 9 on Windows Sever 2008
To use a secure site (for example, SICAM PAS/PQS UI – Operation Client) or download files from the site using
Internet Explorer 9 on Windows Server 2008:
² Select Internet options from the Tools menu.
The Internet Options dialog opens.
² Select the Advanced tab.

² In the Security section, deselect the Do not save encrypted pages to disk check box and click OK.
You can view SICAM PAS/PQS UI - Operation Client and download the CHM help file.
For more information, refer to Microsoft report, http://support.microsoft.com/kb/2549423.
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Changing Date/Time Format
If you have changed the date/time format of the operating system, you must change these formats accord-
ingly in the Internet Information Services (IIS), to have the data displayed in the same format.
To change the date/time format:
² Click Start and enter IIS.
The Internet Information Services (IIS) Manager window opens.
² In the Connections section, select SiemensEnergy in the Sites folder.
The SiemensEnergy Home section is displayed.

[sc_SiemensEnergy_Home, 2, en_US]

Figure 3-5 SiemensEnergy Home Section

² Double-click .NET Globalization.
The .NET Globalization section is displayed.
² Select the preferred Culture and UI Culture from their respective list box.

ii NOTE
Select the country specific culture and not the neutral culture from their respective list box.

² In the Actions section, click Apply.
The date/time format is saved.
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[sc_NET_Global, 2, en_US]

Figure 3-6 .NET Globalization Section

² Close the Internet Information Services (IIS) Manager window.

² Restart the system.
The date/time format is changed.

Enabling Windows Security for Internet Explorer on Windows 8.1 or Windows Server 2012 R2
To enable the Windows Security dialog:
² Select Internet options from the Tools menu.
The Internet Options dialog opens.
² In the Security tab, select Local intranet and click Custom level... in the Security level for this zone

section.
The Security Settings - Local Intranet Zone dialog opens.
² Select Prompt for user name and password in the User Authentication section.
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[sc_Security_settings_Local_Intranet_zone, 2, en_US]

Figure 3-7 Security Settings

² Click OK to confirm.

Starting SICAM PAS/PQS UI – Operation and SICAM PAS/PQS UI –
Operation Client

Starting SICAM PAS/PQS UI – Operation
Start SICAM PAS/PQS UI – Operation by using the Windows Start menu:
² Click Start and scroll through the app list.

² Select UI - Operation from the SICAM PAS/PQS folder.
SICAM PAS/PQS UI – Operation opens and the current station configuration is displayed.

3.2
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[sc_Sicam_Operation, 2, en_US]

Figure 3-8 SICAM PAS/PQS UI – Operation

The configuration tree displays the station's configuration in the structure in which it has been set up in SICAM
PAS/PQS UI – Configuration.
The Status section shows the current status of the connection, which you have selected from the configura-
tion tree.
In the Redundancy state section, you can see which of the redundant components is active.
The Errors section displays information which supports you in determining the cause of the problem.

Starting SICAM PAS/PQS UI – Operation Client
On a computer with a SICAM PAS/PQS installation start SICAM PAS/PQS UI – Operation Client by using the
Windows Start menu:
² Click Start and scroll through the app list.

² Select UI – Operation Client from the SICAM PAS/PQS folder.
SICAM PAS/PQS UI - Operation Client opens and the current station configuration is displayed.
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[sc_Operation_Client, 1, en_US]

Figure 3-9 SICAM PAS/PQS UI – Operation Client

The configuration tree displays the station's configuration in the structure in which it has been set up in SICAM
PAS/PQS UI – Configuration.
The Status section shows the current status of the connection, which you have selected from the configura-
tion tree.
In the Redundancy state section, you can see which of the redundant components is active.
The Errors tab displays information which supports you in determining the cause of the problem.
The Report tab displays the report logs of procedures in SICAM PAS/PQS runtime

Starting SICAM PAS/PQS UI – Operation Client on a Remote Desktop
On a computer without a SICAM PAS/PQS installation start SICAM PAS/PQS UI – Operation Client entering the
required URL in an Internet browser.
² Open a browser.

² In the address bar, enter the name of PAS/PQS computer and the name of the application as follows:
https://computername/PASOperateClient/.
The Windows Seurity dialog opens.

Operation
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[sc_Authentication, 1, en_US]

Figure 3-10 Authenticating User

² Enter the SICAM PAS/PQS User Name and Password to access SICAM PAS/PQS UI – Operation Client.

ii NOTE
In Internet Explorer 10, if you are not able to select the components in the configuration tree, proceed with
the following steps:

• Enter the following URL in the address bar:
http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=2600100&kbln

• Click Show hotfixes for all platforms and languages (7).

• Request for the hotfix according to the operating system and the platform.

• Install the hotfix that is sent to your e-mail address.

Working with SICAM PAS/PQS UI – Operation and SICAM PAS/PQS
UI – Operation Client
The following sections explain how to work with SICAM PAS/PQS UI – Operation and SICAM PAS/PQS UI –
Operation Client.

Updating the Display

Updating the View
Updating view is used to view the newly added devices, interfaces, and applications in the user interface. For
example, inserting a device is indicated by a red icon on the left of the project name. This icon is also shown
for the initial parameterization of the project. The Current state of the project which is displayed in the Status
section changes to The view must be updated.
The Update view function can be executed on the project level.
To update the view:
² Select the project in the configuration tree.

² Click Update view in the Status section (in SICAM PAS/PQS UI – Operation).
- or -

² Press <F5> (in SICAM PAS/PQS UI – Operation Client).

3.3
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The configuration tree is displayed according to the last changes.

Updating the System
In the configuration tree, the icon on the left shows the status of each component. Updating system is used to
transfer the current state of the configuration to the runtime system.
The Update system function must be carried out upon the initial system configuration and to update any
changes in the configuration.

ii NOTE
Clicking Update system stops and restarts the whole system.

² Select the project in the configuration tree.

² Click Update system in the Status section.
The system update is logged in the Report. If you update the system for the first time, you are prompted in
the Report to restart the Full Server and all DIPs connected.

Activating the Changes
After changing parameters in the configuration, for example, the baud rate of an interface, click Activate
changes to apply the changes.
Changes to the configuration data can be activated on the following levels:

• Project

• Application

• Interface/Device group
To update the configuration:
² Select a level in the configuration tree.

² Click Activate changes in the Status section.
The function is not available in redundant configurations. In this case, changes are activated by using the
Update system function With database copy enabled.

Updating a Device

After an interruption of the communication with a device, you have different options to update the display of
the operating state:

• Refresh

• Activate GI
To update a device:
² Select a device from the configuration tree.

Refreshing the Status

² Click Refresh in the Status section.
The device information is updated from the internal image.

Activating a General Interrogation

² Click Activate GI in the Status section.
This starts a general interrogation. The data of the selected device is updated from the process.

3.3.2
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The update is logged in the Report.

Enabling/Disabling Bay/Telecontrol Blocking

If you have selected a device in the configuration tree, you can set a bay or telecontrol block.
A bay block interrupts the exchange of the device related data with all the slave applications which are
mapped in the Information - Monitoring direction and Information - Command direction sections.
A telecontrol block interrupts the exchange of the device related data with all the control centers which are
mapped in the Information - Monitoring direction and Information - Command direction sections.
To activate or deactivate bay or telecontrol blocking:
² Select a device in the configuration tree.

² In the Status section, click ON.
- or -

² In the Status section, click OFF.

ii NOTE
Exceptions can be defined in the Mapping view of SICAM PAS/PQS UI – Configuration. In the Blocking
column, you can influence the effectiveness of the bay/telecontrol block for each individual item of infor-
mation. You can define whether only the bay or telecontrol block is to be checked or whether all blocks
are ignored and the corresponding items of information shall be transmitted despite a block. For more
information, refer to the online help.

ii NOTE
With Value Viewer or SICAM SCC, the Bay blocking/Telecontrol blocking can be applied for individual
items of information. The object specific activation/deactivation is available in the Information - Moni-
toring direction section.

Block Test Information

Block Test Information is available at Interface level, this will be available once the system is updated.
Block Test Information interrupts the exchange of the interface-related data with the applications supporting
test-tagged information.
To use Block Test Information, following is the procedure:
² Select an interface in the configuration tree.

² In the Status section, under the Block Test Information label, click ON to stop processing/forwarding the
test information.
- or -

² In the Status section, under the Block Test Information label, click OFF to process/forward the test
information.

Diagnosis

The diagnostic function supports you in determining the cause of an error occurred.
For communication connections, the function is available for the following applications:

• IEC 61850 Server/Client

• IEC 60870-5-101 Slave

• IEC 60870-5-103 Master

3.3.3

3.3.4
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• IEC 60870-5-104 Master/Slave

• DNP3 Master/Slave

• Modbus Master/Slave

• PROFIBUS DP Master

• SICAM MIC Master

• SIMEAS R Master

• SICAM Q80 Master

• SIPROTEC 4 Service IF Master

• OPC Server/Client

• OPC XML DA Server

• PQS Automatic Notification
The error information always refers to the component selected in the configuration tree, for example, an
interface or a device/control center.
The display type depends on the system configuration. If there are redundant components, information on
potential errors is displayed separately for each individual component.

[sc_Operation_Diagnosis, 2, en_US]

Figure 3-11 SICAM PAS/PQS UI – Operation - Diagnosis
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[sc_Operation_Client_Diagnosis, 1, en_US]

Figure 3-12 SICAM PAS/PQS UI – Operation Client - Diagnosis

The diagnostic function provides you with valuable information on potential sources of error which might
have caused the pending fault. The cause can for example, be a communication fault or a missing license. For
the interpretation of the useful notes provided, it is important to consider the current operating state of your
system.
During commissioning, an error such as No connection to the device usually has a different cause than
during operation. If such a message is displayed during the commissioning phase, you must first check
the power supply, the plug connections and the configuration of the communication parameters. During
operation, errors which might occur during the configuration of connection parameters, such as incorrect IP
addresses or port numbers, can almost be excluded. In this state, however, problems with monitoring times
defined too short can occur.
As soon as you have eliminated a potential cause of error, restart the component affected. In this way, you will
find out whether the problem has been successfully eliminated or whether another error is reported, which
was previously hidden by the first error.
If you cannot eliminate the problem, please contact the hotline. The hotline technicians will support you in
determining the cause (for example, initiation of a trace run).

Redundancy
You can operate the SICAM PAS/PQS system components in a redundant configuration. Redundancy can be
configured for:

• System

• Interfaces to devices and substations

• Interfaces to control centers

• Devices/Substations
For more information on redundancy and the different configuration options, refer to /9/ SICAM PAS, Redun-
dancy.

3.4
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Deploying a Project Database to a Redundant SICAM PAS/PQS System

In redundant configurations, the database of the partner Full Server is updated by using the Update system
function With database copy enabled. The function is valid for initial configuration and successive configura-
tion changes.
² Start SICAM PAS/PQS UI – Operation on the Full Server.

² In the Status section, select the With database copy option.

² Select Update system.
The database is updated on the redundant Full Server.
The system update is logged in the Report.
If you update the system for the first time, you are prompted in the Report to restart the redundant Full Server
and all DIPs connected. If the system is updated after a change, the redundant Full Server and the DIPs are
restarted.

Redundancy State

Depending on the selection of a system component in the configuration tree, the operation and connection
status of the redundant component is shown in the Redundancy state section.
In this view, you can switch over individual components, for example, an interface.

[sc_Redund_Config_Sys, 2, en_US]

Figure 3-13 Redundant Configured Systems and Interfaces in SICAM PAS/PQS UI – Operation
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[sc_Operation_Client, 1, en_US]

Figure 3-14 Redundant Configured Systems and Interfaces in SICAM PAS/PQS UI – Operation Client

With isolating systems in SICAM PAS/PQS UI - Operation Client you cancel the redundancy function. In this
case you can apply changes to the configuration of one computer while the other computer continues to
perform the runtime functionality.

Controlling Connections
You can activate and deactivate connections and reactivate them later. To do so, click Start or Stop in the
Status section. Respectively only one button is active depending on the current operating status of the
connection.
In a redundant configuration be aware of the following difference:

• With SICAM PAS/PQS UI – Operation you cannot start and stop connections of all partner systems
independently.

• With SICAM PAS/PQS UI – Operation Client you can start and stop all redundant connections independ-
ently from each other in the Redundancy state section.

For more information on how to update the system, refer to Updating the System, Page 217.

Starting and Stopping Data Links
To activate a data link:
² Select the inactive link in the configuration tree.

² Click Start in the Status section.

3.5
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[sc_Start_Stop_Oper, 2, en_US]

Figure 3-15 Starting a Data Link in SICAM PAS/PQS UI – Operation

If you have selected a system, an application, or an interface, the communication to all subordinate connec-
tions is started, for example, to all devices of an interface.
 
To deactivate a data link:
² Select the active link in the configuration tree.

² Click Stop in the Status section.

[sc_Stop_Oper_Client, 1, en_US]

Figure 3-16 Stopping a Data Link in SICAM PAS/PQS UI – Operation Client

If you have selected a system, an application or an interface, the communication to all subordinate connec-
tions is interrupted, for example, to all devices of an interface.
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Starting and Stopping Data Links with Redundancy Enabled
Starting and stopping data links at the interface or device level is applicable in SICAM PAS/PQS UI – Operation
Client for the following protocols:

• IEC 60870-5-101 Master/Slave

• IEC 60870-5-103 Master

• IEC 60870-5-104 Master/Slave

• IEC 61850 Server/Client

• DNP3 Master/Slave

• Modbus Master/Slave

• SIMEAS R Master

• SICAM Q80 Master

• SNMP Master

• SICAM MIC Master
 
To activate a data link:
² Select the inactive link at the application, interface, or device level in the configuration tree.

² Click Start for the required link in the Redundancy state section.

[sc_Start_Oper_Client, 1, en_US]

Figure 3-17 Starting a Data Link in SICAM PAS/PQS UI – Operation Client in Redundant Systems

If you activate a link, all the communications to the level starts.
 
To stop a data link:
² Select the active link in the configuration tree.

² Click Stop for the required link in the Redundancy state section.
If you stop a link, all the communications to the level stops.
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GOOSE Status Monitoring
In SICAM PAS/PQS UI – Operation Client, you can monitor the status of GOOSE data transmission. The
following is displayed for every GOOSE list of a device:

• The transmission of the GOOSE list is enabled.

• The GOOSE list is periodically received within a defined time range.
The GOOSE status is shown to the right of the application in the configuration tree and on the lower levels.

[sc_GOOSE status application level, 1, en_US]

Figure 3-18 GOOSE Status Monitoring, Error-free Transmission of GOOSE Lists

If you disable the transmission of the GOOSE list in a device, the status  is not shown on the higher levels as
long as at least 1 device is transmitting GOOSE lists.
If no GOOSE list has been transmitted within the specified time range (3 x TTL), the error status  is shown
on all levels.
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[sc_GOOSE status error application level, 1, en_US]

Figure 3-19 GOOSE Status Monitoring, Error Shown on the Application Level

² Navigate to the device with the incorrect GOOSE status.
The status of the GOOSE lists is shown in the GOOSE status tab.

[sc_GOOSE status error device level, 1, en_US]

Figure 3-20 GOOSE Status Monitoring, GOOSE Status of a Device

Operating State
The icons to the left of the entries in the configuration tree show the current status of the individual data links.

3.7
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• Click the arrow next to the project, a system, an application, or an interface in order to view subordinate
data links.

• Click the icon or the name of an entry in the tree structure in order to view details on the system status in
the Status section (that is, the right-hand window section).

Table 3-1 Status Displays

Icon Status display Color Explanation
Project folder Red The project configuration was changed while SICAM

PAS/PQS UI – Operation was displayed.
Incorrect compatibility key Yellow/

black
The parameterization of the application (for example,
SoftPLC, exchanged IP address) does not match the
current SICAM PAS/PQS project.

Values invalid Yellow The connection currently does not provide valid
values.

Starting Violet System start-up: The connection was activated by
SICAM PAS/PQS, but the device or system does not
yet respond.
Possible causes:
Temporary status: The component responds shortly
afterwards, and the connection is then active
(running).
The component has failed.
The component has been disabled on the hardware
side.

Stopping Violet The connection is being shut down.
The connection is deactivated, but the component
has not yet responded.
Temporary status, the connection is interrupted
shortly afterwards (stopped).

Starting
(blocked)

Violet System start-up
The connection is blocked by a bay/telecontrol block.

Stopping
(blocked)

Violet The connection is being shut down.
The connection is blocked by a bay/telecontrol block.

Running Green The connection is active.

Stopped Blue The connection has stopped.

Running
(blocked)

Green The connection is active.
The connection is blocked by a bay/telecontrol block.

Stopped
(blocked)

Blue The connection is stopped.
The connection is blocked by a bay/telecontrol block.

Bay/telecontrol block
(ON)

Blue The bay block or telecontrol block is enabled.

Bay/telecontrol block
(OFF)

Blue The bay block or telecontrol block is disabled.
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Table 3-2 Status Displays – Redundancy

Icon Status display Color Explanation
Active Green One redundant component is active, the other

component is not active.
Active
(blocked)

Green One redundant component is active and blocked by
a bay or telecontrol block. The other component is
inactive.

Inactive Blue The connection of the redundant component is inac-
tive.

Inactive
(blocked)

Blue The connection of the redundant component is inac-
tive and blocked by a bay or telecontrol block.

Standby mode Violet The redundant component runs in standby mode.

Invalid state Red Both redundant components are turned to master or
run in standby mode concurrently.

The following GOOSE status indications are available in SICAM PAS/PQS UI – Operation Client only.
The icons to the right of the entries in the configuration tree show the current GOOSE status of the individual
data links.

• In order to view subordinate data links, click the arrow next to the application or an interface.

• In order to view details on the GOOSE list status, select the GOOSE status tab for the corresponding
device.

Table 3-3 Status Displays – GOOSE Status Monitoring

Icon Status display Color Explanation
GOOSE list working fine Green The GOOSE lists are periodically received from the

device within the defined time range (3x TTL).
Values of the system indications:

• SysGooseEna_[ListName] = 2
• SysGooseStat_[ListName] = 2

Starting Violet The connection was activated by SICAM PAS/PQS, but
the device or system does not yet respond.

GOOSE list disabled Blue The GOOSE list has been stopped by the user.
Values of the system indications:

• SysGooseEna_[ListName] = 1
• SysGooseStat_[ListName] = 1

GOOSE list not received Red The GOOSE lists are enabled, but at least 1 GOOSE list
has not been received.
Values of the system indications:

• SysGooseEna_[ListName] = 2
• SysGooseStat_[ListName] = 1

Values invalid Yellow The connection currently does not provide valid
values.

Archive Activity Monitor
The Archive Activity Monitor shows the current activities of an archive, that is, all the information sent to the
archive from a Power Quality or a Fault Recording device. All the devices are listed in the Device column.
The data stored by the archive is displayed in the Activity column. The date and time of the corresponding

3.8
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activity is displayed in the Date/Time column. The elapsed activity information along with the date and time
is displayed in gray. The elapsed activity information is available as long as the Archive Activity Monitor is
running. The grayed out information is replaced if the next activity is started for that device.

[sc_Archive_activity_monitor, 3, en_US]

Figure 3-21 Archive Activity Monitor

To start the Archive Activity Monitor:

• From the SICAM PAS/PQS UI – Operation menu, select View > Archive Activity Monitor....
- or -

• From the Windows Start menu:
– Click Start and scroll through the app list.
– Select SICAM PAS/PQS > Tools.

The Tools folder opens.
– Double-click Archive Activity Monitor.

The Archive Activity Monitor dialog opens which displays the current activities of the archive.
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Value Viewer

The Value Viewer provides a well-structured overview of all the information from your station.
Using the options available in the Value Viewer, you can test data links and modify information for test
purposes, for example, within the framework of commissioning.
4.1 Starting the Value Viewer 231
4.2 Showing Information 231
4.3 Editing Information 232
4.4 Columns of the Value Viewer 234
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Starting the Value Viewer
Start the Value Viewer from the Windows Start menu:
² Click Start and scroll through the app list.

² Select Value Viewer from the SICAM PAS/PQS folder.
The Value Viewer opens and displays your current station configuration as defined in SICAM PAS/PQS UI –
Configuration.
For more information on the individual columns, refer to 4.4 Columns of the Value Viewer.
The program is only available in the English user interface language.

[sc_Value_Viewer, 2, en_US]

Figure 4-1 Value Viewer

Showing Information
Selecting a Data Link

To show the information transmitted by a device or an interface:
² In the Project section, click the data link which you want to view.
The table on the right of the project section shows specifically the information related to this data link.
The display is refreshed automatically.

Filtering Information
To restrict the display of information, specify filter criteria for one or several columns. In addition to column-
specific filter criteria, you can also define and apply user filters.
To filter information:

4.1
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² To view information relevant at a certain time, click the drop-down list of the column including the filter
criterion (for example, TimeStamp).

² Select a filter criterion, for example, date.
The table now shows only the information which has arrived at the specified time.
² Select the filter criterion in another column. For example, select the Valid criterion in the TimeStamp-

Status column.
The table shows only the information which has arrived at the specified time with the valid time stamp.

Resetting a Filter

² Select the (None) filter criterion in order to show all information in this column again.

Showing Details of an Item of Information
To show details of an item of information:
² Click Properties on the right-hand window margin.

² Select a table row.
The properties of this item of information are now displayed in the Properties window.

[sc_Pror_Item_Info, 2, en_US]

Figure 4-2 Window Showing the Properties of an Item of Information

For more information on the individual columns, refer to 4.4 Columns of the Value Viewer.

Editing Information
For test purposes, you can modify information in the Value Viewer and transmit it to the device.

4.3
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² Select the item of information which you want to edit.

² Open the Properties window.

² In the Properties window, select the field which you want to modify.

² Select an entry from the drop-down list of this field or overwrite the entry in the input box.

[sc_Modify_Items_Info, 2, en_US]

Figure 4-3 Modifying Items of Information

Testing Data Links
You can perform specific operator actions in order to test whether an interface or a device transmits correct
values.
² Activate Substitute in order to manually update an information state, for example, the switch position of

an equipment component.

² Activate Control in order to send a command.

² Deactivate Control in order to send a command message.

² Activate Select in order to define “Select before operate” for the command.
This option is not available for all protocols.

² To transmit information, click Transmit.
² Activate Break in order to cancel the selection command.
Commands are sent to the connected devices and substations. Messages are forwarded to the mapped
destinations by using the DSI server.
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ii NOTE
The commands and messages which the Value Viewer sends to the process cannot be distinguished from
actual process changes in the control center.
The command output is secured by a password.
To use the Windows access rights for user administration, you must use the default password 000000 for
the Value Viewer.

Columns of the Value Viewer
The Value Viewer is only available in English user interface language. The following list describes the mean-
ings of the individual columns.

Table 4-1 Columns of the Value Viewer

Column Designation Explanation
TimeStamp Time stamp of the last update of an item of information
TimeStampStatus Validity of the time stamp

• Valid: Time stamp valid
• Process: Time stamp received from the process
• Replaced: Time stamp replaced
• ClockSync: Clock synchronized
• ClockValid: Time stamp provided by the clock

TimeStampQuality Classification of the quality of the time stamp

• High: Deviation from the reference time < 10 ms
• Low: Deviation from the reference time > 2 s
• Medium: Deviation between High and Low
The field remains empty if this classification is not possible.
The quality of the time stamp depends on the synchronization type and the
transmission protocol.

ValuePath Address of the item of information
ValueName Name of the item of information
Value Value of the item of information
InitiatorCategory Command origin (source)
CauseOfTransmission Cause of transmission
TestBit To identify whether the item of information sent/received is marked as test

information.

• DsiTestBitOFF: Item of information is an operational information
• DsiTestBitON: Item of information is a test information

AdditionalCause Additional transmission cause
Validity Status of the item of information
TypeOfValue Type of the item of information
TypeId Value type (ScadaInteger or ScadaFloat)
ValueId Internal ID
Source Origin of the item of information, for example, transmitted or calculated
NormalSource Expected origin of the item of information, for example, transmitted,

substituted, and calculated

4.4
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Column Designation Explanation
NormalRange • NotInitialized: Value not initialized

• Normal: Value in normal range
• Abnormal: Value outside the normal range (measured-value over-

flow)
ValueFlags • dsiSigned: A signed value is sent/received

• dsiUnsigned: An unsigned value is sent/received
DsiCovSequence Counter for the number of transmissions of the value since the start of the

DSI server
0 = server overflow, 80000000 = invalid

IdentificationNumber • Fault number or
• Finterrogation cycle number or
• Feedback identification

TypeOfIdentificationNumber Identification type
SupplementaryInformation • Irrelevant

• Implicit, additional information depending on the type of information,
for example, relative time

TypeOfSupplementaryInforma-
tion

Type of the item of information

Value Viewer
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Archives

This chapter provides general notes on archives and illustrates how you can monitor an archive using the
SNMP Server Windows feature and the SNMP application.
You can perform a back-up of the runtime archive at regular intervals in order to prevent the loss of historical
data due to restricted storage capacity.
5.1 General Notes on Archives 237
5.2 Monitoring the Archive 237
5.3 Accessing the Monitoring Functions 238
5.4 Backup Archive 245
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General Notes on Archives
The drives required for operation the of SICAM PAS/PQS system (Windows, Export service, SICAM PAS/PQS
temp files, and Recpro archive) are monitored for the available space. After update system, a minimum
storage capacity of 500 MB has to be available on all the required drives. When the available storage capacity
of one of the drives used is less than this threshold value, the archive remains stopped and a warning message
is displayed in the Report.
When the archive is stopped, data is no longer stored in the archive and it is not exported from the archive. To
restart the archive, a minimum storage capacity of 1 GB should be available for each of the drives.
To monitor the storage capacity of the drives, an alarm in the form of an e-mail and/or the SMS can be
configured, refer to 2.6.16 PQS Automatic Notification. Additionally, this alarm can be routed to SICAM SCC or
any control center.

ii NOTE
The network drives are not monitored for the available space.

Archive Maintenance
The storage capacity of the archive is displayed in the status bar of the SICAM PQ Analyzer. Once the archive
is 100 % full, archiving of the data is stopped and 10 % of the oldest archived data is deleted. The data
from the archive is deleted until sufficient storage space has been created to store the incoming data. Once
sufficient storage capacity is available, the archiving of the data is resumed. The deletion of the archive is a
time-consuming activity and can take a few hours depending on the data uniformity (linear to time range),
fragments in the archive, size of the fragment files, and so on.
In rare cases, earlier versions of SICAM PAS/PQS allow the archive size to be larger than the configured limit. If
the archive size is larger than the configured archive size, after upgrading from the earlier versions of SICAM
PAS/PQS to V8.03, the oldest data from the archive is deleted until the archive size becomes less than the
configured limit. The process of deletion can take a long time depending on the amount of data. If the archive
is more than 150 % full (as displayed in the status bar of the SICAM PQ Analyzer), you can prevent the long
running deletion of the archive by increasing the value of Archive size for the Archive application in SICAM
PAS/PQS UI – Configuration before updating the system in SICAM PAS/PQS UI – Operation.
² Save the data before its deletion with the SICAM Archive Backup tool.
For more information, refer to 5.4 Backup Archive.
For more information on the handling of the archives, refer to /13/ SICAM PQ Analyzer.

Read-/Write Speed of the Archive
The read-/write speed of the archive might be degraded if the advanced attribute Compress contents to save
disk space is selected for the archive folder.
To verify the folder setting:
² Select the archive folder and select Properties from the context menu.

The Properties dialog opens.

² Select the General tab and click Advanced....
The Advanced Attributes dialog opens.

² Deselect Compress contents to save disk space.

Monitoring the Archive
When monitoring an archive, you must be aware whether the archive is installed on the SICAM PAS/PQS
computer or on an archive computer.

5.1

5.2
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Archive and SICAM PAS/PQS on the Same Computer
If you have configured an archive within a SICAM PAS/PQS system in order to store fault records or PQ data,
this archive data is published by an archive server for the SICAM PQ Collector or SICAM PQ Analyzer.
This archive server is automatically started by the Archive Server monitoring service.
You use the SNMP Server Windows feature and the SNMP application in order to detect an unexpected failure
of the archive server.

Archive Computer with SICAM PQ Collector and Archive Server
The SICAM PQ Collector allows you to combine the archives of several SICAM PAS/PQS systems into a shared
Collector archive on an archive computer. This ensures that the SICAM PQ Analyzer can directly access the data
from all the SICAM PAS/PQS systems.
The SICAM PQ Collector provides the Collector runtime and Archive server functions.
You use the Windows SNMP server feature and the SNMP application in order to transfer status information
from the Collector runtime and archive server to the SICAM PAS/PQS system:

How to Proceed
The following steps are required in order to access the monitoring functions:

• 5.3.1 Installing the SNMP Server Windows Feature

• 5.3.2 Installing SNMP Feature for Windows 10 and Above

• 5.3.3 Configuring SICAM PAS/PQS
The configuration consists of the following steps:
– Importing the device description
– Inserting the SNMP application, an interface and a device for each Collector
– Mapping the information to a control center or an operator station.

Accessing the Monitoring Functions

Installing the SNMP Server Windows Feature

Depending on the monitoring functions required in the individual case, the SNMP Server Windows Feature
must be installed:

• on the computer on which SICAM PAS/PQS is installed

• on the computer on which the Collector archive is installed

ii NOTE
The Windows Feature only supports SNMP V1 and V2.

You require administrator rights in order to be able to install the SNMP server Windows feature.
² Click Start, type Turn Windows features on or off, and confirm by pressing <Enter>.
The Windows Features dialog opens.

5.3

5.3.1
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[sc_turn_SNMP_windows_feature_on, 3, en_US]

Figure 5-1 Activating SNMP

² Activate the Simple Network Management Protocol (SNMP). The WMI SNMP Provider feature is
optional and not required.

² Click OK to exit the dialog.
Changing the Windows feature can take a few minutes.
² Click Start, type Services, and confirm by pressing <Enter>.
The Services dialog opens.

[sc_SNMP_Service, 2, en_US]

Figure 5-2 SNMP Service
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² Select the SNMP Service and select Properties from the context menu.

² Select the Security tab.

[sc_Accepted_communities_names, 2, en_US]

Figure 5-3 SNMP Service

² In the Accepted community names section, click Add....

[sc_community_name, 2, en_US]

Figure 5-4 SNMP Community Name

² Retain the READ ONLY default setting and enter the public community name.
The community name is also the default setting for inserting a device into the interface of the SNMP
application.

² Click Add to confirm.

² In the Accept SNMP packets from these hosts section, click Add....
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[sc_SNMP_IP_address, 2, en_US]

Figure 5-5 SNMP Community Name

² Enter the host depending on the archive storage location:

• Archive and SICAM PAS/PQS on the same computer
For a redundant configuration enter the host name, the IP, or the IPX address of the redundant
SICAM PAS/PQS system.

• Archive computer with SICAM PQ Collector and archive server
Enter the host name and the IP or IPX address of the SICAM PAS/PQS system which monitors
the runtime of this Collector and this archive server. For a redundant configuration add the host
names, the IP, or the IPX addresses of both systems.

 

² Click Add... to confirm your entries.

² Click Apply to save your changes.
In order to make the changes effective, restart the SNMP service.
² Select the General tab.
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[sc_stop_SNMP_service, 2, en_US]

Figure 5-6 Restarting the SNMP Service

² Click Stop and then Start.
² Next, click OK to exit the dialog.
The SNMP Server Windows feature is installed.

Installing SNMP Feature for Windows 10 and Above

In Windows 10 and above, the SNMP service is available as a separate Windows feature and it is not installed
by default.
To install the SNMP service for Windows 10 and above, perform the following steps:
² Select Settings > Apps > Apps & Features > Optional features > Add a feature. The Add a feature

dialog opens.

² Select the following features from the list:
- Simple Network Management Protocol (SNMP)
- WMI SNMP Provider (to get all SNMP service configuration tabs).

² Click Install.
The SNMP service appears in the services.msc console.
Refer to section 5.3.1 Installing the SNMP Server Windows Feature for further steps on installing SNMP Server
Windows Feature.

5.3.2
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Configuring SICAM PAS/PQS

Perform the following steps in SICAM PAS/PQS UI – Configuration:

• Importing the Device Description

• Inserting an Application, Interface, and Device

• Mapping Information

Importing the Device Description
To import the device template for monitoring the archive:
² Open the Templates view.

² Select SNMP and then select Import... from the context menu.

² Select the device description depending on the archive storage path in the %publicdocu-
ments%Siemens\SICAM PAS PQS\DeviceDescriptions\snmp directory:

• Archive and SICAM PAS/PQS on the same computer
SICAM_PQS_Archive_Status.txt device description

• Archive computer with SICAM PQ Collector and archive server
SICAM_Collector_Status.txt device description.

[sc_importdevicedescription, 2, en_US]

Figure 5-7 Importing the Device Template (Archive Computer)

Inserting an Application, Interface, and Device

² Open the Configuration view.

² Insert the SNMP application, an interface, and a device for the archive on the same computer and the
Collector archive on separate computers.

² Enter a name.

² Next, select the SICAM PQ Collector Status device template or SICAM PQS Archive Status.

² Enter the IP address of the respective computer in the IP address field.

5.3.3
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² Check the Community field. The entry must match the community name which you have defined for
the Windows SNMP service.

[sc_addSNMPdevice, 2, en_US]

Figure 5-8 Inserting a PQ Collector System

Mapping Information

² Open the Mapping view and select the desired status information.
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[sc_SNMPmapping, 3, en_US]

Figure 5-9 Inserting a PQ Collector System

² This status information can now be mapped to a control center, substation, or an HMI system (SCC),
processed in the SoftPLC, or sent by e-mail/SMS using the PQS Automatic Notification function.

Backup Archive
To avoid the loss of historical data due to restricted storage capacity, Siemens recommends you create
backups of the runtime archive at regular intervals. The backup can be used to view historical data via SICAM
PQ Analyzer and restore the archive in situations where hardware faults or software errors lead to a corruption
of the runtime system.

ii NOTE
Instead of creating a backup of the runtime archive (backup archive) you can use the SICAM PQ Collector
which continuously synchronizes the (Collector) archive with the runtime archive. In this way you create a
copy of the archive data. The advantage of this approach is that there is only one archive and that you do
not need to care about deleting obsolete backup copies due to restricted storage capacity.
For more information on the SICAM PQ Collector, refer to /14/ SICAM PQ Analyzer, Incident Explorer.

Creating a Backup Archive

The SICAM Archive Backup tool serves to back up the SICAM PAS/PQS archive in a selected target folder.
Start the SICAM Archive Backup tool from the Windows Start menu:
² Click Start and scroll through the app list.

² Select SICAM PAS/PQS > Tools.
The Tools folder opens.

² Double-click Archive Backup.
The SICAM Archive Backup tool opens.

5.4

5.4.1
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[sc_Backup_Archive, 1, en_US]

Figure 5-10 SICAM Archive Backup

² Click … to select the Target folder.

ii NOTE
The selected Target folder can be located on a SICAM PAS/PQS system, a backup server, or a SICAM PQ
Analyzer system. Make sure you have sufficient storage capacity available to create a backup archive. If the
backup archive is on a backup server or a SICAM PQ Analyzer system, make sure that the path is assigned to
a drive.

² Select Fast backup if you want to speed up the backup process.

ii NOTE
If you select fast backup, all the applications must be stopped in SICAM PAS/PQS UI – Operation before
starting the backup process.

² Once the backup process is completed, click OK to exit the dialog.

ii NOTE
If you click Cancel, the data already copied to the target folder is not deleted.

ii NOTE
You can schedule a backup process at regular intervals, by using %pas_bin%\SICAMArchiveBackup.exe
<target folder path>.

Restoring a Backup Archive

To restore a backup archive, execute the batch file to restore the content of the archive and the session
management and EAArch files.
To restore a backup archive, perform the following steps:

• Executing the Restore_Backup.bat batch file

• Further Steps

Executing the Batch File
Steps to be performed on the SICAM PAS/PQS system:
² Stop the SICAM PAS/PQS system in SICAM PAS/PQS UI – Operation / SICAM PAS/PQS UI – Operation Client.

5.4.2
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² Close SICAM PAS/PQS UI – Configuration and SICAM PAS/PQS UI – Operation / SICAM PAS/PQS UI –
Operation Client.

² Stop the Archive Server monitoring service, the SSR, and the Defragmentation Agent services.
For more information on these services, refer to /3/ SICAM PAS/PQS, Installation.

² Execute the batch file, Restore_Backup.bat located at the <SICAM Archive Backup target folder path>
with administrator rights.
The batch file restores the content of the archive and the required session management, user, and
EAArch files.

ii NOTE
If the location of the archive in the runtime system has changed compared to the backup archive, the
EAArch file must be modified in order to be suitable for the archive.
Therefore the following steps must be performed:

• Open the EAARch file at %COMMONAPPDATA%Siemens\SICAM PQ Analyzer\Runti-
meArchive\Siemens.Energy.Archives.EAArch with a text editor.

• Change the path variables to the new location.

Further Steps
Proceed with the following steps on the SICAM PAS/PQS system
² Verify that the SICAM PAS PQS Users group has the required access rights for the runtime archive

directory in the Security tab of Internet Properties dialog and the EAArch file at %COMMONAPP-
DATA%Siemens\SICAM PQ Analyzer\RuntimeArchive\Siemens.Energy.Archives.EAArch.

² Start the Archive Server monitoring service, the SSR, and Defragmentation Agent services.
For more information on these services, refer to /3/ SICAM PAS/PQS, Installation.

² Start SICAM PAS/PQS UI – Configuration and SICAM PAS/PQS UI – Operation / SICAM PAS/PQS UI –
Operation Client.

Any PQ data created between the backup date and the restore date are not included in the archive. To retrieve
this data, configure a Start date 1 day before the backup date on the interface of all the PQ devices in SICAM
PAS/PQS UI – Configuration.
² Update/Start the SICAM PAS/PQS system in SICAM PAS/PQS UI – Operation / SICAM PAS/PQS UI – Opera-

tion Client.

² Start the archive and all the devices.
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User Administration

This chapter explains you how to work with the SICAM PAS/PQS User Administration.
You can use this system component to assign user rights for your employees. These rights are classified
according to user roles which provide access to various fields of application.

ii NOTE
The User Administration is not applicable for SICAM PAS/PQS UI – Operation Client.
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6.2 User Roles and User Groups 250
6.3 Administrating Users 251
6.4 Logging on/off a User 255
6.5 Modifying the Basic Settings of the User Administration 256
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Starting User Administration
To start the SICAM PAS/PQS User Administration from the Windows start menu:
² Click Start and scroll through the app list.

² Select User Administration from the SICAM PAS/PQS folder.

Setting up the User Administration
The User Administration opens in a dialog for the initial login as an administrator.
An administrator is set up in the default setting.
² For the initial login after the new installation of SICAM PAS/PQS, enter the Administrator user name and

the default Admin password.

² To use the Windows access rights, select Use Windows users.
- or -

² To define individual access rights, select Use internal SICAM PAS/PQS users.

[sc_Log_on_user_initial, 1, en_US]

Figure 6-1 Logging on as an Administrator

ii NOTE
The Use Windows users and Use internal SICAM PAS/PQS users options are visible only when the user
logs on for the first time. For all following logins, the action defined in this dialog can be modified
in the User Administration by clicking Tools > Type of User Administration > .... The Type of User
Administration menu is enabled only for domain users.

² In the dialog which opens, enter and confirm your new password. 

ii NOTE
The default password must be changed, because it is public.
Your new password will be maintained even if you have secured all other user rights by using the Windows
access rights.

The User Administration dialog opens.

6.1
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User Roles and User Groups
User Administration

A user can log on with one of the following user roles:

• Administrator with full rights

• System engineer with full rights, no access to the User Administration

• Data engineer with full rights for SICAM PAS/PQS UI – Configuration and Feature Enabler, read-only
rights for SICAM PAS/PQS UI – Operation and Value Viewer

• Switch operator with full rights for SICAM PAS/PQS UI – Operation and Value Viewer, read-only rights for
SICAM PAS/PQS UI – Configuration and Feature Enabler

• Guest with read-only rights for all SICAM PAS/PQS system components with exception of the User
Administration

• Security administrator with full rights for the User Administration, read-only rights for all SICAM
PAS/PQS system components

• RBAC manager creates users and assigns roles in the User Administration, with read-only rights for all
SICAM PAS/PQS system components

• Security auditor audits the security logs, with read-only rights for all SICAM PAS/PQS system components

[sc_User_Administration, 4, en_US]

Figure 6-2 User Administration, Example

Nesting User Groups within the Same Domain
When SICAM PAS PQ is installed in a domain, the following groups corresponding to the same domain can
access SICAM PAS PQ applications.
Also, the users nested under these subgroups can access SICAM PAS PQ applications.

• Domain Local group

• Global group

• Universal group

ii NOTE
As a prerequisite, Main group must be added to SICAM PAS PQS user group to support nesting.

Nesting User Groups in 2 Different Domains
Users from another domain are allowed to access SICAM PAS PQ applications only when the Active Directory
domain declares the other domain as a trusted domain.

6.2
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ii NOTE
Only the users of Global group and Universal group from the other domain are allowed to access SICAM
PAS PQ applications.

Administrating Users
Setting up New Users

To set up a new user:
² Click Edit > Create user from the User Administration menu bar.

² Enter the different users with their corresponding user roles.

Selecting Windows Users
Consider the following prerequisites:

• The system must be connected to a domain.

• The user must log on with a domain-user account and not with a Windows local-user account.

• The user which is used for login must be part of the SICAM PAS PQS Users user group.
To select a Windows user:
² In the Create user dialog in the Common settings section, click ... next to the Group or user name field.

² In the Select a group or a user dialog, click Domains... in order to select the network domain.

² Enter the group or the user name to be used and click Check name to check it.

[sc_Creating_Win_user, 1, en_US]

Figure 6-3 Creating a Windows User

² In the Common settings section, select a Role from the list box.

6.3

User Administration
6.3 Administrating Users

SICAM, SICAM PAS/PQS, Configuration and Operation 251
E50417-P8976-C433-C9, Edition 05.2023



Creating SICAM PAS/PQS Users
To create a SICAM PAS/PQS user:
² Enter the User name in the Common settings section.

² Select a Role from the list box.

[sc_Creating_PAS_user, 1, en_US]

Figure 6-4 Creating a SICAM PAS/PQS User

² Enter a password and confirm it.

Authenticating a User
If you communicate with a control center through the DNP3i Slave protocol, you can authenticate the user for
individual commands.
² In the Authentication input area in the User authentication box, selectYes from the list box.

² Enter your Pre-shared key.
The Pre-shared key (text) must consist of 16 characters.
The Pre-shared key (hex) must consist of 32 characters.

² Enter the DNP3 user ID.
The DNP default user is assigned user ID 1.
To all other users a user ID >1 is assigned.

² Click OK to confirm your entries.
The authentication function is only effective if it has been activated during the parameterization of the
DNP3i Slave in SICAM PAS/PQS UI – Configuration. To do this, open the Configuration view, Security -
Authentication input area. In this area, you also assign the default user.
This ensures that all users with a DNP3 user ID have the switching authority for all commands.
To restrict the switching authorization of a user to individual commands, you can assign these commands in
the Mapping view.
Proceed as follows:
² Select the DNP3i control center from the configuration tree in the Mapping view.
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[sc_DNP_Assigning_Users, 2, en_US]

Figure 6-5 DNP3i Slave Protocol – Assigning Users

² Select an item of information in the DNP user column. In the dialog which opens next, select one or
several users, which are authenticated for this command.

[sc_DNP_Selecting_Users, 2, en_US]

Figure 6-6 DNP3i Slave Protocol – Selecting Users
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For more information on authentication and secure data transmission, refer to /8/ SICAM PAS/PQS, Security.

Activating the DNP Authentication Subsequently
Proceed as follows if you are logged on as a Windows user and want to subsequently activate your DNP
authentication:
² Switch the User Administration to Internal SICAM PAS/PQS users.

² Close the User Administration.

² Log on as an internal SICAM PAS/PQS administrator.

² Switch the User Administration to Windows users.

² Change the Windows user.
For more information on authentication and secure communication, refer to /8/ SICAM PAS/PQS, Security.

Changing the Type of User Administration
To change the type of User Administration:
² In the menu bar, select Tools > Type of User Administration > Use Windows users in order to use the

Windows access rights for User Administration.
- or -

² In the menu bar, select Tools > Type of User Administration > Use internal SICAM PAS/PQS users in
order to use individual SICAM PAS/PQS access rights for User Administration.

Any users of the other type of User Administration will be invalid if there is a change.
To ensure that existing users become valid again:
² Select the invalid user and select Edit user from the context menu.

² In the dialog which opens, enter the new access rights.
If there is a change of the type of User Administration, the parameters defined for authentication will be
maintained and applied to the changed user account.

Editing a User
Use one of the following options in order to assign a user to another user group or to change the password of
a user.
To edit a user:
² Click Edit in the corresponding row.

- or -

² Right-click the row of the user and select Edit user from the context menu.
- or -

² Select the row of the user and select Edit > Edit user from the User Administration menu bar.
The Edit user dialog opens.
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[sc_Editing_user_account, 1, en_US]

Figure 6-7 Editing a User

The parameters displayed depend on the selected type of User Administration and are entered analog to the
procedure for creating a user.
² Edit the parameters.

Deleting a User
All users, apart from an administrator, can be deleted.
To delete a user:
² Click Delete in the corresponding row.

- or -

² Right-click the row of the user and select Delete user from the context menu.
- or -

² Select the row of the user and select Edit > Delete user from the User Administration menu bar.
The user is removed from the list.

Logging on/off a User
First, the individual SICAM PAS/PQS system components are started without the User Administration. The
header of the system components shows that the User Administration has been deactivated.
When opening the User Administration for the first time, the existing administrator is shown as the user by
default.
The User Administration is effective for the following system components:

• SICAM PAS/PQS UI – Configuration

• SICAM PAS/PQS UI – Operation

6.4
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• SICAM PAS/PQS UI – Operation Client

• Feature Enabler

• Value Viewer
The User Administration itself can only be opened by users with administrator rights.

Activating the User Administration
Proceed as follows to activate the User Administration:
² Select Tools > Activate user login from the User Administration menu bar.
The checkmark on this menu item indicates the selection.

Logging on a User
The login of a user depends on the selected type of User Administration.

• If Windows access rights are used, your user name and the user role assigned are automatically used for
accessing the applications.

• If internal SICAM PAS/PQS access rights are used, the Log on user dialog opens as soon as the first
system component is started.

² Enter the User name and the Password.

[sc_Log_on_user, 1, en_US]

Figure 6-8 Logging on a User to a SICAM PAS/PQS System Component

The system component opens and your user name is displayed in the header of the system component. As
long as this system component is open, you are automatically logged on for the other system components.

Logging off a User
If you close all system components, you automatically log off as a user.
To leave one or several system components open, you can log off by using a menu command.
To log off as a user:
² In the menu bar of a system component for which you are logged on, click File > Log off user.

The Log on user dialog opens. The header of all open system components indicates that no user is
logged on. The applications are blocked until a new user has logged on. This ensures that one user is
always logged on while the User Administration is active.

Modifying the Basic Settings of the User Administration
Selecting a Language

To change the user interface language of the User Administration:
² Select Tools > Language selection and select the desired language in the dialog which opens.

6.5
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The new language setting is activated upon a restart of the User Administration.

Setting a Timer
To set the time for the automatic logout from the User Administration:
² Select Tools > Set timer and set a time between 0 and 60 minutes in the dialog which opens.

The 0 minutes setting deactivates the automatic logout.

[sc_Logoff_Time_User_Administ, 2, en_US]

Figure 6-9 Setting the Logout Time for the User Administration

Showing the History of the User Administration
Showing the Security Log File

All activities of the User Administration are logged in chronological order in a log file.

ii NOTE
The security log file can only be displayed if the logged on Windows user belongs to the administrator
group.

To show the progress of User Administration activities:
² Select File > Show security log file....

[sc_User_Administ_Log_File, 2, en_US]

Figure 6-10 User Administration Log File
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Configuring syslog

ii NOTE
The Security menu is available only for the Administrator and Security administrator.

Security related logs, for example, user login/logout, start/stop of system components, modifications in the
archive (import records, import PQDIF, delete records, delete reports, add or edit traffic lights), are displayed
in the Windows Event Viewer in the PASSecurity and PQ Analyzer Security folders. Use syslog to collect
these security-related logs of the applications within a system on a dedicated syslog server.
To configure the syslog server:
² Select Configure syslog... from the Security menu.

The Configure syslog dialog which opens provides the parameters:

• Activate syslog
By default, this parameter is set to No. Select Yes to activate syslog.

• Server IP address
By default, the IP address of the network card of your computer is used. Enter the syslog server IP
address.

• UDP port
This parameter is used to establish the connection to the syslog server. By default, 514 is used as
UDP port number.

 

² Click OK to configure syslog or click Cancel to discard the changes.

ii NOTE
After syslog has been configured, update the system in SICAM PAS/PQS UI – Operation.

Enabling Asset Monitoring (SNMP Agent)

ii NOTE
The Security menu is available only for the Administrator and Security administrator.

SICAM PAS/PQS provides an SNMP Agent which makes available asset information, for example, product
name, installed software and database versions, date of last configuration changes, and enabled features, to
an SNMP Manager.
SNMP Agent also stores security related logs, for example, user login/logout, start/stop of system components,
modifications in the archive (import records, import PQDIF, delete records, delete reports, add or edit traffic
lights), available as information for the SNMP Manager.
To enable/disable asset monitoring:
² Select Enabling Asset Monitoring (SNMP Agent) from the Security menu.
The checkmark on this menu item indicates the selection.

6.7

6.8

User Administration
6.7 Configuring syslog
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ii NOTE
In order to be able to communicate information about the SICAM PAS/PQS station between with the SNMP
Agent and the SNMP manager, the following credentials are required:

• SNMP User Name: Admin

• SNMP V3 Authentication Protocol: SHA512

• SNMP V3 Authentication Password: 12345678

• SNMP V3 Privacy Protocol: AES128

• SNMP V3 Privacy Password: 12345678
For safety reasons, Siemens recommends you remove this initial standard user, create your own user, and
assign a new password. The corresponding SNMP tree structures and tables for user management are
readable and writable (USMMIB).For more information refer to RFC documentation: USM-MIB (RFC 3414,
2574) and VACM-MIB (RFC 3415, 2575).
User credentials for SNMP Agent can be:

• Adapted to established connection of SNMP Manager
– or –

• Configured in advance using MIB browser
For example, https://www.ireasoning.com/downloadmibbrowserpro.shtml, go to Tools > Manage
SNMPv3 USM Users.

ii NOTE
When SICAM PAS/PQS is configured with SNMP client, the port number 161 is used. In such a case, the
SNMP Agent and the SNMP client both tend to use the same port number 161, causing one of them to
fail. To solve this, you can assign the SNMP Agent to another port by adding an environment variable,
RC_SSA_SNMP_PORT with the value of the port number as a decimal number.

ii NOTE
For the display of MIB information (MIB – Management Information Base), a MIB browser and the descrip-
tion files are required.
You can find the MIB file in the DeviceDescriptions/MIB folder on the SICAM PAS/PQS DVD.

Enabling Security Notifications (SNMP Agent)

ii NOTE
The Security menu is available only for the Administrator and Security administrator.

Security related logs, for example, user login/logout, start/stop of system components, modifications in the
archive (import records, import PQDIF, delete records, delete reports, add or edit traffic lights), are displayed
in the Windows Event Viewer in the PASSecurity and PQ Analyzer Security folders. Use Enabling security
notifications (SNMP Agent), to publish the security-related logs of the applications within a system as traps
to SNMP Manager.
To enable/disable the security events as traps:
² Select Enable security notifications (SNMP Agent) from the Security menu
The checkmark on this menu item indicates the selection.

6.9

User Administration
6.9 Enabling Security Notifications (SNMP Agent)
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ii NOTE
The parameters used by the SNMP Agent for the generation of notifications or messages can be remotely
configured. The corresponding SNMP tree structures and tables for Security Notification are readable and
writable. For more information refer to RFC documentation: SNMP-NOTIFICATION-MIB (RFC 3413) and
SNMP-TARGET-MIB (RFC 3413).

ii NOTE
When SICAM PAS/PQS is configured with SNMP client, the port number 162 is used. In such a case, the
secure SNMP Agent and the SNMP client both tend to use the same port number 162, causing one of them
to fail. To solve this, you can assign the secure SNMP Agent to another port by adding an environment
variable, RC_SSA_SNMP_PORT with the value of the port number as a decimal number.

User Administration
6.9 Enabling Security Notifications (SNMP Agent)

260 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



Human-Machine Interface (HMI)

Use SICAM SCC to monitor and control your system.
SICAM SCC provides access to the SICAM PAS/PQS station with a local network, by using the Intranet or by
using the Internet.
7.1 Overview 262
7.2 Setting up a Connection 262
7.3 Mapping Information 263
7.4 Exporting Configuration Data 265
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Overview
The SICAM SCC Human-Machine Interface (HMI) serves for system monitoring and control.
Functional and spatial interactions of your station components are represented in the SICAM SCC overview
and station diagrams.
State changes of process information and control actions are logged chronologically in message lists such as
alarm and event lists.
You can intervene in the process and control it from the station diagrams.
Messages and measured values can be logged and saved in the archive.
The assignment of specific user authorizations and the consideration of the switching authority on different
levels protect your system against unauthorized access.
Various switching modes, update functions, and options for the setting of bay and telecontrol blocks comple-
ment the power-management functions of SICAM SCC.
The communication with the SICAM PAS is performed by using Ethernet (TCP/IP).
To connect SICAM SCC to SICAM PAS: 

• Using SICAM PAS UI – Configuration, add the SCC application, the corresponding interface, and a
control center object to your project and configure them accordingly.

• Export the project data for SICAM SCC using SICAM PAS/PQS UI – Configuration.

• Map the information to SICAM SCC.

• Export the project data for SICAM SCC using SICAM PAS/PQS UI – Configuration.

• Import the project data into SICAM SCC.

Setting up a Connection
Inserting an Application

To insert an application for SICAM SCC in SICAM PAS/PQS UI – Configuration:
² Right-click Full Server in the configuration tree and select Application > SCC from the context menu.

Inserting an Interface

² Insert an interface for the SCC application.

² Select the interface of the SCC application and under General parameters, enter the name of the
interface.

7.1

7.2

Human-Machine Interface (HMI)
7.1 Overview
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[sc_Insert_App, 3, en_US]

Figure 7-1 Inserting an Application

² Select the Text format used for the mapping of information for SICAM SCC:

• Long text, 255 characters for message group and message text, can be exported as a TEA-X file
only

• Short text, can be exported as a TEA-X file or as a SCC file in PXD format

 

ii NOTE
If Unicode characters (except Central European character sets) are used, they are replaced with # in the
exported PXD file.

² Define the Switching authority group assignment, for example, Local 1.
For more information on the switching authority, refer to A.14 Information – Switching Authority.

Inserting a Control Center

² Insert a control center for the SCC application. Enter a name, for example, Control_center_local.

Mapping Information
Monitoring Direction

² Select the Mapping view.

² Select the control_center_local. In the monitoring direction, select the information which you want to
display on your operator terminal.

Select how you want to use each individual item of information in SICAM SCC:
² Select the Alarm logging column to enter the information into an alarm list.

² Select the Tag logging column to show the information in a diagram.

7.3

Human-Machine Interface (HMI)
7.3 Mapping Information
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² Select the Archive system column to archive a message or a measured value. This selection automati-
cally initiates the selection in the Tag logging column.

ii NOTE
The following Message list, Message type, and Value text group columns are enabled only if the Alarm
logging is enabled.

² In the Message list column, select the message list in which the information is displayed. Indications can
be assigned to Event and alarm list, Event and protection message list, Event list, and SCC default.

² In the Message type column, define the message type for each indication. For example, the color in
which the message is displayed in the message list.
Indications can be classified as Alarm type, Error type, SCC default type, and Warning type.

² In the Value text group column, select the value text group in which the information is displayed.
Indications can be assigned to different type of value text groups: 0...16, SCC default, Show process
value.

Command Direction

² Switch to the command direction and select the information which can be controlled by using your
operator terminal.

² Select the Alarm logging column to enter the information into the event list.

² Select the Tag management column to show the information in a diagram.

ii NOTE
The following Message list, Message type, and Value text group columns are enabled only if the Alarm
logging is enabled.

² In the Message list column, select the message list in which the information is displayed. Indications can
be assigned to Event and alarm list, Event and protection message list, Event list, and SCC default.

² In the Message type column, define the message type for each indication. For example, the color in
which the message is displayed in the message list.
Indications can be classified as Alarm type, Error type, SCC default type, and Warning type.

² In the Value text group column, select the value text group in which the information is displayed.
Indications can be assigned to different type of value text groups: 0...16, SCC default, Show process
value.

Human-Machine Interface (HMI)
7.3 Mapping Information
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[sc_Mapping_Info, 3, en_US]

Figure 7-2 Mapping Information

This selection creates the SCC tags, which you require for the configuration and parameterization of your HMI.
Define the topological structure of your station before mapping the tags to SICAM SCC.
If you have modified the topology after the export, you can have the tag names updated.
For more information, refer to 2.9 Mapping the Topological Structures.

Exporting Configuration Data
Exporting Data

In order to be able to use the configured and parameterized information in SICAM SCC, you must export it
from SICAM PAS/PQS UI – Configuration.
² Select the Configuration view.

² Select the control center of the SCC application and select Export... from the context menu.

7.4

Human-Machine Interface (HMI)
7.4 Exporting Configuration Data
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[sc_Exporting_Config_Data, 3, en_US]

Figure 7-3 Exporting Configuration Data

The export function creates a TEA-X file or a PXD file in the selected directory. The PXD file export for SICAM
SCC is only possible, if the short text text format is selected in the SCC interface. Afterwards, you import
the file in SICAM SCC using the SICAM PAS Wizard. When using TEA-X, only 1 PAS station can be imported in
SICAM SCC.
The tag names are created from the topological designations of the information. If you have modified the
topology after mapping the information for SCC, you can decide whether you want to perform the export with
modified SCC tag names or with those which were valid upon the mapping of the data.

Updating SCC Tag Names
To update the tag names:
² Open the Mapping view. Select the control center and select Replace SCC tag names from the context

menu.
For more information, refer to /5/ SICAM SCC, Human Machine Interface SICAM SCC.

Human-Machine Interface (HMI)
7.4 Exporting Configuration Data
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SINAUT LSA Converter

Use the SINAUT LSA Converter in order to convert the project data of a SINAUT LSA system for use in SICAM
PAS/PQS.
8.1 Converting SINAUT LSA Project Files 268
8.2 Importing/Updating Project Data 270

8
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Converting SINAUT LSA Project Files
General Information

Use the SINAUT LSA Converter in order to convert the project data of a SINAUT LSA system for its use in SICAM
PAS/PQS.
After the conversion, one XML file and one or several TXT files are available. The TXT files hold the descrip-
tion files of the devices configured in the SINAUT LSA system.
Import the XML file into your SICAM PAS/PQS project. After the import, all devices of the SINAUT LSA system
are included the SICAM PAS/PQS project.
For large systems, the project data is stored in 2 files, Modul1.lsa and Modul2.lsa.
During the conversion, you must specify only one of the two files. The other file is converted automatically.
The SINAUT LSA Converter creates a Modul.lsa file which holds all project data.
The indexes required for the definition of the configuration commands and all related parameters are written
into a SYAP_xxx.txt file. xxx is the name of the download file, for example, SYAP_Modul.txt.

Converting SINAUT LSA Project Data
Start the LSA Converter from the Windows Start menu.
² Click Start and scroll through the app list.

² Select LSA Converter from the SICAM PAS/PQS folder.

² In the Open an LSA Configuration dialog which opens next, specify the LSA file which you want to
convert.

² Click Open to open the LSA Converter dialog.

[sc_Interface_Creation, 1, en_US]

Figure 8-1 Selecting the Interface Creation

² Activate per FP/LPII/SC Channel or per SKA module in order to assign the desired interface to all the
devices of an SKA module.

² Activate per multiplexer interface in order to assign the desired interface to all devices of an MUX
multiplexer and then click OK to confirm.

The abbreviation SKA stands for the serial interfacing module for request control.
If required, the dialog for the selection of the version of the SKA firmware opens.
² Select the version of the SKA firmware (see online help) and click OK to confirm.
The dialog for saving the protection device templates opens.
² Select in a separate device description file.

The templates of the protection devices are saved in separate files.

8.1

SINAUT LSA Converter
8.1 Converting SINAUT LSA Project Files
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ii NOTE
The in the device description file of the bay controller option is supported in monitoring direction.
Protection devices can be connected via the IEC 60870-5-103 protocol. However, commands, measured
values, or fault records are not supported. If commands, measured values, or fault records are required,
the protection devices must be connected directly to SICAM PAS/PQS via the IEC 60870-5-103 Master
application.

For project data of SINAUT LSA systems of Version 6 or older, the dialog for the specification of the device type
opens.

[sc_Defining_ Dev_Type, 1, en_US]

Figure 8-2 Defining the Device Type

The device number is indicated in the GB2TN column.
The device name is indicated in the Device column.
² Under Device type, select the type of each individual device and then click OK to confirm. All device

types of a system are now available for selection from the drop-down list box.
Specify a type for each device.

The conversion is executed. The progress of the conversion is documented in the Report.

SINAUT LSA Converter
8.1 Converting SINAUT LSA Project Files
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[sc_Report_Dialog, 2, en_US]

Figure 8-3 Report Dialog

The created files are saved in the directory of the LSA file.

Importing/Updating Project Data
The following description is identical for the SINAUT LSA ILSA Master and IEC 60870-5-103 Master appli-
cations. The individual steps are explained using the example of SINAUT LSA ILSA Master. If devices are
connected to the SINAUT LSA system via the IEC 60870-5-103 protocol, perform the same steps for the IEC
60870-5-103 Master application.

Importing Project Data into SICAM PAS/PQS

To import the converted data of the SINAUT LSA system into SICAM PAS/PQS:
² Start SICAM PAS/PQS UI – Configuration.

² Insert the SINAUT LSA ILSA Master application into the project.

² Select the inserted application and select Import... from the context menu.

² In the dialog which opens, select the XML file created by the SINAUT LSA Converter.
This starts the import process. The progress (successful execution / errors occurred) is documented in the
Report.
The Import – select elements dialog shows the devices the data of which can be inserted into the configura-
tion tree.

8.2

8.2.1

SINAUT LSA Converter
8.2 Importing/Updating Project Data
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[sc_Selecting_Element, 1, en_US]

Figure 8-4 Importing/Updating - Selecting an Element

ii NOTE
Do not deselect individual devices of an interface for Importing/Updating. Otherwise, the interface data for
devices which have not been selected becomes inconsistent.

² Click OK to confirm.
After the import, you can view the devices of the SINAUT LSA system in the configuration tree.

[sc_Imported_Dev_Config, 3, en_US]

Figure 8-5 Imported Devices in SICAM PAS/PQS UI – Configuration

Updating the Project Data

The following applies when updating a SINAUT LSA system in SICAM PAS/PQS with changed project data:

8.2.2

SINAUT LSA Converter
8.2 Importing/Updating Project Data
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• Only the system components of an existing LSA configuration are updated.

• New system components must be imported, refer to 8.2.1 Importing Project Data into SICAM PAS/PQS.

• Any component which has been removed from a SINAUT LSA system must be manually deleted in SICAM
PAS/PQS UI – Configuration.

• The interfaces, devices and information/commands to be updated are identified by their name and not by
their address. If these identifiers are changed, information/commands with a different name are deleted
and created once again with their original name.

To update the converted data of a changed SINAUT LSA system in SICAM PAS/PQS:
² Start SICAM PAS/PQS UI – Configuration.

² Select the SINAUT LSA ILSA Master application and then select Update... from the context menu.

² Continue as described in 8.2.1 Importing Project Data into SICAM PAS/PQS.

ii NOTE
Proceed in the following order when updating an LSA system: Updating existing system components,
Importing new system components, Deleting removed system components.

SINAUT LSA Converter
8.2 Importing/Updating Project Data
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Diagnostic Tools

The Version Scan system component provides information on the version and storage location of installed
products and their lower-level system components.
SICAM CHaSI (Collect Hardware and Software Information) is a diagnostic tool used to collect information on
the hardware and software components of the SICAM systems.
9.1 Version Scan 274
9.2 SICAM CHaSI System 275
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Version Scan
The Version Scan system component determines the version and the storage location of the products
installed and their lower-level system components. Error sources through inconsistent versions of the indi-
vidual components can thus be determined quickly and efficiently.
For the Customer Support Center, the Version Scan provides valuable information, which serves as a basis for
evaluating the system behavior or for determining the causes of problems.
The following products are evaluated:

• SICAM PAS

• SICAM SCC

• SICAM PQ Analyzer

• DIGSI

[sc_VersionScan, 3, en_US]

Figure 9-1 Version Scan

The information provided by Version Scan is structured according to:

• Scanned information
Name and version of the products installed.

• File version information
All exe and dll files of the system component selected in the structure tree
The information is displayed with the name, file name, file version, installation path.

• Registry information
All registry entries of the system component selected in the structure tree

• Optional packages information
Name and installation path of the optional system component selected in the structure tree

Starting the Version Scan
Start the Version Scan system component from the Windows Start menu.
² Click Start and scroll through the app list.

² Select Version Scan from the SICAM PAS/PQS folder.
The Version Scan opens and the installed products are displayed.

9.1

Diagnostic Tools
9.1 Version Scan

274 SICAM, SICAM PAS/PQS, Configuration and Operation
E50417-P8976-C433-C9, Edition 05.2023



Exporting Version Information
You can export the version information, for example, for supporting our hotline.
² Select File > Generate Report and click Create Report in the dialog which opens.

² In the following dialog, click Save As... to save the report.
The report is compressed as a VSCAN file and saved in the destination directory under VersionScanRe-
port.zip.

[sc_Version_Scan_Report, 1, en_US]

Figure 9-2 Version Scan Report, Example

Importing Version Information
You can load the created Report.VSCAN (Version Scan file) in the Version Scan.
Using the version scan file, you can make available customer information for analysis by the hotline.
² Click File > Load Report.

In the dialog which opens, select the directory in which the exported Version Scan report is stored.
The version information of the individual system components can be selected again by using the Version Scan
structure tree.

SICAM CHaSI System
SICAM CHaSI (Collect Hardware and Software Information) is a diagnostic tool used to collect information on
the hardware and software components of the SICAM systems.
You can forward this information to the Customer Support Center for further analysis, which includes the
following data:

9.2

Diagnostic Tools
9.2 SICAM CHaSI System
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• Hardware and software inventory data including data concerning the BIOS, the processor, and the
software installed

• Information on the file system, the network, important entries from the registration database, and
system settings (including the hosts file and the ntp file)

• Information on the version of the SICAM products and files installed for:
– SICAM PAS/PQS
– SICAM PQ Analyzer
– SICAM SCC
– SIMATIC WinCC

• Error log files with information on any program crashes (dump files)

• Windows Event Log

• Windows Error Reporting files (only Appcrash and Apphang files)

• Report logs
SICAM CHaSI provides 2 functions for the collection of diagnostic data:

• 9.2.1 SICAM CHaSI System Overview
Displays a selection of the most important system information in the Web browser. This procedure takes
less than 1 minute.

• 9.2.2 SICAM CHaSI System Details
Displays a collection of detailed diagnostic data. This procedure takes 5 to 15 minutes, depending on the
scope and performance of the system.

You can view all the operations. You can view the collected information in plain text.

ii NOTE
User related data, for example passwords, are not collected.

You can compress the collected data and provide it to the Customer Support Center for further evaluation.
This is done for:

• System Overview data (e-mail)

• System Details data (Secure File Exchange1)
However, in certain support cases, further diagnosis is necessary for which the data required cannot be
collected using the SICAM CHaSI scripts. For example, protocol logs during the runtime of the programs.

SICAM CHaSI System Overview

For System Overview, only the most relevant values are determined and displayed. You can forward the
generated file to the Customer Support Center. You can use the generated values for analysis or setting up an
inventory of the system.

Starting SICAM CHaSI System Overview
To start the determination of the System Overview data:
² Double-click the SystemOverview.bat file in the %PAS_BIN%\CHaSI\ directory.
The command-line tool displays the processed information, as well as the progress of processing. Afterwards,
the information is arranged in tables and displayed via the Internet Explorer.

9.2.1

1 SIEMENS Secure File Exchange, service for secure data exchange, see https://secufex.erlm.siemens.de
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[sc_Chasi_overview_IE, 2, en_US]

Figure 9-3 Displaying the System Overview Data in Internet Explorer

ii NOTE
If Internet Explorer is not installed, the systemoverview.xml file is not displayed. In this case, open the
file manually using any other Web browser.
Due to the security settings of Google Chrome, the systemoverview.xml file cannot be displayed in this
browser.

Forwarding the Collected Data to the Customer Support Center
In the %ProgramData%\Siemens\CHaSI\SystemOverview [Date Time]\ directory, the information is
saved in systemoverview.xml, for example: C:\ProgramData\Siemens\CHaSI\SystemOverview 2014- 07-04
10-58-26\systemoverview.xml.
In addition, the SystemOverview.xlst, \css\screen.css, and \css\print.css files are copied into the specified
directory. These files are required for representation.
² Save the SystemOverview [Date Time] directory as a ZIP file and send it to the Customer Support

Center.

SICAM CHaSI System Details

The values required for initial analysis of System Details are determined and collected automatically. The
information is collected independently of the operating system used and the product installed.

9.2.2

Diagnostic Tools
9.2 SICAM CHaSI System
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Starting SICAM CHaSI System Details

ii NOTE
Administrator rights are required to access the SICAM CHaSI System Details tool. If administrators rights
are not available, the tool tries to obtain them using the user account control function. If a user’s rights are
not sufficient in order to execute the tool with administrator rights, the tool is aborted.

To start the determination of the System Details data:
² Double-click the SystemDetails.bat file in the %PAS_BIN%\CHaSI\ directory.
However, it can also become necessary to stop the SICAM runtime services and close the SICAM PAS/PQS
components, for example, for copying the SICAM PAS/PQS database.
² If you agree that the SICAM runtime services are stopped, enter Yes.

The services are automatically restarted afterwards. The SICAM PAS/PQS components, for example,
SICAM PAS/PQS UI – Configuration, must be restarted manually.
If you enter No, exclusively tasks that are admissible during runtime or with components started are
executed.

[sc_Chasi_details, 1, en_US]

Figure 9-4 Command Line Tool with System Details Data

Errors are highlighted in red and warnings are highlighted in yellow. If you ignore these errors and warnings,
the corresponding information is not included in the evaluation.

Forwarding the Collected Data to the Customer Support Center
The information collected is saved in a new directory each time you generate the system details:

%ProgramData%\Siemens\CHaSI\SystemDetails[Date Time]\
(for example: C:\ProgramData\Siemens\CHaSI\SystemDetails 2014-06-30 17-44-10)
² Save the SystemDetails[Date Time] directory as a ZIP file and send it to the Customer Support Center for

further analysis.

Diagnostic Tools
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Structure of Grid Codes
A Grid Code is composed of a multitude of characteristics for which different rules may apply. The rules of a
characteristic are used for identifying power quality violations.
If a rule is deactivated, all rule parameters are deactivated as well. The deactivated rules are saved, but not
applied.

[le_pqa_GridCodeLimit, 5, en_US]

Figure A-1 Grid Code Limits

(1) Limits that can be defined for each of the selected characteristic group
(2) List of characteristics for the selected characteristic group
(3) Enabled rules with their limit

The following limits can be defined:

• Period limits
Period limits specify the maximum permissible occurrence of limit violations. They are suited for the
evaluation of measured characteristics required for the generation of scheduled reports.

• Operational limits
Operational limits define absolute limits, which may never be exceeded or undershot.

• Classification limits
Classification limits are used in the evaluation of measured voltages to classify voltage events.

Parameters of Period Limits

• Hysteresis
Percent value in terms of the measuring variable for the stabilization of the data to be evaluated. Minor
value changes are not considered.

• Averaging time
Averaging time in the following format: Hours:Minutes:Seconds

• Upper limit
Absolute value for flicker
The upper limit must be greater than or equal to the lower limit.

A.1
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• Lower limit
Absolute value for flicker
The lower limit must be less than or equal to the upper limit.

• Value of the interval
Value of the time range observed, in terms of the unit of the interval, for example,1 (hour)

• Unit of the interval, for example, Minute, Hour, Day, Week, Month, and Year

• Max. violation rate
Permissible violation time, in percent, in terms of the time interval defined.
Example: For an interval of 1 week, the setting 95 % corresponds to a maximum permissible total
violation time of 159.6 hours.

Parameters of Operational Limits

• Hysteresis
Percent value in terms of the measuring variable for the stabilization of the data to be evaluated. Minor
value changes are not considered.

• Averaging time
Averaging time in the following format:
Hours:Minutes:Seconds

• Upper limit
Absolute value for flicker
The upper limit must be greater than or equal to the lower limit.

• Lower limit
Absolute value for flicker
The lower limit must be less than or equal to the upper limit.

Parameters of Classification Limits

• Hysteresis
Percent value in terms of the measuring variable for the stabilization of the data to be evaluated. Minor
value changes are not considered.

• Time 1 (’short’)
Maximum duration of ‘short’ events

• Time 2 (’long’)
Minimum duration of ‘long’ events

• Enable limits 3 and 4
If this option is disabled, the limits for Minor Dip and Minor Swell are saved but not applied.

• Limit 1
Limit value to differentiate between Interruption and Major Dip

• Limit 2
Limit value to differentiate between Major Dip and Minor Dip

• Limit 3
Limit value to differentiate between Minor Dip and normal operation area

• Limit 4
Limit value to differentiate between Minor Swell and normal operation area

• Limit 5
Limit value to differentiate between Minor Swell and Major Swell

Events are classified as shown in the following matrix:
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[sc_pqa_ClassifcationMatrix, 2, en_US]

Figure A-2 Classification Matrix

Updating a User-Defined Mapping File
The PQ data in PQDIF format is exported based on the default mapping file, PQDIF_Archive_Mapping.csv to a
user-defined location. You can selectively export the PQ data in PQDIF format by customizing the PQDIF tags in
the default mapping file as per your requirements.
To update a user-defined mapping file, proceed with the following steps:
² Copy PQDIF_Archive_Mapping.csv from %pas_bin% to %publicdocuments%Siemens\SICAM PAS

PQS\PQDIFExport.
² Edit the contents of this file using a spreadsheet application to modify the PQDIF tags as per your

requirements.
You can also delete the rows to filter the data that is not required to be exported.

ii NOTE
The mapping file is always saved in the .csv format. Other file formats like .xls or .xlsx are not accepted.
The mapping file must contain at least one valid entry.

² To reflect the changes made in the user-defined mapping file in the PQS Automatic Export application,
update the runtime system using SICAM PAS/PQS UI – Operation or SICAM PAS/PQS UI – Operation Client.
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ii NOTE
The mapping file is validated during the export. Any validation errors in the mapping are shown as warn-
ings in the Report. The measurement channels that have warnings during the validation of the mapping
file are not exported.

The default mapping file contains the following columns:

Table A-1 Columns of the Default Mapping File

Name of the column Description
CharacteristicType Defines which measurement data is to be transmitted via an individual

channel, for example, Voltage, and Current
MeasurementValueType Defines what is represented by the actual quantitative measurement data,

for example, Mean, Max, and Min values
tagQuantityMeasuredID Identifies the physical quantity under measurement that is, voltage, current,

power, etc
In general, there is a one-to-one correspondence between these and the
units of the series.

tagQuantityCharacteristicID Specifies additional detail about the meaning of the series data
tagValueTypeID Specifies the meaning of the series data
Frequency/Base Specifies nominal frequency
tagQuantityUnitsID Specifies the units of the data in this series
tagQuantityTypeID Defines the high-level description of the type of quantity that is being

captured by this channel

ii NOTE
The list of valid PQDIF tags are defined in the IEEE 1159.3 PQDIF Standard.
The list of valid CharacteristicType and MeasurementValueType are defined in the Archive configuration
file at %pas_bin%/en/Siemens.Energy.Archives.ini.

Updating a User-Defined Channel List File
The PQ data in CSV format is exported based on the default channel list file, PQDataCSVExport_Channel-
List.csv to a user-defined location. You can selectively export the PQ data in CSV format by customizing the
channel list file as per your requirements.
To update a user-defined channel list file, proceed with the following steps:
² Copy PQDataCSVExport_ChannelList.csv from %pas_bin% to %publicdocuments%Siemens\SICAM

PAS PQS\CSVExport.
² Edit the contents of this channel list file using a spreadsheet application as per your requirements.

You can also delete the rows to filter the data that is not required to be exported.

ii NOTE
The channel list file is always saved in the .csv format. Other file formats like .xls or .xlsx are not accepted.
The channel list file must contain at least one valid entry.

² To reflect the changes made in the user-defined channel list file in the PQS Automatic Export applica-
tion, update the runtime system using SICAM PAS/PQS UI – Operation or SICAM PAS/PQS UI – Operation
Client.
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ii NOTE
The channel list file is validated during the export. Any validation errors in the channel list file are shown
as warnings in the Report. The measurement channels that have warnings during the validation of the
channel list file are not exported.

The default channel list file contains the following columns:

Table A-2 Columns of the Default Channel List File

Name of the column Description
CharacteristicType Defines which measurement data is to be transmitted via an individual

channel, for example, voltage and current
MeasurementValueType Defines what is represented by the actual quantitative measurement data,

for example, Mean, Max, Min, and ExtremeEvent.

ii NOTE
The list of valid CharacteristicType and MeasurementValueType are defined in the Archive configuration
file at %pas_bin%/en/Siemens.Energy.Archives.ini.

Report Templates
Company Logo in Reports

Your company logo can be inserted in the report header for the following reports:

• Scheduled report

• PQ violation report

• Fault location report
Save the logo in PNG format in the %PUBLICDOCUMENTS%Siemens\SICAM PAS PQS named as
Logo_customer.png.
If the graphics file for the logo is higher than 150 pixel or wider than 100 pixel, it is automatically scaled to
150 x 100 pixel. This may lead to visible artifacts and a blurred display.
If this folder or the logo is missing, the default image present in the installed location of SICAM PAS/PQS is
used.

Report Template File
Report template files for scheduled reports are created as ASCII formatted TXT files which can be edited using
a text editor.

ii NOTE
When you edit a report template file, keep a copy of the updated file in a location different from the folders
created by the setup - otherwise a database or a software update overwrite your changes.

ii NOTE
To enable the usage of Unicode characters, store the report template text files using UTF-8 encoding with
BOM (Byte Order Marker).

You find report template files for scheduled reports in the directory %PUBLICDOCUMENTS%Siemens\SICAM
PAS PQS\ReportTemplatesScheduled.

A.4
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A report template file consists of the following elements:

• Title (once)
The title includes the name of the report.

• Version (once) (optionally)
The version is used to determine if a newer report template is available with the product.

• Chapter (optionally)
Chapters are used to structure a report. You can assign a chapter heading and change the page layout.

• Diagram
A diagram is defined by the diagram name, type, characteristic, and phase. You can also specify, whether
measured or evaluated characteristics are displayed.

The following table shows the elements with their possible values.
For more information on the element syntax, refer to A.5 Examples of Report Template Files.
Element Description/Value
Title Defines the title of the report

The title may appear only once in the report template.
Version2 Defines the version of the report template

The version must appear only once in the report template.
The value must be in the format:
<Major version>.<Minor version> , for example 1.0, 1.1, or 2.0

Generation2 Interval for report generation.
Possible values are:

• None: The report is never generated.
• Every day: The report is generated every day.
• Every week: The report is generated every week.
• Every month: The report is generated every month.
• Every year: The report is generated every year.

Chapter2 Divides the report into different chapters
NewPage Page format of the chapter

Possible values are:

• Default: Uses the page format of the standard printer
• Current: Copies the setting of the previous chapter

Diagram Diagram name, creates a diagram
Type Diagram type to be used, see Values for Type, Page 286
Characteristic Characteristic to be displayed, see Values for Characteristic, Page 287
Phase Phase for which the report is created, see Values for Phase, Page 290
DisplayMeasuredData • Yes: Measured values are displayed in the diagram

• No: Evaluated values are displayed in the diagram

ii NOTE
The scheduled report is generated when all the PQ characteristics along with evaluated data of the meas-
urement points assigned are available in the archive for the requested reports.

2 Optional
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Values for Type
The diagram types available represent different types of data. The table below shows the diagram types for
report templates and the data types they represent.

Diagram Type Measured Characteristics Evaluated Characteristics
Time line Mean Values X
Time line Max Values X
Time line Min Values X
Table Mean Values X
Table Max Values X
Table Min Values X
Graphic Finger-Print Mean X
Table Finger-Print Mean X
Harmonics spectrum X X
Heatmap Mean Values X
Heatmap Max Values X
Heatmap PQ Index X
Bar view P95-Min-Mean-Max X
Time line Event Values X X
Binary track X
Time line PQ Index X
Time line Power Quality X
Time line Measuring Gap X
Bar view PQ-Statistics X
ESKOM X
ITI X
SEMI F47 X
Graphic Finger-Print PQ Index X
Graphic Finger-Print Event Values X
Table Finger-Print PQ Index X
Table Finger-Print Event Values X
List Voltage-Event X
List Sequence of Events X
Time line Rapid Voltage Changes X
List Rapid Voltage Changes X
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Values for Characteristic

Characteristic Group Types of Characteristics
Voltage Voltage

Voltage balance, Voltage unbalance,
Positive-sequence voltage,
Negative-sequence voltage,
Zero-sequence voltage,
Voltage unbalance u0

Current Current
Current balance, Current unbalance,
Positive-sequence current,
Negative-sequence current,
Zero-sequence current,
Sensitive current,
Current unbalance i0

Frequency Frequency
THD THD voltage, THD current,

PWHD current, PWHD voltage,
TDD current

Power Active power, Reactive power,
Reactive power (Fundamental),
Apparent power, Power factor,
Cos Phi,
Voltage current angle

Flicker Flicker Pst, Flicker Plt,
Flicker Ast, Flicker Alt

Energy Active energy,
Active-energy input, Active-energy output,
Reactive energy,
Capacitive reactive energy, Inductive reactive energy,
Apparent energy
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Characteristic Group Types of Characteristics
Phasor Negative-sequence system,

Positive-sequence system,
Voltage magnitude, Current magnitude,
Voltage angle, Current angle,
Voltage-difference angle, Current-difference angle,
Pos.-seq. voltage magnitude,
Pos.-seq. voltage angle,
Pos.-seq. voltage Delta Phi,
Pos.-seq. current magnitude,
Pos.-seq. current angle,
Pos.-seq. current Delta Phi,
Neg.-seq. voltage magnitude,
Neg.-seq. voltage angle,
Neg.-seq. voltage Delta Phi,
Neg.-seq. current magnitude,
Neg.-seq. current angle,
Neg.-seq. current Delta Phi,
Zero-seq. voltage magnitude,
Zero-seq. voltage angle,
Zero-seq. voltage Delta Phi,
Zero-seq. current magnitude,
Zero-seq. current angle,
Zero-seq. current Delta Phi,
Frequency phasor,
Active power magnitude,
Reactive power magnitude
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Characteristic Group Types of Characteristics
Harmonic 2nd Harmonic voltage,

3rd Harmonic voltage,
4th Harmonic voltage, ... ,
100th Harmonic voltage

2nd Harmonic current,
3rd Harmonic current,
4th Harmonic current, ... ,
100th Harmonic current

0th Interharmonic voltage,
1st Interharmonic voltage,
2nd Interharmonic voltage,
3rd Interharmonic voltage,
4th Interharmonic voltage, ... ,
100th Interharmonic voltage

0th Interharmonic current,
1st Interharmonic current,
2nd Interharmonic current,
3rd Interharmonic current,
4th Interharmonic current, ... ,
100th Interharmonic current

Emissions Emissions 2 kHz to 9 kHz
Emissions 2.1 kHz
Emissions 2.3 kHz, ... ,
Emissions 8.9 kHz

Emissions 9 kHz to 150 kHz
Emissions 9 kHz
Emissions 11 kHz, … ,
Emissions 149 kHz
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Characteristic Group Types of Characteristics
User-defined frequency User-def. voltage frequency A, ... ,

User-def. voltage frequency P

User-def. current frequency A, ... ,
User-def. current frequency P

User-defined mains signalling voltage frequency A, B
Process channels 1st Process channel,

2nd Process channel,
3rd Process channel,
4th Process channel, ... ,
128th Process channel

ii NOTE
The Reactive power (fundamental) characteristic is supported only by the user-defined Grid Codes and
the AllCharacteristics_57-62.TXT report template.
The Emissions characteristic is supported by the IEC61000-2-2-Star-LV.EAGridCode, IEC61000-2-2-Delta-
LV.EAGridCode, and UserDefined_IEC61000-2-2-LV.EAGridCode Grid Codes.
For 50 Hz system frequency, the emissions characteristic ranges from 2 kHz - 9 kHz and 9 kHz - 150 kHz.
For 60 Hz system frequency, the emissions characteristic ranges from 2.5 kHz - 9 kHz and 9 kHz - 150 kHz.

Values for Phase

N N-E L-N E L
A A-B A-N A-E L-E
B B-C B-N B-E Sum
C C-A C-N C-E Undefined

Examples of Report Template Files
In the %PUBLICDOCUMENTS%Siemens\SICAM PAS PQS\ReportTemplatesScheduled directory you find the
following report templates:

• AllDiagrams-Star.txt
Templates for all possible diagram types for the Star network type

• AllCharacteristics_1-27-Star.txt, AllCharacteristics_28-56-Star.txt, AllCharacteristics_57-62-Star.txt
Templates for all supported characteristics for the Star network type

• AllDiagrams-Delta.txt
Templates for all possible diagram types for the Delta network type

• AllCharacteristics_1-27-Delta.txt, AllCharacteristics_28-56-Delta.txt, AllCharacteristics_57-62-
Delta.txt
Templates for all supported characteristics for the Delta network type

• EN50160-Star.txt
Report template for Grid Code according to the EN 50160 standard for the Star network type
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• EN50160.Delta.txt
Report template for Grid Code according to the EN 50160 standard for the Delta network type

• IEC61000-Star.txt
Report template for Grid Code according to the IEC 61000 standard for the Star network type

• IEC61000.Delta.txt
Report template for Grid Code according to the IEC 61000 standard for the Delta network type

• IEC61000-2-2-Star.txt
Report template for Grid Code according to the IEC 61000-2-2 standard for the Star network type

• IEC61000-2-2-Delta.txt
Report template for Grid Code according to the IEC 61000-2-2 standard for the Delta network type

The following pages show some examples of report template files:

• A.6 Average Voltage over the Day with PQ Index Curve

• A.7 Evaluation of the Power Quality for One Month

• A.8 PQ Statistics for the Whole Year

Average Voltage over the Day with PQ Index Curve
These daily reports show the voltage curve and the PQ Index for the voltage in a system with 2 PQ devices.

Settings in the Grid Code

• Period limits
– Disabled

• Operational limits
– Hysteresis: 0%
– Averaging time: 00:10:00 (10 minutes)
– Upper limit: 120%
– Lower limit: 80%

• Classification limits
– Disabled

Report Template File
The report template could look like this:
Title "Voltage curve (day)"

Generation="Every day"
Chapter "Voltage PQ device 1"

NewPage="Default"
Diagram "Voltage curve"

Type="Time line mean"
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="Yes"
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Diagram "PQ Index curve"
Type="Time line PQ Index""
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Chapter "Voltage PQ device 2"
NewPage="Default"

Diagram "Voltage curve"
Type="Time line mean"
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="Yes"

Diagram "PQ Index curve"
Type="Time line PQ Index""
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Evaluation of the Power Quality for One Month
These monthly generated reports show the general PQ Index and the PQ Index for the voltage and current
level.

Settings in the Grid Code

• Period limits:
– Hysteresis: 0%
– Averaging time: 00:10:00 (10 minutes)
– Upper limit: 120%
– Lower limit: 80%
– Interval value: 1
– Interval unit: Month
– Max. violation rate: 1%

• Operational limits:
– Disabled

• Classification limits:
– Disabled

Report Template File
The report template could look like this:
Title "Monthly PQ report"

Generation="Every month"
Chapter "Overview of Power Quality"

NewPage="Default"
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Diagram "PQ Index (overall device)"
Type="Time line PQ Index"
Characteristic="Undefined"
Phase="Sum"
DisplayMeasuredData="No"

Chapter "PQ Index (voltage)"
NewPage="Default"

Diagram "PQ Index (voltage)"
Type="Time line PQ Index""
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Chapter "PQ Index (current level)"
NewPage="Default"

Diagram "PQ Index (current level)"
Type="Time line PQ Index"
Characteristic="Current"
Phase="Sum"
DisplayMeasuredData="No"

PQ Statistics for the Whole Year
These yearly generated reports show the PQ statistics for the voltage in a system with 3 PQ devices.

Settings in the Grid Code

• Period limits:
– Hysteresis: 0%
– Averaging time: 00:10:00 (10 minutes)
– Upper limit: 120%
– Lower limit: 80%
– Interval values: 1
– Interval units: Year
– Max. violation rate: 1%

• Operational limits:
– Disabled

• Classification limits:
– Disabled

Report Template File

Title "PQ Statistics (year)"
Generation="Every year"

Chapter "PQ Statistics"
NewPage="Default"
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Diagram "PQ statistics PQ device 1"
Type="Bar view PQ-Statistics"
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Diagram "PQ statistics PQ device 2"
Type="Bar view PQ-Statistics"
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Diagram "PQ statistics PQ device 3"
Type="Bar view PQ-Statistics"
Characteristic="Voltage"
Phase="Sum"
DisplayMeasuredData="No"

Status Indications and Status Commands
Overview

SICAM PAS/PQS provides status information and status commands concerning systems, applications, interfaces
and device connections. This information can be visualized for example, in SICAM SCC.
Status information is used in the monitoring direction. Status commands are used in the command direction.
The following 5 types of information are distinguished for the Data Management of SICAM PAS/PQS:

• Status commands of a system, an application, an interface, or a device

• Status indications of a system, an application, an interface, or a device

• Status commands of a telecontrol/bay block of an interface or a device

• Status indications of a telecontrol/bay block of an interface or a device
Status indications and status commands are evaluated and set by using SICAM PAS/PQS UI – Operation.

Information - System/Application/Interface/Device
Status Commands

Status commands available in the system have the name _Adm. These commands are available for each level
(systems, applications, interfaces and devices). They are used to specify the target states of the corresponding
level. The values can be predefined as follows:
0 STOPPED target state
1 RUNNING target state

These status commands are of the ADMINC type. They can be mapped as information in the command
direction, for example, to SICAM SCC or a control center.

ii NOTE
If the _Adm status commands of the application level, interface level or device level are not up to date, the
system driver, a SICAM PAS/PQS service, does not run. In SICAM PAS/PQS UI – Operation, this is indicated by
a black exclamation mark on a yellow background. The communication drive does not start up.
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Status Indications
The status indications available in the system have the name _Opr. They are available for each level (systems,
applications, interfaces and devices) and represent the statuses at the time of viewing. The values have the
following meaning:
0 STOPPED
1 RUNNING

These status indications are of the OPER type. They can be mapped as information in the monitoring direction,
for example, to SICAM SCC or a control center.
To view various statuses, the _Adm and _Opr information is combined in SICAM PAS/PQS UI – Operation:

Table A-3 Display in SICAM PAS/PQS UI – Operation

_Adm _Opr Icon Meaning/Display
0 (STOPPED) 0 Stopped

1 (RUNNING) 0 Starting

1 (RUNNING) 1 Running

0 (STOPPED) 1 Stopping

Information - Telecontrol/Bay Blocking
Device-Specific Status Commands and Status Indications

Status commands
Status commands available in the system for the telecontrol/bay block have the name _BlkAdm. They are
available for master applications on the interface and device level. Only the status indications of a Master
connection are used. They specify the target states of the telecontrol/bay block of the devices. The values are
bit patterns and have the following meaning:
10000hex Target state no blocking
20000hex Target state bay blocking
30000hex Target state telecontrol blocking
40000hex Target state telecontrol and bay blocking

These status commands are of the ADMINC info type.

Status indications
Status indications available in the system have the name _Blkopr. They are available for Master applications
on the interface and device level. They are used to show the target states of the telecontrol/bay block of the
devices. The values are bit patterns and have the following meaning:
10000hex No blocking
20000hex Bay blocking set
30000hex Telecontrol blocking set
40000hex Telecontrol and bay blocking set

These status indications are of the OPER info type.
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ii NOTE
The initiator category in the Properties section of the Value Viewer must be set before sending any
command to the device.
When telecontrol blocking is enabled, set the InitiatorCategory field to LocalControl, before the command
is sent to the device from the bay level.

Channel-Specific Status Commands and Status Indications
The telecontrol block sets the BlockState structure value to remote blocked. The control center connection
evaluates the structure value.
To bypass the telecontrol block for a specific channel, the value 50000hex (Ignore telecontrol block) is entered
in the _BlkAdm status command.
In this case, the information is transmitted despite the telecontrol block.
You can modify the structure value in the ValueViewer, by using the automation function, SICAM SCC, or from
the control center.

Information – Switching Authority
In SICAM PAS/PQS UI – Configuration, each topological level (region, station, voltage level and bay) can be
assigned a switching authority.
For each parameterized switching authority, a specific switching authority tag (AuthorityValue xx) is created.
The names of these tags can be freely changed.
The effectiveness of the switching authority tags is deactivated after parameterization (Value 0). During the
system runtime, it is activated by using a control center connection, SICAM SCC or the Value Viewer (value
unequal 0).
Before executing a command, the system checks whether the switching authority tag allows the command
execution at the current time.
The switching authority tags are checked from the lowest to the next higher topology level. As soon as
a defined switching authority tag (value unequal 0) has been found, this value is used for checking the
command output conditions.
If switching authority tags have been parameterized on the Station, Voltage and Bay levels and all switching
authority tags are set to Unequal 0, only the switching authority on the bay level is effective for the command
output.

Examples
If you have set the switching authority tag for the bay for example, to Remote 1 and the switching authority
tag for the station to Local 1, the command output for the bay can still be performed remotely although Local
control has been defined for the station concerned.

Table A-4 Defining the switching authority, example

Application
Interface

Local Remote
1 2 3 1 2 3 4 5

SICAM PAS/PQS UI X X
SICAM SCC 1 X X
SICAM SCC 2 X X X
IEC 60870-5-101 – LS1 X X
DNP3 – LS X X
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Application
Interface

Local Remote
1 2 3 1 2 3 4 5

IEC 60870-5-104 – LS1 X X
IEC 60870-5-104 – LS2 X X

Example - SICAM SCC1:
SICAM SCC1 has the switching authority if Local 1 or Remote 1 has been set in the AuthorityValue xx. This
also applies to all other rows.

ii NOTE
If the switching authority Local x is configured for an interface, you can assign any switching permission
for Local x and Remote x from the application of this interface during operation.
If the switching authority Remote x is configured for an interface, you can assign the switching permission
Local x from the application of this interface during operation only while Remote x has the switching
permission.

Control Commands for the SIMEAS R Device
By using the Value Viewer you can transmit the following commands to the SIMEAS R device:

• Setting the Control Mode, Page 299

• Acknowledging a Group Alarm, Page 299

• Triggering of a Fault Record, Page 299
To enable control commands for SIMEAS R, open the Mapping view in SICAM PAS/PQS UI – Configuration.
Under Information – Command direction, register Status, activate in the Use column:

• c_sys_ControlMode for setting the control mode

• c_sys_GeneralAcknowledge for acknowledging group alarm

• c_sys_TriggerManual for manual triggering of fault records
Control commands for the SIMEAS R are triggered by means of the Value Viewer. The following screenshot
shows an example of the control mode settings for the Test mode of a SIMEAS R device.
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[sc_SIMEAS_R_enable_control_mode, 2, en_US]

Figure A-3 SIMEAS R Enabling Control Commands

[sc_switching_control_modes, 1, en_US]

Figure A-4 SIMEAS R Triggering Control Commands
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Setting the Control Mode
To setup the control mode for a device:
² Open the Value Viewer.

² Select the value c_sys_ControlMode in the ValueName column.

² Under Properties, select the value Command from the CauseOfTransmission list box.

² Enter a value in the Value field:
1 for Normal
2 for Test
3 for Lock

² Select the Control check box.

² To define the operation mode for the device, click Transmit.

Acknowledging a Group Alarm
To acknowledge a group alarm:
² Open the Value Viewer.

² Select the value c_sys_GeneralAcknowledge in the ValueName column.

² Under Properties, select the value Command from the CauseOfTransmission list box.

² Enter the value 1 in the Value field.

² Select the Control check box.

² To acknowledge the group alarm, click Transmit.
The LED on the device goes off.

Triggering of a Fault Record
To manually trigger fault records:
² Open the Value Viewer.

² Select the value c_sys_TriggerManual in the ValueName column.

² Under Properties, select the value Command from the CauseOfTransmission list box.

² Enter the value 1 in the Value field.

² Select the Control check box.

² To execute the command click Transmit.
A fault record will be triggered on the device and transmitted to SICAM PAS/PQS.
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Security-Related Messages
Messages Referring to SICAM PAS/PQS

Event Source – Referred System Component
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Tool started/closed x x x x x x
User added/modified/deleted x
User role and rights changed x
Password changed x
Security-relevant software configuration changed
(syslog parameters, for example, IP address and port,
enabling/disabling User login etc.)

x

Login failed x x x x x x
Login succeeded x x x x x x
Manual logout (user-initiated logout) x x x x x
Timed logout (automatic logout after a period of inactivity) x x x x x
Value substituted x
Wrong password entered (when substituting values) x
Configuration changed (Update system, Activate changes,
user initiated redundancy switchover) x x x

Alarm incident: Unsuccessful login attempt x x x x x x
Password changed for:

• SNMP V3
• FTP
• IEC 60870-5-101 dial up

x

Secure authentication for the archive enabled/disabled x
Security parameters enabled/disabled for:

• DNP3
• IEC 60870-5-104
• IEC 61850

x

All connection requests logged from any IP address for:

• DNP3 Slave
• IEC 60870-5-104 Slave
• IEC 61850 Server

x

All authentication results for DNP3 Slave x
All secure communication results for:

• DNP3 Master/Slave
• IEC 60870-5-104 Master/Slave
• IEC 61850 Client/Server

x

A.16
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Event Source – Referred System Component
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Enabling asset monitoring (SNMP Agent) x
Attempted use of unauthorized configuration software
When EnableFeature.dll is not signed or version mismatch

x

Messages Referring to SICAM PQ Analyzer

Event Remark
Login succeeded Successful login of client (SICAM PQ Analyzer, SICAM

PQ Collector) to SARA server
Login failed License missing, unauthorized user
Manual logout (user-initiated logout) Client (SICAM PQ Analyzer, SICAM PQ Collector)

disconnects from SARA server
Alarm incident: Reboot Startup of SARA server
Alarm incident: Reboot Shutdown of SARA server
Fault records imported Manual import of fault records from SICAM PQ

Analyzer
PQ data imported Manual import of PQ data from SICAM PQ Analyzer
Incident deleted Deletion of an incident from SICAM PQ Analyzer
Incident acknowledged Acknowledgement of an incident from SICAM PQ

Analyzer
Incident comment added/edited/deleted Add/Edit/Delete incident comment from SICAM PQ

Analyzer
Traffic light added/edited/deleted Add/Edit/Delete traffic light from SICAM PQ Analyzer
Client list cleared Clear client management list
Manual retrieval of fault records Manual retrieval of SIMEAS R fault record from SICAM

PQ Analyzer
Manual fault location report generation Manual fault location report generation from SICAM

PQ Analyzer
Operation failed Any unsuccessful operation while modifying the

archive content
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